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About This Guide
This document describes the basic concepts of CentraSite's Eclipse-based graphical user
interface (GUI). It also explains how to use the functions of the CentraSite Eclipse GUI.
This document addresses end users of CentraSite and assumes that you are familiar with
the concepts of CentraSite and the Eclipse Workbench.

Document Conventions
Convention

Description

Bold

Identiﬁes elements on a screen.

Narrowfont

Identiﬁes service names and locations in the format
folder.subfolder.service , APIs, Java classes, methods, properties.

Italic

Identiﬁes:
Variables for which you must supply values speciﬁc to your own
situation or environment.
New terms the ﬁrst time they occur in the text.
References to other documentation sources.

Monospace
font

Identiﬁes:

{}

Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

|

Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).

Text you must type in.
Messages displayed by the system.
Program code.
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Online Information and Support
Software AG Documentation Website
You can ﬁnd documentation on the Software AG Documentation website at “hp://
documentation.softwareag.com”. The site requires credentials for Software AG's Product
Support site Empower. If you do not have Empower credentials, you must use the
TECHcommunity website.
Software AG Empower Product Support Website
If you do not yet have an account for Empower, send an email to
“empower@softwareag.com” with your name, company, and company email address
and request an account.
Once you have an account, you can open Support Incidents online via the eService
section of Empower at “hps://empower.softwareag.com/”.
You can ﬁnd product information on the Software AG Empower Product Support
website at “hps://empower.softwareag.com”.
To submit feature/enhancement requests, get information about product availability,
and download products, go to “Products”.
To get information about ﬁxes and to read early warnings, technical papers, and
knowledge base articles, go to the “Knowledge Center”.
If you have any questions, you can ﬁnd a local or toll-free number for your country
in our Global Support Contact Directory at “hps://empower.softwareag.com/
public_directory.asp” and give us a call.
Software AG TECHcommunity
You can ﬁnd documentation and other technical information on the Software AG
TECHcommunity website at “hp://techcommunity.softwareag.com”. You can:
Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.
Access articles, code samples, demos, and tutorials.
Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.
Link to external websites that discuss open standards and web technology.
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Data Protection
Software AG products provide functionality with respect to processing of personal data
according to the EU General Data Protection Regulation (GDPR). Where applicable,
appropriate steps are documented in the respective administration documentation.
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Introduction to CentraSite and its Eclipse GUI
CentraSite is a standards-based SOA registry and repository. It serves as the central
"system of record" for the Web services and other computing assets of an organization
and provides the tools and infrastructure necessary to implement and manage SOAbased applications successfully.
CentraSite supports the entire development lifecycle of an SOA-based application, from
its design and implementation to its deployment and ongoing operation in the runtime
environment.

Support for the SOA Design-Time Environment
CentraSite supports the development of SOA-based applications by enabling
developers, architects and business analysts to:
Publish Web services and other reusable assets into their organization’s central
registry.
Discover Web services and use them to assemble consumer applications.
Obtain detailed information about a Web service, including the list of its consumers,
its technical support contacts, its disposition in the development lifecycle, usage tips
and performance data.
Examine the relationships that a Web service has with other artifacts in the SOA
in order to understand how a change to that service will impact the service’s subcomponents and dependents.
CentraSite supports an array of design-time tools that enable developers, architects and
business analysts to discover, publish and re-use SOA assets. These tools include:
CentraSite Control, a browser-based user interface provided with CentraSite.
The CentraSite plug-in for Eclipse, also provided with CentraSite.
UDDI V3.0-compatible registry browsers and IDEs.
Third-party design-time tools available from members of the CentraSite Community.
The CentraSite Community is a group of independent software vendors and system
integrators who develop products that integrate with CentraSite.
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Asset Management and Governance
Managing the content of the registry is critical to the success of an SOA environment.
To support this eﬀort, CentraSite provides governance capabilities and tools that enable
administrators and architects to:
Control access to CentraSite and to the metadata for individual assets listed in the
registry.
Model the speciﬁc entities that make up an organization’s SOA environment as well
as the dependencies and interrelationships of those entities.
Enable reuse of computing assets by providing easy access to in-depth information
about an artifact’s technical properties, semantics and relationships to other artifacts
in the SOA.
Deﬁne classiﬁcation systems (taxonomies) that enable Web services and other assets
to be easily discovered and managed.
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Impose mandatory testing, approval processes and/or quality checks to ensure that
assets accepted into the SOA adhere to organizational standards and policies.
Model the lifecycle process associated with each asset type and specify the events
that are to be triggered when an asset transitions from one lifecycle state to another.
The CentraSite plug-in for Eclipse, provided with CentraSite enables developers, architects
and business analysts to discover, publish and re-use SOA assets in the registry and
repository. It can be used with Software AG Designer (which is an Eclipse-based
development tool) or with any Eclipse installation that is running at the same version as
the version of Eclipse that Software AG Designer is using.
The CentraSite Eclipse-based graphical user interface (GUI) follows the paradigms of
the Eclipse Workbench: Views, Editors and Perspectives are provided for working with
the CentraSite registry and repository. Actions can be carried out from context menus
and toolbars. You can customize the working environment using standard Eclipse
Workbench functions. For detailed information on the Eclipse Workbench, refer to the
Workbench User Guide which comes with Eclipse. General information on Eclipse is
available at “www.eclipse.org”.

Starting to Work with the Eclipse GUI
We recommend that you start working with the CentraSite Eclipse GUI by opening one
of the CentraSite perspectives, for example as follows:
To open a CentraSite perspective
1. From the Window menu, select Open Perspective > Other.
2. In the Open Perspective dialog, select CentraSiteAsset Catalog or CentraSiteSearch and
Browse.
3. Click OK.
The perspective opens. You then have to connect to the CentraSite registry and
repository you want to work on.
You can work with the CentraSite perspectives just as you would work with any other
perspective in the Eclipse Workbench. The Workbench remembers which views, editors
and perspectives you have opened, and how you have customized your working
environment. The next time you open the Workbench, it appears in the same view as
you have previously left it. For detailed information, refer to Eclipse's Workbench User
Guide.

CentraSite Perspectives
CentraSite provides two perspectives that you can use to create, browse and manage the
information in the registry and repository.
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Read more in section Perspectives.

CentraSite Views
The CentraSite Eclipse GUI adds Navigation views and List views to the Eclipse
Workbench.
Read more in section Views.

CentraSite Details Editor
The CentraSite Eclipse GUI adds the CentraSite Details editor to the Eclipse Workbench.
Read more in section Details Editor.

Connecting to CentraSite
The ﬁrst task you carry out in the CentraSite Eclipse GUI is to connect to the CentraSite
registry and repository with which you want to work.
The following information is required for establishing a connection to a CentraSite
registry and repository:
The URL of the XML conﬁguration ﬁle for the CentraSite registry and repository, for
example, http://myserver:53305/INMConfiguration/INMConfiguration.xml.
The appropriate URL is generated automatically when you specify the name or IP
address of the server where the registry and repository are installed.
Note:

When publishing to CentraSite from the CentraSite Eclipse GUI, errors can
occur due to network seings. If you observe such problems, use machine
names instead of IP addresses, and ensure that these machine names are
included in the proxy bypass list of the Eclipse environment (General >
Network Connections).

User name and password.
You are prompted for this information to create a connection to the CentraSite registry
before navigating to perspectives. After you have entered the information, the
connection to the CentraSite registry and repository is established, and you can work on
their contents.
The connection information is stored in a so-called connection conﬁguration in
your Eclipse workspace. You can create and maintain any number of connection
conﬁgurations, for example, in order to connect to registries and repositories on diﬀerent
servers or with diﬀerent user names. One of the connection conﬁgurations must be
marked as the default conﬁguration. It is used each time you start working with the
CentraSite Eclipse GUI. The connection conﬁguration that you create when you use
CentraSite Eclipse UI Help Version 10.3
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the CentraSite Eclipse GUI for the ﬁrst time is automatically made the ﬁrst default
conﬁguration. The Registry Explorer view displays the conﬁguration that is currently
used behind the top entry in the view.
When you create a connection conﬁguration, you can choose to save a password. If you
do so for the default conﬁguration, the connection to the corresponding registry and
repository is established automatically when you start working with the Eclipse GUI. If
you do not save a password, you are prompted for it.
Note:

Passwords are saved in the Eclipse secure store (see the Eclipse Workbench User
Guide for details).

Changing Preference Settings
The CentraSite Eclipse GUI adds an entry named CentraSite to the standard Eclipse
Workbench Preferences dialog. Via this entry, you can make the preference seings
described below. To invoke the Preferences dialog, choose Window > Preferences in the
main menu of the Eclipse Workbench.

Registry Tree Settings
The Registry Explorer tree displays the organizations stored in the CentraSite registry
along with the assets assigned to these organizations as a hierarchy of nodes. On the
Registry Tree Settings page, deﬁne the number of elements you want to display under the
CentraSite registry.
For example, if you deﬁne 150 as the number of elements to be displayed under a
CentraSite registry node, and if the number of elements under that particular node in
the Registry tree exceeds 150, you can view only 150 elements at a time. At the end of the
element list, you see >>> n more elements message; where n is the number of elements
that are not displayed in the current node. Right click on this message to display the
additional 150 elements or display all the elements under the node.
The valid values for the number of elements to be displayed are 1 to n. By default, the
number of elements to be displayed is set to 128. If you specify a value "0" in the Registry
Tree Setting page, the default value of 128 is considered.
To remove customized registry tree seings and restore the default seings, click Restore
Defaults.

Language
The names and descriptions of objects in the CentraSite registry can be created and
displayed in diﬀerent languages. On the Language seings page, you can choose your
preferred language. This can be either the language seing of your local system (default)
or a speciﬁed language. The names and descriptions of registry objects you create will be
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stored in the selected language by default. Object names and descriptions are displayed
in the speciﬁed language, if possible.
Note:

When you create your connection conﬁgurations, you may have to choose a
language for your locale (see “Restricted Localization” on page 20). This
will then be your preferred language.

Connections
On the Connections page, you can create and maintain connection conﬁgurations. A
connection conﬁguration speciﬁes the URL of a CentraSite registry and repository
and the user name with which to connect to them. You can create and maintain any
number of connection conﬁgurations, for example, in order to connect to registries and
repositories on diﬀerent servers or with diﬀerent user names.
One of the connection conﬁgurations must be marked as the default conﬁguration by
checking it. It is used each time you start working with the CentraSite Eclipse GUI. The
connection conﬁguration you create when you use the CentraSite Eclipse GUI for the
ﬁrst time is automatically made the ﬁrst default conﬁguration. The Registry Explorer
view displays the conﬁguration that is currently used behind the top entry in the view.
On the Connections page, you can:
Add a new connection conﬁguration: Click Add. In the dialog, specify the following:
An alphanumeric name for the connection conﬁguration.
The name or IP address of the server where the CentraSite registry and
repository are located. The appropriate URL is generated automatically.
The user name with which to connect to the registry and repository.
Whether the login context of the server is to be used for your conﬁguration.
Check the Use login context of server option, if your CentraSite client runs in
a security context diﬀerent from that of the CentraSite server. For details on
diﬀerent security contexts, contact your CentraSite support organization.
You can choose to save a password. Passwords are saved in the Eclipse secure
store (see the Eclipse Workbench User Guide for details).
Edit a connection conﬁguration: Select the conﬁguration, click Edit and change the
values in the dialog.
Remove a connection conﬁguration: Select the conﬁguration, click Remove and
conﬁrm the deletion. You cannot remove the default conﬁguration.
Change the default connection conﬁguration: Check the conﬁguration which is to
become the new default.
Before you edit the default connection conﬁguration, disconnect from the registry and
repository by choosing Disconnect in the context menu of a CentraSite navigation or list
view. After you have changed the default connection conﬁguration, the next action you
carry out in the CentraSite Eclipse GUI will establish a connection with the new data.
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When you select a diﬀerent default conﬁguration, your current connection is
automatically closed and a new one is established with the new data.

Restricted Localization
The CentraSite Eclipse GUI provides restricted localization, in other words it controls
the display to one or more available locales.
If you have conﬁgured your connections and your current language does not match
the allowed locales, an error message is displayed and you are prompted to choose a
language from the list of deﬁned locales.
Note that the language you choose here will also become your preferred language.

Working with Views, Editors and Perspectives
This section oﬀers basic information on how to work with views and editors in the
CentraSite perspectives.

Working with the Perspectives
In the CentraSite Eclipse GUI, you carry out your work in views and editors opened in
the Eclipse Workbench. A perspective is a saved arrangement of views and editors that,
for example, deﬁnes where each view of the perspective is displayed in the Workbench.
A CentraSite perspective is composed of an editor area and several views.
Using the standard features of the Workbench, you can customize the views, editors and
perspectives in your working environment. For example, you can:
Resize and move the views within the Workbench or even out of it
Resize the editor area
Adapt the CentraSite perspectives to your requirements
Reset the perspectives to their default seings
The Workbench remembers which views, editors and perspectives you have opened,
and how you have customized your working environment. The next time you start the
Workbench, it is opened as you have left it.
For details on working with views, editors and perspectives, refer to the Workbench User
Guide.

Working with the Details Editor
The following hints are useful for working eﬀectively with the CentraSite Details editor:
By default, you open the CentraSite Details editor by double-clicking on an element
in one of the CentraSite navigation or list views. You can change the preference
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seings in CentraSite, if you prefer to open the editor by single-clicking on an
element.
The Workbench allows you to have multiple editors open in the editor area. Thus,
you can deﬁne and modify information on several elements in parallel. Any number
of editors can be open, but only one can be active at a time.
To store changes made in the CentraSite Details editor, use the standard functions
available in Eclipse. You can, for example, select File > Save in the main menu or type
Ctrl+S. An asterisk (*) next to the element name on the editor tab indicates that the
editor contains unsaved changes.
Unlike views, the editors cannot be dragged outside the Workbench. By default,
the editors are stacked in the editor area. You can choose to tile them in order to
view deﬁnitions of diﬀerent elements next to each other. For detailed information on
arranging the editors in the Eclipse Workbench, refer to the Workbench User Guide
which comes with Eclipse.
In the CentraSite Details editor, the functionality is distributed across diﬀerent tabs:
Each tab provides a toolbar in the upper right part of the tab. The functions provided
in the toolbar depend on the tab that is displayed.
You can save the current contents of a tab to a ﬁle in HTML format. Using the
buon, you can specify the path and name of the ﬁle in a dialog.
You can refresh the contents of a tab. The contents are automatically updated when
the editor is reopened. However, sometimes it may be required to update the
contents manually. Use the
buon for this purpose, press the F5 key on your
keyboard, or select the Refresh option from a table entry's context menu.
Some tabs in the editor area display elements in tables:
The table entries provide context menu options for working on the individual
elements.
You can sort the entries in the tables by each column in ascending or descending
alphabetical order by clicking the column headers. Using the
buon, you can
select the table columns to be displayed.
By double-clicking an element or selecting the Details option from its context menu,
you can select the element and open its detailed deﬁnition in the CentraSite Details
editor.

Refreshing Views
The display of elements in the various views is usually kept up-to-date as you execute
actions in the CentraSite Eclipse GUI. However, sometimes it may be required to update
the contents manually. For this purpose, the views have a Refresh action, which updates
the view's contents.
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To refresh a view
Do one of the following:
Click the

buon.

Press the F5 key on your keyboard.
Select Refresh from the context menu in the view.
The Refresh action applies to the view as a whole including all elements it contains.

Executing Actions
In the CentraSite Eclipse GUI, you can use the following to perform actions:
Icons in the toolbar of a view or in the toolbar of the CentraSite Details editor.
Menu options in context menus that are assigned to elements displayed in a view or
in the CentraSite Details editor.
Menu options in drop-down menus that are assigned to the Workbench or to an icon
in a toolbar.
To execute an action provided as an icon, click the icon.
To execute a menu option in a context menu
1. Right-click the element to which the context menu is assigned.
The menu options available in each context menu depend on the element you have
selected. Options that are not executable in a speciﬁc context are grayed out.
2. Select the required menu option from the context menu.
To execute a menu option from a drop-down menu, open the menu and select the
option.
Some of the menu options in context and drop-down menus can also be carried out by
using a key shortcut.

Handling Errors
When working with the CentraSite Eclipse GUI, the following types of errors may occur:
Problems with the Eclipse Workbench
Problems with the execution of actions for CentraSite elements
Eclipse Workbench problems are usually recorded in a log ﬁle. An error message points
you to this log ﬁle for details. You can view the log ﬁle by selecting Help > About Eclipse
SDK > Configuration Details > View Error Log.
To view the error log entries, you can also open the Error Log view. This view displays
the error log entries in a table.
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When a problem occurs during the execution of an action on a CentraSite element, a
corresponding message is displayed. You can:
Accept the error message by clicking OK. To update your data, if necessary, refresh
the view after accepting the error message.
Show and hide details on the error by clicking Details. The details provide
information on the CentraSite plug-in where the error occurred, the exception or
error message from the underlying Java runtime environment, and a Java stack trace.
This information can help you overcome the problem. In the case of system errors,
contact your system administrator.

Getting Help
In the same way as the CentraSite interface is integrated into the Eclipse Workbench, its
user documentation is integrated into the help system of the Workbench. The CentraSite
Eclipse GUI has its accompanying documentation plug-in which contributes this user
guide to the help system.
You can get help in the following ways:
Select Help > Help Contents. This displays the books of the Eclipse help system.
Select a view, menu option, dialog or wizard and press F1. This displays contextsensitive help for the selected element with references to the books of the help
system.
For more details on using the help system, refer to the Workbench User Guide.

Exiting the Eclipse GUI
You can exit the Eclipse GUI in one of two ways.
To exit the CentraSite Eclipse GUI
Close the CentraSite perspective, views and editors.
Close the Eclipse Workbench.
The Workbench remembers your working environment. The next time you start the
Workbench, it appears just as you left it.

CentraSite Eclipse UI Help Version 10.3

23

M

Even Header

CentraSite Eclipse UI Help Version 10.3

24

M

Odd Header
Concepts

2

Concepts

■ Registry and Repository ...............................................................................................................

26

■ Assets and Registry Objects ........................................................................................................

26

■ Properties of Registry Objects .....................................................................................................

29

■ Status, Stability and Expiration of Registry Objects ....................................................................

30

■ Versions of Registry Objects ........................................................................................................

32

■ Classifications of Registry Objects ..............................................................................................

34

■ Associations Between Registry Objects ......................................................................................

34

■ External Links ...............................................................................................................................

35

■ Supporting Documents and Resources .......................................................................................

35

■ Properties of Resources ..............................................................................................................

36

■ Attributes ......................................................................................................................................

38

■ Profiles ..........................................................................................................................................

47

■ Namespaces .................................................................................................................................

54

■ Notifications ..................................................................................................................................

55

■ Security .........................................................................................................................................

55

■ Audit Logs ....................................................................................................................................

59

CentraSite Eclipse UI Help Version 10.3

25

M

Even Header
Concepts

Registry and Repository
CentraSite is a registry and repository that allows you to manage and govern your SOA
environment and to achieve control and transparency across all IT resources related to
the SOA.
The registry is the part of CentraSite that is used to manage and describe the SOA
assets, for example, Web services. It does not store the assets themselves; rather, it stores
the relevant information about them. For example, an object stored for a Web service
contains information about the service. The service deﬁnition (WSDL ﬁle), however,
is not stored in the registry but in the CentraSite repository. The CentraSite registry is
thus an inquiry and data source allowing you to browse and search for information on
SOA assets and oﬀering reports on their usage. The information contained in a registry
is organized and represented by registry objects and associations between them.
If you are familiar with the JAXR (Java API for XML Registries) and UDDI standards,
you will recognize various object types and structures that are deﬁned in a registry. You
can modify existing object types and deﬁne additional object types as required.
The repository is a WebDAV-enabled ﬁle store. It typically holds resources that are
related to objects stored in the registry. This includes, for example:
Files that hold the SOA assets themselves, such as the WSDL ﬁles of services or
XPDL and schema deﬁnition ﬁles;
Files such as technical speciﬁcations, sample code or programming guides that are
relevant for your SOA assets;
Files produced or consumed by CentraSite such as policy descriptions, lifecycle
models or reports.
Resources held in the repository can be linked to objects stored in the registry. Some
features of CentraSite, such as the importing of a Web service, create entries in the
repository as well as corresponding objects in the registry. This allows entries in the
repository to be located via UDDI registry mechanisms.

Assets and Registry Objects
In CentraSite, asset management means managing the information contained in the
registry and repository. In the registry, the information is organized and represented by
registry objects. CentraSite distinguishes between registry objects that represent Assets
and Supporting Objects.
In CentraSite, each asset and each user is aﬃliated with organizations. An asset created
by a user is assigned to the organization to which the user belongs. Each organization
in CentraSite can have one or more child organizations. This allows you to create a
hierarchical organization structure in which all users and assets are embedded.
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Initially, only the Default Organization is deﬁned. The administrator who installs
CentraSite acts as administrator of the Default Organization. He/she has all permissions
required to create additional organizations and to deﬁne CentraSite users for the
organizations. For each new organization, he/she has to deﬁne a user as administrator
who in turn has all permissions required to fulﬁll the necessary administrative tasks for
the new organization.

Assets
An asset is a registry object that represents an artifact in your SOA environment, for
example, a Web service, an XML schema or a BPEL process. The Asset Types view of the
CentraSite Eclipse GUI enables you to access the assets deﬁned for the organization to
which you are assigned as a CentraSite user.
An asset is described by:
Properties of Registry Objects, Classiﬁcations of Registry Objects, Associations
Between Registry Objects and External Links. These details of an asset can be
displayed in the Details Editor.
Asset ﬁles. An asset ﬁle is a ﬁle or a ﬁle-like resource that represents or contains the
asset itself. For example, a Web service asset relates to a copy of the WSDL document
that describes the service; an XML schema asset relates to a copy of the actual XML
schema document. Asset ﬁles are stored in the CentraSite repository.
The assets in the registry reference the ﬁles in the repository. Each asset can be
described by one or more asset ﬁles. Whether and how many asset ﬁles are available,
depends on the type of asset.
Supporting documents. A supporting document is a ﬁle that contains useful
information about an asset, for example, a technical speciﬁcation, sample code
or a programming guide. Like asset ﬁles, supporting documents are stored in
the CentraSite repository. They are located in your organization's Supporting
Documents Library, which is part of the CentraSite repository.
The assets in the registry reference the documents in the Supporting Documents
Library. Each asset can be described by one or more supporting documents.
The following asset types are predeﬁned when CentraSite is installed:
Application
Application server
BPEL process
Service
WS policy
XML schema
Virtual Service
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Virtual XML Service
Virtual REST Service
A list of all asset types can be found in the Asset Types View. You can add your own
types, and also modify and delete existing types. Assets of diﬀerent types are identiﬁed
by diﬀerent icons in the CentraSite Eclipse GUI. You can specify the icon to be used
when creating or modifying an asset type.

Supporting Objects
A supporting object is a registry object that is used for managing and organizing the
assets. The CentraSite Eclipse GUI enables you to access these objects.
Like assets, supporting objects are described by Properties of Registry Objects,
Classiﬁcations of Registry Objects, Associations Between Registry Objects and External
Links. These details can be displayed in the Details Editor.
For organizing your assets, you mainly work with registry objects of the following types:
Icon

Object Type

Description

Organization

An Organization object describes an organization that
is involved in the asset management, for example,
an enterprise or part of an enterprise that provides
services. An organization can consist of one or more child
organizations, it can provide services and it can deﬁne
users.

User

A User object provides information about a registered
Users, Groups and Roles in CentraSite . Each user is
aﬃliated with an organization.
The full set of functions for user management is available
in the CentraSite Control (Web interface). The CentraSite
Eclipse GUI provides a restricted set of functions only.

Taxonomy

A Taxonomy object represents a taxonomy that
contains categories for classifying or categorizing
registry objects. The object type of Taxonomy objects is
ClassiﬁcationScheme. CentraSite distinguishes between
internal taxonomies, whose categories are stored in the
registry, and external taxonomies, whose categories are
not available in the registry.

Category

A Category object deﬁnes the hierarchical tree structure
and detailed elements of a taxonomy. It is used to
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Icon

Object Type

Description
classify and categorize registry objects. The object type of
Category objects is Concept.

List

A List object groups registry objects of any type by
logical aspects. A list may contain any number of registry
objects. A registry object may be a member of any
number of lists. The My View of the CentraSite Eclipse
GUI enables you to access the List objects you have
deﬁned.

Properties of Registry Objects
Each Assets and Registry Objects is described by a set of properties. CentraSite
distinguishes between predeﬁned properties and custom properties.

Predefined Properties
The following predeﬁned properties are available for every registry object, independent
of the object's type. They are displayed on the General in the “details editor” on
page 130.
Property
Name

Description

Name

The object's name. Diﬀerent names can be speciﬁed for diﬀerent
languages (locales). The General tab displays the name of the locale
selected in the Changing Preference Seings.

Type

The object type of the registry object.

Description

A textual description of the registry object. Diﬀerent descriptions
can be speciﬁed for diﬀerent languages (locales). The General tab
displays the description of the locale selected in the Changing
Preference Seings.

Organization The organization to which the registry object belongs.
Owner

The object's owner, usually the person who created the object in the
CentraSite registry.
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Property
Name

Description

Created

The date and time when the registry object was created in the
CentraSite registry.

Modiﬁed

The date and time when the registry object was last modiﬁed.

Key

The unique key for identifying the object in the registry. The key is
generated automatically when the registry object is created.

Custom Properties
In addition to the predeﬁned properties, you can deﬁne properties of your choice for
speciﬁc object types as well as for registry objects that you create or modify. These
properties are referred to as custom properties. Custom properties can be:
Type-speciﬁc: You can add properties of your choice to any object type in the
CentraSite registry. When you deﬁne a new object type or modify an existing one,
you can specify aributes which represent the properties.
Each type-speciﬁc custom property has:
A name that must be unique for the object type.
A data type that describes the type of value that can be speciﬁed for the property
at each object of the object type.
Type-speciﬁc custom properties are displayed in the Aributes that are visible for a
registry object in the “details editor” on page 130.
Object-speciﬁc: You can deﬁne properties of your choice for individual registry
objects. These properties are independent of the object type. Each object-speciﬁc
property has:
A name that must be unique for the registry object.
A Namespaces in which the property is valid.
One or several values.
Object-speciﬁc custom properties are displayed on the Object-Speciﬁc Properties in
the CentraSite Details editor.

Status, Stability and Expiration of Registry Objects
Assets and Registry Objects of the following types can have a speciﬁc lifecycle status,
stability, and expiration date and time.
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Taxonomy
Service
Registry objects of object types you deﬁne yourself
In the CentraSite Eclipse GUI, speciﬁc status, stability and expiration information
can be indicated by a decoration at the object's icon or appended to the object's name.
In the general Preferences seings of the Eclipse Workbench, you can specify which
decorations you want to display.

Status
The status indicates a registry object's current stage in its lifecycle. A registry object may
have exactly one of the following statuses at a time:
submied: The registry object has been submied.
deprecated: The registry object has been deprecated explicitly.
approved: The registry object has been submied and approved.
withdrawn: The registry object has been withdrawn by its submier.
In the CentraSite Eclipse GUI, the status of a registry object is displayed on the Summary
in the “details editor” on page 130. Additionally, the following statuses are indicated
by a decoration at the object's icon or appended to the object's name, provided the
decorator is enabled:
Decoration

Status
Deprecated

- withdrawn

Withdrawn

Stability
The stability indicates when and how a registry object may change. A registry object
may have exactly one of the following stability values at a time:
static: The registry object will not change.
dynamic compatible: The registry object may change at any time but the changes will
be downward compatible.
dynamic: The registry object may change at any time.
In the CentraSite Eclipse GUI, the stability of a registry object is displayed on the
Summary in the “details editor” on page 130. Additionally, the stability is indicated
by a decoration at the object's icon, provided the decorator is enabled:
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Decoration

Stability
Static
Dynamic compatible
Dynamic

Expiration Date and Time
The expiration date and time indicates when a registry object becomes invalid. In the
CentraSite Eclipse GUI, the expiration date and time of a registry object is displayed on
the Summary in the “details editor” on page 130.
When the speciﬁed date and time is reached, the string -expired is appended as a
decoration to the registry object's name in the CentraSite Eclipse GUI, provided the
decorator is enabled.

Versions of Registry Objects
Assets and Registry Objects of the following types can have several versions in
CentraSite:
Taxonomy
Service
Registry objects of object types you deﬁne yourself
A version is an instance of a registry object that represents a particular stage in the
object's history. Each object version is an individual registry object having its own
key. Each version of the same object may have diﬀerent Properties of Registry Objects,
Associations Between Registry Objects, Associations Between Registry Objects and
External Links. This means that if, for example, you develop a new version of an existing
Web service, you can maintain the new version and the old version side by side in the
registry, using the same name for both. Applications that access the object do not have to
be updated when a new version of the object is published.
Technically, each version of a registry object is linked to its immediate predecessor
version by an association of the Supersedes type. The association is classiﬁed by the
Versioning category of the CentraSite Versioning taxonomy.
Registry object versions are identiﬁed by version numbers and names. CentraSite
distinguishes between the following version identiﬁers:
CentraSite version identiﬁer: The CentraSite version identiﬁer consists of a major
and minor version number in the following format: major.minor . The identiﬁer and
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its version numbers are maintained exclusively by CentraSite. The initial CentraSite
version identiﬁer for each versionable object is 0.0. For non-versionable objects, it is
empty.
User version identiﬁer: For each registry object and registry object version, you can
specify and maintain a version name or number of your choice. The user version
identiﬁer is independent of the CentraSite version identiﬁer. It is available for both
versionable and non-versionable registry objects.
The Views include all versions of all registry objects. An overview of all the versions of
a speciﬁc object can be displayed on the Versions in the “details editor” on page 130.
The user version identiﬁer is also displayed on the General.
Registry object versions can be created explicitly or implicitly as described in the sections
below. Only the most recent version of a registry object can be used as the basis for
creating a new version.

Explicitly Creating Object Versions
In this CentraSite release, you can explicitly create versions for registry objects of the
Service type.
Options allow you to determine whether:
Only a new version of the registry object as such is to be created.
Registry objects, Supporting Documents and Resources that are related to the old
version are to be linked to the new version, too.
Copies or new versions of registry objects, folders or ﬁles that are related to the old
version are to be created and linked to the new version.
For details on the versioning options for services and on the actions performed, see
Versioning Services.
For any new object version created by a versioning operation, CentraSite increments
the major version number of the CentraSite version identiﬁer by 1 and resets the minor
version number to 0. For example, when you create a new version of a service whose
CentraSite version identiﬁer is 2.1, the new version is identiﬁed as 3.0.

Implicit Creation of Object Versions
When you explicitly create a new version of a registry object, new versions of related
registry objects may be created depending on the version options (see above).
Note:

When you Importing Web Services, thereby updating an existing Web service
in the registry, no new version of the Service registry object is created. Only
the minor version number of the object's CentraSite version identiﬁer is
incremented. For example, if the service's identiﬁer was 3.0, it is changed to
3.1. The import updates the most recent version of a service; previous versions
remain unchanged.
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Classifications of Registry Objects
The registry objects stored in the registry can be categorized by internal and/or external
classiﬁcations:
Internal classiﬁcation means that a category stored in the CentraSite registry is
assigned to the registry object.
External classiﬁcation means that a taxonomy is assigned to the registry object whose
categories are not stored in the CentraSite registry.
Any number of internal and external classiﬁcations can be assigned to a registry object.
The classiﬁcations assigned to a selected object are displayed on the Classiﬁcations tab in
the “details editor” on page 130. The registry objects classiﬁed by a selected category
can be displayed in the Search view.
When you deﬁne a new object type or modify an existing one, you can specify aributes
that map to classiﬁcations you want to make visible for the object type. An aribute that
represents a classiﬁcation can be displayed in the set of custom proﬁles that is visible for
a registry object in the CentraSite Details editor.

Associations Between Registry Objects
The Assets and Registry Objects stored in the Registry and Repository can be
interconnected by associations and implicit references. An association or implicit
reference starts at a source object and is directed to a target object.

Associations
An association is a connection between registry objects that is created and maintained by
a CentraSite user. Associations can be listed on the “Associations” on page 141 tab in
the “Details Editor” on page 130.
When you deﬁne a new object type or modify an existing one, you can specify Aributes
which map to associations you want to make visible for the object type. An aribute that
represents an association can be displayed in the set of Aributes that is visible for a
registry object in the CentraSite Details editor.
Associations can be of diﬀerent types. You can display a list of available association
types in the Contents View by selecting the Types > Association Types.
When CentraSite is installed, a number of predeﬁned association types are available
that can be customized to meet your requirements. Predeﬁned association types whose
names contain the string " CentraSite ", for example " CentraSiteMyFavorites" or
"UsesCentraSiteOperation", are reserved for CentraSite-internal purposes. You should
not use these when creating associations between registry objects.
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The list of association types can be customized to hold any type of association that your
organization needs.

Implicit References
Implicit references are connections between registry objects that are created and
maintained automatically by CentraSite. For example, when you create a service or user
within an organization, CentraSite creates an implicit reference between the service
or user and organization objects. Implicit references also include list assignments and
classiﬁcations.

External Links
In addition to having associations with other objects, Assets and Registry Objects can
have links to resources that are managed outside the registry, for example, to ﬁles in
the CentraSite repository or on a WebDAV server. A link to an external resource is
represented by the resource's URL, which is stored in the registry. A registry object may
have any number of external links.
In the CentraSite registry, an external link is stored as a registry object of the
ExternalLink type. The URL of the external resource is stored with the ExternalLink
object.
The external links of a registry object are shown on the External Links in the Details
Editor. The registry objects to which a folder or ﬁle is connected via an external link are
shown on the Aached To in the CentraSite Details editor.
When you deﬁne a new object type or modify an existing one, you can specify Aributes
which map to external links you want to make visible for the object type. An aribute
that represents an external link can be displayed in the set of Aributes that is visible for
a registry object in the CentraSite Details editor.

Supporting Documents and Resources
The repository is a WebDAV-enabled ﬁle store. It holds resources related to objects
stored in the CentraSite registry. These include:
Files representing supporting documents that contain useful information about
assets, such as technical speciﬁcations, sample code or programming guides.
Asset ﬁles such as the WSDL ﬁles of services or XPDL and schema deﬁnition ﬁles.
Files produced or consumed by CentraSite such as policy descriptions, lifecycle
models or reports.
Folders for organizing the ﬁles.
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The supporting documents are organized in the Supporting Documents Library in the
CentraSite repository. Each organization in CentraSite is assigned a subfolder in this
library where its supporting documents are located.
The ﬁles representing other resources are organized in folders outside the Supporting
Documents Library.
By default, a CentraSite user can access the documents in the Supporting Documents
Library of the organization to which he/she is assigned. A CentraSite Administrator can
access the overall folder structure of the CentraSite repository.
The folders and ﬁles held in the repository can be linked to objects stored in the registry.
Some features of CentraSite, such as the importing of a Web service, create entries in the
repository as well as corresponding objects in the registry.
You can browse and manipulate the folders and ﬁles of the repository in the Repository
Explorer view and in the Documents view. You can create new folders and ﬁles and
delete existing ones at any time.
The ﬁles stored in the CentraSite repository are versionable. A new version of a ﬁle is
created each time changes to it are uploaded to the repository or when its properties are
changed. You can list all the versions of a ﬁle on the Versions tab in the “Details Editor”
on page 130 and display the contents of each version in read-only mode in an Eclipse
Workbench editor.

Properties of Resources
Each folder and each ﬁle in the repository has a set of predeﬁned properties that
describe it. The properties can be displayed on the General tab in the “Details Editor” on
page 130 and in the Contents view.
A folder has the following predeﬁned properties:
Property
Name

Description

Name

The folder's name. You can change it by renaming the folder.

Type

The folder's type, usually hpd/unix-directory.

Created

The date and time when the folder was created in the CentraSite
repository.

Modiﬁed

The date and time when the folder was last modiﬁed.
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Property
Name

Description

Version

The user-assigned version identiﬁer for the folder. The userassigned identiﬁer can be made up of any sequence of characters.
It is not required to be numeric.

Organization The organization to which the folder belongs.
Key

The Universally Unique Identiﬁer (UUID) that is assigned to the
folder and uniquely identiﬁes it within the repository. CentraSite
automatically assigns a UUID to a folder when the folder is added
to the repository.

Owner

The folder's owner, usually the person who created the folder in
the CentraSite repository.

A ﬁle has the following predeﬁned properties:
Property
Name

Description

Name

The ﬁle's name. You can change it by renaming the ﬁle.

Description

A short description of the ﬁle. You can change the description as
required.

Type

The ﬁle's type.

Size

The ﬁle's size.

Created

The date and time when the ﬁle was created in the CentraSite
repository.

Modiﬁed

The date and time when the ﬁle was last modiﬁed.

Owner

The ﬁle's owner, usually the person who created the ﬁle in the
CentraSite repository.

Version

The user-assigned version identiﬁer for the ﬁle. The user-assigned
identiﬁer can be made up of any sequence of characters. It is not
required to be numeric.
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Property
Name

Description

Organization The organization to which the ﬁle belongs.
Key

The Universally Unique Identiﬁer (UUID) that is assigned to the
ﬁle and uniquely identiﬁes it within the repository. CentraSite
automatically assigns a UUID to a ﬁle when the ﬁle is added to
the repository.

Attributes
In the CentraSite Eclipse GUI, the deﬁnition of a registry object is represented by
aributes and proﬁles.
Aributes represent the individual Properties of Registry Objects, Classiﬁcations of
Registry Objects, Associations Between Registry Objects and External Links that are
deﬁned for a registry object.
The object's type deﬁnition determines which aributes are visible in the CentraSite
Eclipse GUI. For example, the asset type for a Service includes aributes that identify the
name of the service, provide the service's endpoints, identify the owner of the service,
supply links to programming documentation and so forth.
In CentraSite Eclipse GUI, aributes appear as properties:

All registry object types that represent assets include the following basic aributes:
Attribute

Description

Name

The name under which the asset is cataloged.
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Attribute

Description

Description

A descriptive comment that provides additional information
about an asset.

Key

The Universally Unique Identiﬁer (UUID) that is assigned
to the asset and uniquely identiﬁes it within the registry.
CentraSite automatically assigns a UUID to an asset when the
asset is added to the registry.

Version

The user-assigned version identiﬁer for an asset. The userassigned identiﬁer can be made up of any sequence of
characters. It is not required to be numeric.

System
Version

The system-assigned version number that CentraSite maintains
for its own internal use. CentraSite automatically assigns this
identiﬁer to an object when a version of the object is created.
The system-assigned identiﬁer is always numeric and always
has the format:
MajorVersion .Revision
Where:
MajorVersion is an integer that represents the asset's version
number. This value is incremented by one when a new
version of the asset is generated (e.g., 1.0, 2.0, 3.0).
Revision is an integer that represents an update to a particular
version of an asset. When the revisioning feature is enabled
for CentraSite, the Revision number is incremented each time
a change is made to the object (e.g., 1.0, 1.1, 1.2).
An asset's System Version aribute cannot be deleted or
modiﬁed by a user.

Created

The date on which the asset was added to the catalog.
CentraSite automatically sets this aribute when a user adds
the asset to the catalog. Once it is set, it cannot be modiﬁed.

Last Modified

The date on which the catalog entry for the asset was last
updated. CentraSite automatically updates this aribute when
a user modiﬁes any of the asset's aributes.

Submitting
Organization

The organization to which the asset belongs.
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Attribute

Description

Owner

The user who currently owns the asset. CentraSite
automatically sets this aribute when a user adds the asset to
the catalog.

Lifecycle
State

The asset's current lifecycle state. If a lifecycle model has been
associated with an asset type, CentraSite updates this aribute
as the asset passes through its lifecycle.

Attribute Data Types
When you add an aribute to a type, you specify the aribute's data type. The data type
determines what kind of information the aribute can hold. After you add an aribute
to a type, the aribute's data type cannot be changed.

The following table lists the data types that you can assign to an aribute. Most types
can be conﬁgured to hold a single value or multiple values (i.e., an array of values).
Data Type

Description

Boolean

Holds a true or false value.
Note: When a Boolean value is displayed in the CentraSite
Eclipse GUI, its value is generally displayed as "Yes" (if the
aribute's value is true) or "No" (if the aribute's value is
false).

Classiﬁcation

Holds references to one or more categories in a speciﬁed
taxonomy. You use this type of aribute to classify assets
according to a speciﬁed taxonomy.

Computed
Aribute

Holds a value that is supplied by a user-deﬁned Java plug-in.
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Data Type

Description

Date/Time

Holds a timestamp that represents a speciﬁc date and/or time.

Duration

Holds a value that represents a period of time as expressed in
Years, Months, Days, Hours, Minutes and Seconds.

Email

Holds an email address. This data type only accepts values in
the format:
anyString @anyString
Note: When a user enters a value for an Email aribute,
CentraSite veriﬁes that the value conforms to the format
above, but it does not aempt to validate the address
itself.

File

Holds references to one or more documents that reside in
CentraSite's supporting document library or at a speciﬁed URL.
You can use this type of aribute to aach documents such as
programming guides, sample code and other types of ﬁles to an
asset.

IP Address

Holds a numeric IP address in the v4 or v6 format.

Multiline
String

Holds a string of text. When this type of string is displayed in
a CentraSite user interface, the string is displayed in a multiline text box and lines of text are wrapped to ﬁt the width of the
box. (Compare this with the String data type described below.)
The Internationalized option allows you to store the text in
internationalized string format. For more information about the
Internationalized option, see the String data type, below.

Number

Holds a numeric value. When you deﬁne an aribute of this
type, you can specify the number of decimal positions that are
to be shown when the aribute is displayed in a user interface.
If you do not want to restrict the number of decimal positions
that the user interface displays, choose the Maximum Precision
option to display all positions.
You can optionally assign a label such as Seconds, tps, KB, EUR
or $ to aributes of this type, and specify whether this label is
to appear as a preﬁx or a suﬃx when the aribute's value is
displayed in a user interface.
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Data Type

Description
Note: The underlying data type for this kind of aribute is a Java
double.

String

Holds a string of text. When this type of string is displayed, it is
displayed in a single-line text box. If a value exceeds the width
of the box, the excess characters are simply not displayed.
The Internationalized option allows you to create a String
aribute that holds diﬀerent values for diﬀerent locales.
In CentraSite Eclipse GUI, for example, if a user logs on to
CentraSite in an English locale and he or she assigns a value to
an Internationalized String aribute, that value will be visible
to other users with English locales. If a user in a German locale
were to view the aribute, the aribute would appear empty
because it has no value for the German locale. If the Germanlocale user were to subsequently assign a value to the aribute,
the aribute would then have two String values: one in English
and one in German.
When CentraSite Eclipse GUI displays an Internationalized
String, it displays the value associated with the user's current
locale. In the example described above, it would show the
English value to users with English locales and the German
value to users in German locales. Users in other locales would
see an empty aribute until a value for their locale had been
assigned to the aribute.
The Enumeration option allows you to specify a list of allowed
values for the aribute.

URL/URI

Holds a URL/URI. This type of aribute only accepts values in
the form:
protocol ://host / path
Where:
protocol is any protocol that java.net.URL supports
host is the name or IP address of a host machine
path (optional) is the path to the requested resource on the
speciﬁed host

Relationship

Holds references to other registry objects. You use this type of
aribute to express a relationship between an asset and another
object in the registry.
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Data Type

Description

RichText

Holds a string of text that can optionally include HTML tags.
When CentraSite Eclipse GUI displays a Rich Text aribute, it
formats the text according to the embedded HTML tags (if any)
the text contains.
Besides rendering text in HTML format, a Rich Text aribute
diﬀers from a String aribute in the following ways:
The value of a Rich Text aribute is stored in CentraSite UI
document repository, not in the object database.
A Rich Text aribute can hold much more text than a String
aribute.

Attribute Names
An aribute that is one of the following types has two names associated with it: a display
name and a schema name.
Boolean
Date
Duration
Email
Multiline String
IP Address
Number
String
URL
The display name for these types of aributes is the name that is displayed by the
CentraSite Eclipse GUI. An aribute's display name can consist of any combination of
characters, including spaces.
The following are all valid aribute names:
Business Owner
Amount (in $)
Numéro de téléphone
Avg. Invocations/Minute
1099 Code

You can change an aribute's display name at any time.
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The aribute's schema name is the name that CentraSite actually gives to the underlying
JAXR slot that represents the aribute in the registry. This name must be NCNameconformant, meaning that:
The name must begin with a leer or the underscore character (_).
The remainder of the name can contain any combination of leers, digits, or the
following characters: . - _ (i.e., period, dash, or underscore). It can also contain
combining characters and extender characters (e.g., diacriticals).
The name cannot contain any spaces.
For more information about the NCName type, see “hp://www.w3.org/TR/
xmlschema-2/#NCName”.
If you do not specify a schema name for an aribute, CentraSite automatically generates
a default schema name based on the aribute's display name. It does this by taking
the aribute's display name and replacing any spaces in the name with underscore
characters (_). If the default name that CentraSite generates is not NCName-conformant,
you must explicitly assign a valid schema name to the aribute.
The following table describes the default schema names that CentraSite would generate
for the display names shown above.
For this Display
Name…

CentraSite would generate
this schema name…

The resulting schema name is…

Business
Owner

Business_Owner

Valid. You would not need to
change the schema name.

Amount (in $)

Amount_(in_$)

Invalid. A schema name cannot
include the () or $ characters.
You must replace the default
name with a valid schema name.
You might, for example, use
Amount or AmountInDollars as
the schema name.

Numéro de
téléphone

Numéro_de_téléphone

Valid. You would not need to
change the schema name.

Avg.
Invocations
Minute

Avg._Invocations/
Minute

Invalid. A name must not include
the / character. You must replace
the default name with a valid
schema name. You might, for
example, use AvgInvokesPerMin
as the schema name.
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For this Display
Name…

CentraSite would generate
this schema name…

The resulting schema name is…

1099 Code

1099_Code

Invalid. A schema name must not
begin with a number. You must
replace the default name with a
valid schema name. You might,
for example, use _1099_Code or
code1099 as the schema name.

Note also that an aribute's schema name must be unique within the type (i.e., two
aributes in a type cannot have the same schema name).
After the aribute is created, you can no longer change its schema name.

Names for the Other Attribute Types
The concept of display names and schema names does not apply to the following types
of aributes:
Classiﬁcation
File
Relationship
These types are not represented using JAXR slots and, therefore, do not require
underlying schema names. These aributes have one name, which can consist of any
combination of leers, numbers or special characters (including spaces).

Computed Attributes
CentraSite Eclipse GUI oﬀers you the possibility to use computed aributes in the asset
type deﬁnitions and proﬁles.
The computed aribute holds a value that is supplied by a user-deﬁned Java plug-in.
Once you have deﬁned a computed aribute, you can use it in CentraSite Eclipse GUI in
the same way as any other aribute.
The available computed aributes can be viewed and edited in the “Details Editor” on
page 130 when the object's deﬁnition is displayed. You can, for example, assign the
aribute to a proﬁle or reorder the aribute position within a proﬁle.

Defining a Computed Attribute
The computed aribute is deﬁned as the implementation of the ComputedAttribute
interface. The following topics describe how to deﬁne a computed aribute:
“Implementation guidelines for Java-based computed aributes” on page 46
“Structure of archive ﬁle” on page 47
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“Sample code” on page 47
Implementation guidelines for Java-based computed attributes
This section describes the Java interfaces and methods that you need to implement for a
computed aribute.
Interfaces

Description

ComputedAribute This interface declares basic rendering methods for the user
interface. It extends the ProﬁleAribute interface.
boolean: isUsed(): returns true if this aribute is used by at
least one instance of the corresponding asset type.
Collection: setValue(Collection);
ProﬁleAribute

void: init(Collection<CentraSiteRegistryObject>, Locale)
Collection: getValue();
String: getAributeKey();
AributeDescriptor: getAributeDescriptor();

AributeDescriptor This interface deals with the standard properties
(isReadOnly(), is Required()...) for an aribute.
String: getDataType(): returns the data type of this
aribute. This can be one of the supported standard types
(xs:...), or one of the special types: File, RichText, Image
(allows the speciﬁcation of the image type).
Object: getDefaultValue(): returns the default value of this
aribute.
String[]: getEnumValues():
int: getMaxLength(): returns the maximum length of this
aribute.
String: getMaxOccurs(): returns whether the aribute can
have multiple occurrences.
String: getMinOccurs(): returns whether the aribute is
optional or required.
Object: getNativeAribute(): returns the native aribute
instance if the data type is not primitive, otherwise returns
null.
int: getPrecision(): gets the precision for a number aribute.
String: getUnitLabel(): returns the slot's unit label.
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Interfaces

Description
boolean: hasDefaultValue(): returns whether this aribute
has a default value.
boolean: isPreﬁx(): Returns true if the slot's unit label is a
preﬁx, and false if it is a suﬃx.
boolean: isReadOnly(): returns whether this aribute is
read-only.
boolean: isRequired(): returns whether this aribute is
required.

Structure of archive file
The archive ﬁle must contain the following folders and ﬁles:
Zip folder

Description

META-INF

This folder contains the conﬁg.properties ﬁle, which is the build
ﬁle for the plug-in. This properties ﬁle contains an entry of the
following format:
com.softwareag.centrasite.computed.attr.impl.class=
com.sample.StringAttrImpl

lib

This folder contains the archive ﬁle with the source code
examples, the plug-in's executor class and the external libraries.

Sample code
Sample Java code for implementing a computed aribute is supplied in the demos folder
under CentraSite installation folder. The sample code is available in the ﬁles:
ComputedAribute.java
ProﬁleAribute.java
AributeDescriptor.java

Profiles
In the CentraSite Eclipse GUI, the deﬁnition of a registry object is represented by
aributes and proﬁles.
Proﬁles are used to manage the presentation of aributes in the CentraSite Eclipse GUI.
They determine how the aributes are grouped when a registry object is displayed.
Proﬁles and aributes are displayed in the “Details Editor” on page 130. Each proﬁle
is displayed on an individual tab, each tab showing the aributes assigned to the
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proﬁle. When you display an asset in CentraSite Eclipse GUI, for example, the aributes
associated with a particular proﬁle are grouped together on a tab. Note that a tab is only
displayed in the editor if you have permission to view the corresponding proﬁle.
In CentraSite Eclipse GUI, proﬁles appear as tabs:

When you deﬁne an asset type, you specify the proﬁles on which its aributes are to
be displayed. CentraSite does not require an aribute to be assigned to a proﬁle. If you
do not assign an aribute to a proﬁle, the aribute will not be visible in the CentraSite
Eclipse GUI (the aribute will still be available via the API). You can assign an aribute
to multiple proﬁles if you want it to appear on multiple proﬁles (tabs) in the CentraSite
Eclipse GUI.
You can deﬁne any number of proﬁles for an asset type. You can specify the order in
which you want the proﬁles to appear when an instance of the type is displayed. You
can also specify the order in which aributes are to be displayed within each proﬁle.

Generic Profiles
In addition to the proﬁles that you deﬁne, CentraSite provides several predeﬁned
proﬁles, called generic proﬁles, which you can optionally include in an asset type.
The generic proﬁles contain system-deﬁned aributes and controls. The information
on the generic proﬁles is generated by CentraSite. You cannot customize the content of
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the generic proﬁles or add aributes to them. You can, however, select which of these
proﬁles you want CentraSite to include with an asset type.
Generic Profile

Description

General

Displays the asset's generic information. This proﬁle
contains the general aributes that are common to all
registry objects (Name, Description, Organization etc).

Summary

Available only for Service, XML Schema, and Application Server
asset types. Provides basic information about a Service,
XML Schema or Application Server. For a service asset,
this proﬁle includes a list of the operations and bindings
that the service provides.

Notifications

Displays the list of users who are registered to receive
notiﬁcations when changes are made to the asset.

Classification

Displays the list of categories by which an asset is
classiﬁed. This proﬁle also contains controls for adding ad
hoc classiﬁers to an asset.

Associations

Displays the list of objects to which the asset is related.
This proﬁle also contains controls for establishing "ad hoc"
relationships between an asset and other objects in the
registry.

Permissions

Displays the asset's instance-level permissions. This proﬁle
also contains controls for modifying the asset's instancelevel permissions.
To view all of the instance-level permissions for an asset, a
user must have Modify or Full permissions on the asset. To
edit the instance-level permissions for an asset, a user must
have Full permissions on the asset. If a user has only View
permission on an asset, the Permissions proﬁle shows only
that particular user's permissions for the asset.
Note: The Permissions proﬁle is enabled for all asset types.
You cannot disable this proﬁle at the type level.
To restrict access to this proﬁle, use instance-level
permissions.

Versions

Displays the versioning history for an asset and provides
links to earlier versions and revisions of the asset. This
proﬁle also contains the controls for generating a new
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Generic Profile

Description
version of the asset, purging older versions of the asset and
reverting to a previous version of an asset.

External Links

Displays the list of links to external documents and ﬁles
that are aached to the asset. This proﬁle also contains
controls for aaching documents and ﬁles to an asset.

Object-Specific
Properties

Displays the list of object-speciﬁc properties that have been
assigned to an asset. An object-speciﬁc property consists
of a key, which identiﬁes the name of the property, and an
optional String value, which contains the data associated
with the property. (A property's value can be null.)
Object-speciﬁc properties are used to hold information
about an instance of an asset when there is no predeﬁned
aribute to hold that data. Typically, they are used in oneoﬀ situations to aach ad-hoc data to an instance of an
asset. For example, if you were managing a certiﬁcation
eﬀort, you might use an object-speciﬁc property to identify
the set of assets that required certiﬁcation.
Note: The Object-Specific Properties proﬁle is enabled for all
asset types. You cannot disable this proﬁle at the type
level. To restrict access to this proﬁle, use instancelevel permissions.

Audit Log

Displays the update activity associated with an asset. This
proﬁle lists each change that has been made to an asset and
identiﬁes the user that made the change.

Subscriptions

Displays the list of users who are registered to receive
notiﬁcations when changes are made to the asset.

Policies

Displays the list of design/change-time policies and runtime policies that are applicable to an asset (i.e., it displays
all the policies whose scope encompasses the displayed
asset).
Note: The Policies proﬁle is displayed for virtualized
services regardless of whether you enable or disable
it for the Service asset type. In other words, when
you disable the Policies proﬁle for the Service asset
type, the CentraSite Eclipse GUI removes the proﬁle
from service assets, but continues to display it for
virtualized services.
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Generic Profile

Description

Performance

Displays the run-time performance metrics associated
with an asset. If you are using webMethods Mediator,
webMethods Insight or another run-time monitoring
component to log performance metrics for an asset,
CentraSite displays those metrics on this proﬁle.
Note: The Performance proﬁle is displayed for virtual
services regardless of whether you enable or disable
it for the Service asset type. In other words, when you
disable the Performance proﬁle for the Service asset
type, CentraSite Eclipse GUI removes the proﬁle from
service assets, but continues to display it for virtual
services.

Computed Profiles
CentraSite Eclipse GUI oﬀers you the possibility to add computed proﬁles into asset
type deﬁnitions. In a computed proﬁle, you can implement your own algorithms
for calculating the values you wish to represent. You can, for example, aggregate or
compute aribute information from embedded or linked objects.
A computed proﬁle is a user-deﬁned proﬁle that is implemented as a Java plug-in.
You add the computed proﬁle to the asset type by importing the computed proﬁle's
deﬁnition from an archive ﬁle. The plug-in speciﬁes the aributes that are contained
in the proﬁle. The plug-in also has the sole responsibility for rendering the layout
representation within the proﬁle.
After a computed proﬁle has been deﬁned for an asset type, the computed proﬁle is
treated in the same way as any other proﬁle; for example, permissions for computed
proﬁles can be granted in the same way as for standard proﬁles, and the ordering
of proﬁles within a type deﬁnition is the same for computed proﬁles as for standard
proﬁles.
If the computed proﬁle has been implemented to be used without user interfaces, it will
be available both in CentraSite Control and in Eclipse. If the computed proﬁle is to be
used with user interfaces, it must be implemented separately for CentraSite Control and
for the CentraSite Eclipse GUI.

Defining a Computed Profile
The following topics describe how to deﬁne a computed proﬁle:
“Implementation guidelines for Java-based computed proﬁles” on page 52
“Structure of archive ﬁle” on page 54
“Sample code” on page 54
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Implementation guidelines for Java-based computed profiles
This section describes the Java interfaces and methods that you need to implement for a
computed proﬁle.
Interfaces

Description

ComputedProﬁle

This interface declares basic rendering methods for the
user interface.
void: init(java.lang.Object, Locale): with
CentraSiteRegistryObject as a parameter where the
necessary implementation is done and updateAsset()
which would return a collection of registry object serves
as a save hook.
boolean: canRenderUI(): This determines whether the
rendering is based on the UI (true) or on the triples
associated with the proﬁle (false).
Collection: getAributes(): returns a collection of
ProfileAttribute and would be called only when
canRenderUI() returns true.
Collection: updateAsset(): returns a collection of
CentraSiteRegistryObject and would be called only
when canRenderUI() returns true.

WebUIProﬁle

This interface is speciﬁc to the rendering for CentraSite
Control. (Other rendering can be provided for e.g.
Eclipse)
java.lang.Object: createProﬁleContent(): create the
proﬁle contents with XML content (in compliance with
Application Designer).

ProﬁleAribute

This interface deals with the standard UI rendering of
the proﬁle's aributes and allows deﬁning the aributes
as key value pairs. The rendering of each aribute
will be the standard rendering for the corresponding
datatype of the aribute.
AributeDescriptor: getAributeDescriptor(): returns
the descriptor of the aribute.
String: getAributeKey(): returns the key of the
aribute.
String: getName(): returns the name of the aribute.
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Interfaces

Description
Collection: getValue(): returns the value of the aribute.

ComputedAribute
Line

This interface deals with the user-deﬁned UI rendering
of the proﬁle's aributes. The UI rendering of the
aributes will be determined by the coding of this
interface.
void: buildUI(StringBuilder layout): This method is
responsible for rendering the layout deﬁnition.
void: passivate(): This method is responsible for storing
the values back to the object.
void: revert(): This method is to revert the changes.

AributeDescriptor

This interface deals with the standard properties
(isReadOnly(), is Required()...) for an aribute.
String: getMinOccurs(): returns the minimum allowed
occurrences of this aribute.
String: getMaxOccurs(): returns the maximum allowed
occurrences of this aribute.
boolean: isRequired(): returns whether this aribute is
required.
boolean: isReadOnly(): returns whether this aribute is
read-only.
boolean: hasDefaultValue(): returns whether this
aribute has a default value.
Object: getDefaultValue(): returns the default value of
this aribute.
int: getMaxLength(): returns the maximum length of this
aribute.
String: getDataType(): returns the data type of this
aribute.
Object: getNativeAtribute(): returns the native aribute
instance if the data type is not primitive, otherwise
returns null.
String[]: getEnumValues():
boolean: isPreﬁx(): returns whether this slot's unit label
is a preﬁx or suﬃx value. Return true if the unit label is
a preﬁx, false for suﬃx.
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Interfaces

Description
int getPrecision(): returns the precision for a number
aribute.
String: getUnitLabel(): returns this slot's unit label. The
label may be null.

Structure of archive file
The archive ﬁle must contain the following folders and ﬁles:
Zip folder

Description

META-INF

This folder contains the conﬁg.properties ﬁle, which is the
build ﬁle for the plug-in. This properties ﬁle contains an
entry of the following format:
com.softwareag.centrasite.computed.profile.webui.impl.
class= com.sample.MyProfileImpl

lib

This folder contains the archive ﬁle with the source code
examples, the plug-in's executor class and the external
libraries.

Sample code
Sample Java code for implementing a computed proﬁle is supplied in the demos folder
under CentraSite installation folder. The sample code is available in the ﬁles:
ComputedProﬁle.java
WebUIProﬁle.java

Namespaces
CentraSite is an XML registry and repository. In XML, a namespace identiﬁes elements
or aributes as belonging to a particular set of deﬁnitions. If several XML documents use
the same element name or aribute name to denote diﬀerent things, namespaces can be
used to treat them as distinct objects. Elements marked as belonging to one particular
namespace can, for example, be processed separately from the others, if required, by
using ﬁltering mechanisms, such as that provided by the XSLT stylesheet language.
When you create your own object types, you are prompted for a namespace. This is
used as a namespace qualiﬁer for the elements and aributes in the object type's schema
deﬁnition.
The following example shows why namespaces are important: If you wish to import
an object type deﬁnition from another CentraSite installation, and an object type of
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the same name but with a diﬀerent deﬁnition already exists in your installation, it is
nevertheless possible to import the object type deﬁnition as long as the namespaces
diﬀer.
A namespace is speciﬁed as a URL, for example, http://www.MyCompany.com/
MyDepartment. The URL does not need to be the address of a real Web location, but
it should be chosen to be unique to your business organization and represent your
company or department as precisely as possible. This ensures that if your ontology
is ever used in the same environment as an ontology from another organization, the
chances of having the same namespace name are minimized.
Note:

Some namespaces are reserved for internal use in CentraSite and must not be
used as user-deﬁned namespaces:
http://namespaces.CentraSite.com/Schema
http://namespaces.CentraSite.com/Schema/jaxr

Namespaces are not displayed in the navigation views of the CentraSite
Eclipse GUI. You can at any time see them in the details of a speciﬁc object
type.

Notifications
CentraSite provides features and functions for notifying users about changes to registry
objects: Users can register notiﬁcation requests for any number of registry objects.
Whenever an object that is tagged for notiﬁcation changes, the users are notiﬁed
accordingly.
You can access the list of registry objects for which you have registered a notiﬁcation
request as well as the change notiﬁcations you have already received for your requests
from the Notiﬁcations folder in the My view. When a registry object for which you have
registered a notiﬁcation request changes, a corresponding alert is set and displayed for
the object in the Contents view. To notice the next change of the object immediately, you
can remove the alert in the view.
All users who have registered a notiﬁcation request for a speciﬁc object are listed on the
Notiﬁcations tab in the “Details Editor” on page 130.

Security
CentraSite provides a sophisticated access control concept that allows you to deﬁne
exactly which users can view and manipulate Assets and Registry Objects in the
CentraSite registry and Supporting Documents and Resources in the CentraSite
repository. At diﬀerent levels, access can be granted or denied to single users, groups or
roles.
Access is controlled by permissions which deﬁne whether a user, a group or a role is
allowed to perform a single operation or a set of operations. In the CentraSite Eclipse
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GUI, three types of permission are distinguished: view, edit or delete a registry object
in the CentraSite registry or a folder or ﬁle in the CentraSite repository. View and edit
permission for a registry object can be granted for its complete deﬁnition or it can be
restricted to individual Aributes.
In the CentraSite Eclipse GUI, you can display the security seings on the Permissions in
the “Details Editor” on page 130. To deﬁne users, groups, roles and permissions, use
the CentraSite Control (Web interface).

Users, Groups and Roles in CentraSite
A user to whom access can be granted or denied in CentraSite is a user who is known
to an external authentication system (such as an operating system or Active Directory
Server) and is mapped to a registry object of the User type. Registry objects of the User
type are inactive until they are associated with an external user. Only active users can
log on to CentraSite. For creating users and associating them to external users, use the
CentraSite Control (Web interface). The Registry Explorer View of the CentraSite Eclipse
GUI enable you to access the User objects and see whether a user is active or inactive.
A role deﬁnes a set of permissions. Each user is assigned at least one role. When a user
is assigned to a role, he/she receives all the permissions deﬁned for the role. CentraSite
distinguishes between system-level roles and organization-level roles. Whereas systemlevel roles apply across all organizations, organization-level roles are eﬀective for exactly
one organization. For both types, CentraSite provides predeﬁned roles. You can also
create your own system-level and organization-level roles to suit your organizational
requirements.
The following roles are examples of predeﬁned system-level roles in CentraSite:
CentraSite Administrator: The main administration role which provides access to the
complete set of functions that is available in CentraSite.
Guest: The default role for unauthenticated users. Users with this role are permied
to search and browse the assets stored in the CentraSite registry.
Asset Type Administrator: A user with this role is permied to create and
manipulate object types and taxonomies.
The following roles are examples of predeﬁned organization-level roles in CentraSite:
Asset Provider: A user with this role can create and manage registry objects.
Depending on the permission's scope, the user can either create and manage registry
objects for their organization only or for all organizations deﬁned in CentraSite.
Asset Consumer: A user with this role can read registry objects. The user cannot
create new registry objects. Depending on the permission's scope, the user can either
read registry objects of their organization only or of all organizations deﬁned in
CentraSite.
Document Administrator: A user with this role is responsible for managing an
organization's Supporting Documents Library. The user can view, add, edit and
delete documents.
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A group deﬁnes a set of users with identical roles and permissions. CentraSite provides
predeﬁned groups. You can also create your own groups to suit your organizational
requirements.
The functions for user, group and role management are available in the CentraSite
Control (Web interface). For detailed information, refer to the documentation which
comes with the CentraSite Control.

Security Settings for Object Types
For each object type in the CentraSite registry, you can deﬁne security seings which
apply to all registry objects of this type. You can assign the permissions described below
to individual users and/or roles.
Note:

The security seings apply to the objects of a type, but not to the type itself.
To control access to the object type deﬁnition, deﬁne Security Seings for
Registry Objects which represents the type. The registry object representing
the type is a Taxonomy object of type ObjectType.

Object Type

Permission

Description

Objects

View

Allows objects of the type to be read.

Edit

Allows objects of the type to be created and
modiﬁed.

Delete

Allows objects of the type to be deleted.

View

Allows Associations Between Registry Objects for
objects of the type to be read.

Edit

Allows associations for objects of the type to be
created.

Delete

Allows associations for objects of the type to be
deleted.

View

Allows Audit Logs for objects of the type to be
read.

Edit

Allows auditable events for objects of the type to
be modiﬁed.

Associations

Auditable events
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Object Type

Classifications

Permission

Description

Delete

Allows auditable events for objects of the type to
be deleted.

View

Allows Classiﬁcations of Registry Objects for
objects of the type to be read.

Edit

Allows classiﬁcations for objects of the type to be
created.

Delete

Allows classiﬁcations for objects of the type to be
deleted.

Security Settings for Registry Objects
For each Assets and Registry Objects in the CentraSite registry, you can grant or deny
the permissions described below to individual users, groups and/or roles.
Note the following:
Users, groups and roles must also have the appropriate permissions for the registry
object's type.
When a user, group or role is assigned more than one permission, only the ﬁrst is
relevant. The remaining ones are ignored.
Permission

Description

View

Allows read operations for the object. View permission for a registry
object can be granted to its complete deﬁnition or it can be restricted to
individual Aributes.

Edit

Allows modiﬁcations to the object. Edit permission for a registry
object can be granted to its complete deﬁnition or it can be restricted to
individual proﬁles.

Delete

Allows the object to be deleted.

Security Settings for Folders and Files
For each Supporting Documents and Resources in the CentraSite repository, you can
grant or deny the permissions described below to individual users, groups and/or roles.
Note the following:
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When a user, a group or a role is assigned more than one permission, only the ﬁrst is
relevant. The remaining ones are ignored.
Since the CentraSite repository is a WebDAV site, the security seings available
correspond to WebDAV ACL privileges.
Permission

Description

View

Allows read operations for the folder or ﬁle.

Edit

Allows modiﬁcations to the properties of the folder or ﬁle.
For folders: Allows subfolders and ﬁles in the folder to be created.
For ﬁles: Allows the ﬁle contents to be changed.

Delete

For folders only: Allows subfolders and ﬁles in the folder to be
deleted.

Audit Logs
CentraSite records in audit logs all actions carried out on registry objects. The audit log
of a registry object allows you, for example, to ﬁnd out when and by whom an object
was created or changed.
The audit log of a registry object you select is displayed on the Audit Log tab in the
“Details Editor” on page 130.
Technically, audit log entries are stored as registry objects of the AuditableEvent type.
An AuditableEvent object can be assigned an object-speciﬁc property named Comment
whose value is displayed in the Comment column of the audit log.

CentraSite Eclipse UI Help Version 10.3

59

M

Even Header

CentraSite Eclipse UI Help Version 10.3

60

M

Odd Header
Tasks

3

Tasks

■ Browsing the Registry ..................................................................................................................

62

■ Browsing the Repository ..............................................................................................................

65

■ Using Favorites ............................................................................................................................

66

■ Working with Registry Objects .....................................................................................................

67

■ Working with Supporting Documents and Resources .................................................................

84

■ Working with Associations and External Links ............................................................................

88

■ Exporting Data from Centrasite ...................................................................................................

94

■ Importing Data into CentraSite ....................................................................................................

96

■ Working with Reports .................................................................................................................

106

CentraSite Eclipse UI Help Version 10.3

61

M

Even Header
Tasks

Browsing the Registry
The CentraSite Eclipse GUI provides you with various ways and means to browse a
Registry and Repository.

Asset Types View
The Asset Types View allows you to access the assets stored in the CentraSite registry. In
the view, you select which types of assets you want to access. After selecting the types,
all assets that exist for these types are displayed in the Contents View. Two options are
provided for selecting types in the Asset Types view:
Select the checkboxes for the asset types you want to access. Then click the
buon
or double-click a type in the view to display all existing assets of the selected types in
the Contents view.
Press the
buon. Now select a checkbox for an asset type to display the
corresponding assets in the Contents view.
The
buon toggles the selection mode in the view. The
buon is only relevant
when the
buon is not pressed. The Workbench remembers the selection mode you
have set for the Asset Types view. The next time you start the CentraSite Eclipse GUI,
the selection mode is set as you left it.

My View
The My View allows you to access:
Registry objects, folders and ﬁles that you use frequently or that you want to keep
close at hand.
Assets for which you are registered as owner.
Searches and lists you have saved in CentraSite.
Registry objects for which you have registered a notiﬁcation request and for which
you have received change notiﬁcations.
In the view, you select the elements that you want to access. After selecting an entry
in the view, the corresponding registry objects are listed in the Contents View. Files
and folders are listed in the Documents View. The
buon in the toolbar of the view
deﬁnes how to select an entry in the My CentraSite view:
buon is pressed: Single-click an entry in the My CentraSite view to list the
corresponding elements in the Contents or Documents view.
buon is not pressed: Double-click an entry in the My CentraSite view to list the
corresponding elements in the Contents or Documents view.
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The Workbench remembers the selection mode you have set for the My CentraSite view.
The next time you open the view, the selection mode is set as you have left it.
For your favorite registry objects, the My CentraSite view also allows you to open the
“Details Editor” on page 130. Depending on your Changing Preference Seings,
single-click or double-click a favorite registry object to view or modify its detailed
deﬁnition in the editor.

Registry Explorer View
The registry objects displayed in the Registry Explorer View depend on how your
system administrator has conﬁgured the view's contents. Diﬀerent conﬁgurations can be
available, from which you can choose the appropriate one to work with.
The default conﬁguration sorts the registry objects in the view by organizations. For
each organization, you can browse a tree structure that has branches for Organizations,
Services, Users and all asset types for which assets exist in the registry.
Independent of the conﬁguration, the view provides the following options:
Click the plus sign (+) in front of a tree heading or a registry object name to expand
the next level of the hierarchy.
Click the minus sign (-) in front of a tree heading or a registry object name to collapse
the hierarchy below.
Use the Registry Explorer View for browsing the registry.
Depending on the Changing Preference Seings you have deﬁned for the
“Preference Seings” on page 18, view a list of the predeﬁned number of assets or
click the plus sign (+) at the end of the list to the next list of asset or view all assets.
Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click a registry object to view or
modify its detailed deﬁnition in the editor.
Note:

If the number of elements below a speciﬁc object in the tree exceeds 128, only
128 elements at a time are displayed. At the end of the list, n more elements
is appended, where n is the number of elements not yet displayed. Via the
context menu of this entry, you can select to show all elements or the next 128
elements.

Impact Analyzer View
The Impact Analyzer View represents registry objects and their associations and implicit
references with other objects graphically. The graphical representation is enabled via a
Flash-based Web browser.
The view is not included in the CentraSite perspectives by default. It is automatically
opened when you start a graphical impact analysis with the Impact Analyzer.
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The Impact Analyzer view provides the following options:
Use the options in the view's menu bar to select the types of associations, implicit
references and registry objects you want to include in the impact analysis and
display in the view.
Single-click a registry object in the view to display the object's owner, version
number and description.
Important: If you are running Designer on a 64-bit operating system, ensure that you
have installed the Adobe Flash Plugin 64-bit in the 64-bit Web browser.

Administration View
The Administration View allows you to access the registry objects namely, taxonomies
and report templates. In the view, you select which objects you want to access. All
objects that exist for the selected type are listed in the Contents View.
The

buon in the toolbar of the Administration view deﬁnes how to select objects:

If the
buon is pressed: Single-click an entry in the Administration view to
display the corresponding registry objects in the Contents view.
If the
buon is not pressed: Double-click an entry in the Administration view to
display the corresponding registry objects in the Contents view.
The Workbench remembers the selection mode you have set for the Administration
view. The next time you open the view, the selection mode is set as you have left it.

Contents and Search View
The Contents View and the Search View display registry objects in simple lists. The
Contents view may also display objects in structured lists. You have the following
options:
Click the plus sign (+) in front of an entry to expand the next level of the structure.
Click the minus sign (-) in front of an entry to collapse the structure below.
Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click a registry object to view or
modify its detailed deﬁnition in the editor.
The
buon in the toolbar deﬁnes how to use the listed objects for browsing the
registry:
If the
buon is pressed: Single-click an entry in the view to focus the
corresponding object in the Registry Explorer View.
If the
buon is not pressed: Double-click an entry in the view to focus the
corresponding object in the Registry Explorer.
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Note that an object in the Registry Explorer can only be focused if the
buon is
pressed in these views. The Workbench remembers the selection mode you have set for
the Contents or Search view. The next time you open the views, the selection mode is set
as you have left it.

Details Editor
Speciﬁc tabs in the “Details Editor” on page 130 display registry objects in tables.
By double-clicking an object or by selecting the Details option from the object's context
menu, you can select the object and open its detailed deﬁnition in the CentraSite Details
editor.

Browsing the Repository
The CentraSite Eclipse GUI provides you with diﬀerent means and ways to browse a
Registry and Repository.

Repository Explorer View
In the Repository Explorer View, the folders of the CentraSite repository are shown in a
tree like in any standard ﬁle explorer. You have the following options:
Click the plus sign (+) in front of a folder name to expand the next level of the tree.
Click the minus sign (-) in front of a folder name to collapse the tree below.
Single-click a folder to select it. For a selected folder, the Documents View displays
the folders and ﬁles it contains.
By default, the Repository Explorer view displays the contents of the Supporting
Documents Library of the organization to which you are assigned. As an administrator,
you can choose to display all folders of the CentraSite repository if you need to browse
to folders and ﬁles stored outside the library. To do so, select the Advanced menu option
in the view's toolbar. Deselect the menu option to switch back to displaying the contents
of the Supporting Documents Library only.

Documents View
The Documents View displays the contents of the folder you have selected in the
Repository Explorer view. You have the following options:
Double-click a folder to display the folders and ﬁles it contains in the Documents
view and focus it in the Repository Explorer view.
Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click an element in the Documents
view to display its details in the CentraSite Details editor.
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Select Show Document in a ﬁle's context menu to display its contents in an editor.
The editor depends on the ﬁle's type. You can specify the editors to be used for
speciﬁc ﬁle types in the Preferences of the Eclipse Workbench.
Click the
buon in the toolbar or choose Up in the context menu to move up one
level in the folder hierarchy, i.e. to display the contents of the current folder's parent
folder in the Documents view.

Using Favorites
The CentraSite Eclipse GUI allows you to create and maintain a list of your favorite
Assets and Registry Objects. Your favorites are displayed in the My Favorites folder of
the My View.
You can add any registry objects to your favorite list, rename entries in the favorite list
and remove obsolete entries from the favorite list.
In addition to working with you favorite registry objects, the CentraSite Eclipse GUI
automatically provides you with direct access to all assets for which you are registered
as owner and to all search queries and lists you have saved in CentraSite. Your assets,
search queries and lists are automatically displayed in the My Favorites folder of the My
View.
In the My Favorites folder of the My CentraSite view, you can work in a way similar to
the Registry Explorer View views:
Click the plus sign (+) in front of an entry to expand the next level of the structure.
Click the minus sign (-) in front of an entry to collapse the structure below.
Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click a registry object for viewing or
modifying its detailed deﬁnition in the editor.
Select a list, a search or the Assets I Provide entry to list the corresponding registry
objects in the Contents View. To select an entry, single-click or double-click it,
depending on the selection mode you have set for the My CentraSite view. This
displays your assets or the objects contained in a list in the Contents view. The
results of a search are displayed in the Search View view.

Adding Favorites
To add a registry object to your favorites
Drag and drop the registry object from a Views to the My CentraSite view.
Or:
1. Select the registry object in a CentraSite navigation or list view.
2. Select Add to Favorites from the context menu.
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3. In the dialog displayed, specify a name for the favorite.

Managing Favorites
You can manage your favorites in the My CentraSite view.
To rename a favorite
1. Select the favorite you want to rename.
2. Select Rename Favorite from the context menu, or press the F2 key on the keyboard.
3. Specify the new name in the dialog displayed.
To delete a favorite from the favorites list
1. Select the favorite you want to delete.
2. Press the DELETE key on the keyboard, or select Delete Favorite from the context
menu.
3. Conﬁrm the deletion in the dialog displayed.

Working with Registry Objects
This section describes tasks and actions related to Assets and Registry Objects.

Searching and Finding Registry Objects
The CentraSite Eclipse GUI provides you with an advanced search facility which helps
you ﬁnd Assets and Registry Objects in the CentraSite registry. It adds the following
pages to the standard Search dialog of the Eclipse Workbench, which you use to specify
the search criteria:
Keyword Search Page for searches by keywords.
Advanced Search Page for searches by search conditions.
XQuery Page for searches by queries.
The registry objects found by a search are listed in the Search View. In this view, you can
repeat previous searches with the same or reﬁned search criteria.
The following sections describe:
The basic procedures for carrying out searches.
How to specify keywords for a search.
How to specify search conditions.
How to specify queries in XQuery format.
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Executing a Search
To execute a new search
1. Do one of the following:
Click the

buon in the main toolbar of the Eclipse Workbench.

Select Search > Search or Search > CentraSite from the main menu.
2. In the Search dialog:
Enter keywords on the Keyword Search Page, or
Specify search conditions on the Advanced Search Page, or
Enter a query in XQuery format on the XQuery Page.
You can save deﬁned keywords, search conditions or a query in XQuery format
for later reuse: Type a name of your choice in the Saved search ﬁeld of the
corresponding search page and click Save. The saved queries are user-speciﬁc and
can be used by the same user on any client. They are added to the My Favorites
folder in the My View.
To use a query you have saved, just select it in the Saved search ﬁeld.
3. Click Search to start the search.
The registry objects found are listed in the Search View. You can work with the
found registry objects in the same way as you work with other registry objects in a
CentraSite navigation or list view.
You can abort a long-running search by clicking the

buon in the Search view.

In the Search view, you can:
Repeat the most recent search: Click the

buon or press F5.

Repeat a previous search by selecting it in the list that is displayed when you click
the arrow next to the
buon. The entire list of previous searches can be deleted
with Clear History at the boom of the list. In the dialog displayed when you click
the
buon or when you select History in its menu, you can remove individual
entries from the search history.
Repeat the most recent search with reﬁned criteria: Click the
buon. In the Search
dialog, specify additional search conditions on the CentraSite Search page, change
the keywords on the CentraSite Keyword Search page or change the query on the
CentraSite XQuery page, as required.
In the My CentraSite view, you can:
Repeat a saved search: Click the name of the saved search in the My Favorites folder.
Delete a saved search: Navigate to the search to be deleted in the My Favorites folder
and choose Delete Saved Search from the context menu.
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Specifying Keywords
On the Keyword Search Page of the Search dialog, you can specify keywords for
searching for registry objects. All objects will be found that contain the speciﬁed text
strings in their name, description, or any property of the string data type.

Specifying Search Conditions
On the Advanced Search Page of the Search dialog, you can specify search conditions.
The search conditions you have deﬁned are displayed in the table. One condition
specifying the type of the registry objects to be found is always present. You can change
it, but not remove it.
All search conditions you specify are combined by logical ANDs in the search. They
cannot be ORed.
You have the following options of specifying search conditions:
Add a new search condition: Click the
buon. In the Add Condition dialog, select
a condition and specify its details. The available conditions depend on the selected
object type. For a description of all conditions, refer to Search and Filter Conditions.
Remove a search condition: Select the condition in the table and click the

buon.

Modify an existing search condition: Double-click the condition in the table and
specify the new details in the Modify Condition dialog.

Using XQuery
You can use queries in XQuery format to search for registry objects. On the XQuery Page
of the Search dialog, you can type or paste any query that fulﬁlls the syntactical and
semantical requirements of CentraSite and returns a list of registry objects as its result.
For details on XQuery in CentraSite, contact your CentraSite support organization.
The CentraSite Eclipse GUI oﬀers the following feature to help you write queries for
searching registry objects: On the CentraSite Advanced Search page of the Search dialog,
specify search conditions of your choice. When you click the
buon, a new Search
dialog is opened and the XQuery representation of the search conditions is displayed
on the CentraSite XQuery page. Now you can, for example, execute the query, edit it, or
save it for later reuse.

Creating Registry Objects
You can create new Assets and Registry Objects of any object type in the CentraSite
Eclipse GUI. The CentraSite Eclipse GUI distinguishes between creating registry objects
representing assets and supporting objects.
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Creating Assets
To create an asset
1. Do one of the following:
Use the Asset Types View or My View to display any assets in the Contents
View. Click
in the toolbar of the Contents view.
In the Registry Explorer View, select the organization that provides the asset.
Select New > Asset in the context menu.
2. On the Asset Details page of the Create Asset wizard, select the organization to
which the new asset is to be assigned.
3. Select the type for the new asset.
4. Enter the name and, optionally, a description for the new asset. The name and
description you enter in the dialog are stored for the language selected in the
Changing Preference Seings of the Eclipse Workbench.
5. Click Finish to open the “Details Editor” on page 130 for the new asset.
6. Use the tabs in the editor to Updating Registry Objects. The tabs that are displayed
depend on the asset's type. You can, for example, deﬁne Properties of Registry
Objects, Associations Between Registry Objects, External Links or Classiﬁcations of
Registry Objects for the asset.
7. Save the object's deﬁnition, for example, by selecting File > Save from the main menu
or by typing Ctrl+S.
Note:

To represent SOA assets in CentraSite, it is often not suﬃcient to create a
single object in the registry. For example, a Web service or a process deﬁnition
is represented by several Assets and Registry Objects as well as Supporting
Documents and Resources in the CentraSite repository. Refer to Creating
Services for the basic steps required to represent a Web service in CentraSite.
Instead of creating all the required registry objects, folders and ﬁles manually,
you can use the CentraSite Importing Data into CentraSite. These functions
allow you to import data of diﬀerent types and create all the required registry
objects, folders and ﬁles.

Creating Supporting Objects
To create a supporting object
Use the Administration View to display a list of existing supporting objects in the
Contents View. Click
in the view's toolbar to start the New Object wizard for
creating a new object.
Use the My View or Registry Explorer View to navigate to the parent object under
which you want to create the new registry object. Select the type of registry object
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you want to create from the New submenu in the parent's context menu. This starts
the New Object wizard. The New submenu oﬀers all the object types available
for new registry objects at this position. For example, if you have selected an
organization, you can create objects of type Organization or User below it.
The pages of the New Object wizard diﬀer, depending on the type of supporting object
you are creating. To ﬁll in the wizard:
1. On the ﬁrst page of the wizard, specify the new object's Properties of Registry
Objects, as requested. The properties depend on the type of registry object you are
creating. For all types of object, you can specify a name and a description. The name
and description you enter are stored for the language selected in the Changing
Preference Seings of the Eclipse Workbench. Clicking the
buon next to the
Name or Description ﬁeld opens a Edit Dialog where you can enter names and
descriptions for diﬀerent locales.
2. Click Next to move to the next wizard page, or click Finish to create the object now
without deﬁning custom properties.
3. On the Custom Properties page, you can deﬁne Properties of Registry Objects for the
new registry object. For each property, you can deﬁne a name, a namespace in which
the property is valid and one or several values.
4. Click Finish to close the wizard and open the “Details Editor” on page 130 for the
new object.
5. Use the tabs in the editor to Updating Registry Objects. The tabs that are displayed
depend on the object's type. You can, for example, deﬁne Properties of Registry
Objects, Associations Between Registry Objects, External Links or Classiﬁcations of
Registry Objects for the object.
6. Save the object's deﬁnition, for example, by selecting File > Save from the main menu
or by typing Ctrl+S.

Creating Services
In order to represent a Web service in CentraSite, you will usually use the Importing
Web Services function. In some cases, however, you may wish to manually create the
Assets and Registry Objects for a Web service.
The following registry objects are required to represent a Web service:
An object of the Service type representing the service itself.
ServiceBinding objects that describe a speciﬁc way to access a speciﬁc interface
oﬀered by a service. Each service may have a set of service bindings.
SpeciﬁcationLink objects that link a service binding and a registry object which
represents a service interface with operations or a speciﬁcation that describes how
to use the service via the service binding. Each service binding may have a set
of speciﬁcation link instances. Usually, registry objects linked to a service by a
speciﬁcation link are categories or objects of the Interface type. The linked objects are
displayed below the corresponding speciﬁcation links in the tree.
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An external link to a WSDL ﬁle in the CentraSite repository describing the service.
To manually create these objects and files
1. Do one of the following:
Use the Asset Types View or My View to display any assets in the Contents
View. Click
in the toolbar of the Contents view.
In the Registry Explorer View, select the organization that provides the Web
service. Select New > Service in the context menu.
2. On the Asset Details page of the Create Asset wizard, select the organization to
which the new service is to be assigned.
3. Select Service as the type.
4. Enter the name and, optionally, a description for the new service. The name and
description you enter in the dialog are stored for the language selected in the
Changing Preference Seings of the Eclipse Workbench.
5. Click Finish to open the “Details Editor” on page 130 for the new service.
6. Use the tabs in the editor to Updating Registry Objects.
7. Save the service's deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.
8. Add the service bindings to the service, for example, by navigating to the service in
a CentraSite navigation or list view and selecting New > Service Binding from the
service's context menu.
9. Add speciﬁcation links to each service binding as required, for example, by
navigating to a service binding in a CentraSite navigation or list view and selecting
New > Speciﬁcation Link from the service binding's context menu.
10. Aach the appropriate WSDL ﬁle to the service. You can do this in one of the
following ways:
Use the Importing Web Services function and specify the appropriate WSDL
ﬁle. As a prerequisite, the service object in the registry must have the following
Classifying Registry Objects: uddi-org:xml:namespace taxonomy, namespace
in WSDL ﬁle speciﬁed as the classiﬁcation value. uddi-org:xml:localName
taxonomy, service's name in WSDL ﬁle speciﬁed as the classiﬁcation value. The
import function can thus locate the service in the WSDL ﬁle and update the
registry and repository accordingly.
Use the Aach WSDL option in the context menu of the service object in the
registry. This menu option displays a dialog where you can specify the WSDL
ﬁle to be used in the same way as when importing a Web service. In this case, the
service's namespace and local name in the registry are set to the namespace and
local name speciﬁed in the WSDL ﬁle.
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Versioning Services
When you create a new version of a registry object of the Service type, the following
actions are performed:
A new registry object of the Service type is created, which represents the new version
and has its own key.
The name and description of the old version are copied to the new version. You can
modify them later, if required, either manually or by aaching a new WSDL ﬁle to
the new service version.
The Namespaces of the new version is the one you specify in the New Version
wizard.
The Properties of Registry Objects of the old version are copied to the new version,
except for the following: The new version has its own unique key. The user version
identiﬁer of the new version is the one you specify in the New Version wizard.
The major version number of the CentraSite version identiﬁer is increased by 1 for
the new version, the minor version number is set to 0.
The Status, Stability and Expiration of Registry Objects of the old version are copied
to the new version.
The new version is assigned to the same organization as the old version.
The new version is assigned the same internal and external Classifying Registry
Objects as the old version.
The service bindings and speciﬁcation links of the old service version are copied
to the new version. Registry objects which are referenced by the speciﬁcation links
(e.g. Interface objects) are also copied. If these objects are versionable, the copies are
represented as new versions. The new service version re-uses all required ﬁles of
the old version in the repository. New versions of the relevant External Links are
created, which link the new service version and the existing ﬁles.
Associations Between Registry Objects of the old service version as well as of its
service bindings and speciﬁcation links are copied to the new version according to
the rules described below.
Aributes of the old version are copied to the new version. See above for the
actions performed for properties, classiﬁcations, associations or external links. The
same actions are performed when copying aributes that visualize properties,
classiﬁcations, associations or external links.
Subscriptions for Notiﬁcations at the old version are NOT copied to the new version.
Similarly, if you added the old version to your Using Favorites, the new version is
NOT added automatically.
The Security Seings for Registry Objects of the old version are copied to the new
version.

CentraSite Eclipse UI Help Version 10.3

73

M

Even Header
Tasks

The Audit Logs of the old version is copied to the new version, and a new entry is
added for the versioning operation at the new version.

Handling of Associations
When you create a new version of a service, its associations and the corresponding target
or source objects are handled according to the following rules. The same rules apply to
associations assigned to service bindings and speciﬁcation links of the service.
Outgoing associations:
Associations of the following types are NOT copied to the new version of the
service, i.e. the new version does not have these associations: BelongsTo, HasParent,
EquivalentTo, Extends, Supersedes, user-deﬁned associations.
Associations of the following types are copied to the new version and linked to
the same target object as for the old service version: RelatedTo, ExternallyLinked,
InstanceOf, Uses, Replaces, ResponsibleFor, SubmierOf.
Associations of the following types are copied to the new version and linked to a
copy of the target object: HasChild, HasMember, Contains, Implements. The copy
of the target object is created by the versioning operation. If the target object is a
versionable object, the copy is represented as a new version of the target object.
Incoming associations:
Associations of the following types are NOT copied to the new version of the
service, i.e. the new version does not have these associations: BelongsTo, RelatedTo,
HasChild, HasMember, ExternallyLinked, Contains, EquivalentTo, Extends,
Implements, Supersedes, Uses, Replaces, ResponsibleFor, SubmierOf, user-deﬁned
associations.
Associations of the following types are copied to the new version and linked to the
same source object as for the old service version: InstanceOf.
Associations of the following types are copied to the new version and linked to a
copy of the source object: HasParent. The copy of the source object is created by
the versioning operation. If the source object is a versionable object, the copy is
represented as a new version of the source object.

Updating Registry Objects
You can update a Assets and Registry Objects in the “Details Editor” on page 130
when the object's deﬁnition is displayed.
To update a registry object
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click a registry object in a CentraSite view to
open the editor.
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2. Use the Details Editor for Registry Objects to modify the object's details. The tabs
that are displayed depend on the object's type. See below for hints on how to update
the deﬁnition.
3. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.
In the CentraSite Details editor, you use the diﬀerent tabs for updating Properties
of Registry Objects, Associations Between Registry Objects, External Links or
Classiﬁcations of Registry Objects of the registry object:
Use the Object-Speciﬁc Properties, Associations, External Links or Classiﬁcations tab
if no Aributes exists that maps to the property, the association, the external link or
classiﬁcation you want to create, modify or remove.
Use the set of custom proﬁles that is visible for the object to create, modify or remove
aributes that map to a property, an association, an external link or a classiﬁcation.
Do not use the tabs for the predeﬁned proﬁles if corresponding aributes are
available in Aributes.
Note the following hints for updating an object's deﬁnition:
Mandatory
attribute

Attributes marked with an asterisk (*) are mandatory. The object's definition
cannot be saved without entering a value for these attributes.

Read-only
aribute

Aributes can be read-only. The value given for the aribute cannot
be changed.
If the aribute has a

buon next to it, multiple values can be

speciﬁed. Enter the ﬁrst value in the ﬁeld and click
. A new line is
inserted for entering the next value. You can enter as many values as
required.
If the aribute has a
buon next to it, click it to remove an
aribute value you no longer need.
Simple
input ﬁeld

For some aributes, you can type the value directly in the input
ﬁeld. For example, the Description property can be entered directly.
If the aribute supports values for diﬀerent locales, the value you
type in the ﬁeld is stored for the language selected in the Changing
Preference Seings.
Input ﬁelds oﬀer basic text editing functions such as undo, cut, copy,
and paste, that help you entering values.
If the aribute has a
buon next to it, click it, and update the
value in the dialog displayed. For speciﬁc properties, for example,
the Name and Description properties, you can enter and change
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Mandatory
attribute

Attributes marked with an asterisk (*) are mandatory. The object's definition
cannot be saved without entering a value for these attributes.
values for diﬀerent locales in this Edit Dialog. Click OK to apply your
changes and close the dialog.
If the aribute has a
buon next to it, click it, and enter a date and/
or time in the Select Date and Time Dialog.
If the aribute has a
buon next to it, its value represents a
registry object. For example, the Owner of an object is a registry
object of the User type. To enter or change the value, click the
buon and select the appropriate object in the Select Object Dialog.
Click OK to apply your changes and close the dialog.
If the aribute has a
buon next to it, its value represents an
external link. To deﬁne the external link, click the
buon and enter
the URL of the external resource that is to become the target of the
external link, for example, hp://myserver:53305/CentraSite/ino:dav/
documents/icons/dbms.gif. Alternatively, you can select a document
from the ﬁle system of your computer that is to become the target of
the external link.
Note:

If you have speciﬁed a password-protected document, and
the document you want to access requires user authentication,
simply enter the username and password in the authentication
dialog. This authentication request happens only when you try
to access a protected document for the ﬁrst time.

Classifying Registry Objects
You can categorize Assets and Registry Objects by Classiﬁcations of Registry Objects.
You can assign any number of internal and external classiﬁcations to a registry object,
and add or remove assignments later. The classiﬁcations assigned to a selected registry
object are displayed on the Classiﬁcations in the “Details Editor” on page 130. You
can also display all registry objects that are classiﬁed by a selected category.
Use the following options for assigning and deassigning classiﬁcations only for
classiﬁcations that are not represented by Aributes in one of the custom proﬁles in the
CentraSite Details editor. For working on aributes, use the mechanisms for Updating
Registry Objects.
Note:

The object type is a speciﬁc category (ObjectType taxonomy), which is
assigned implicitly to a registry object when the object is created. This
assignment cannot be changed.
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Assigning Classifications to Registry Objects
To assign classiﬁcations to registry objects, use one of the following procedures.
To assign an internal or external classification
1. In a CentraSite navigation or list view, select one or more objects to which you want
to assign classiﬁcations.
2. Select Classify from the context menu.
3. In the Classify wizard, specify whether you want to assign internal or external
classiﬁcations to the registry objects. Click Next.
4. If you choose to assign internal classiﬁcations, select the appropriate category or
categories on the Select Object Dialog page of the wizard. Click Finish to create the
classiﬁcation assignments. If you choose to assign an external classiﬁcation, select the
appropriate taxonomy on the Select Object Dialog page of the wizard. Click Next. On
the Specify Classiﬁcation page, specify the classiﬁcation name and value.
5. Click Finish to create the classiﬁcation assignments.
To assign an internal classification
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object to which you want to
assign internal classiﬁcations in a CentraSite view to open the editor. The object's
classiﬁcations are displayed on the Classiﬁcations tab.
2. On the Classiﬁcations tab, click
in the toolbar, or select Add Internal
Classiﬁcations from the table's context menu.
3. On the Select Object Dialog page of the Add Internal Classiﬁcations wizard, select
the appropriate category or categories.
4. Click Finish to create the classiﬁcation assignments.
5. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.
To assign an external classification
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object to which you want to
assign an external classiﬁcation in a CentraSite view to open the editor. The object's
classiﬁcations are displayed on the Classiﬁcations tab.
2. On the Classiﬁcations tab, click
in the toolbar, or select Add External
Classiﬁcation from the table's context menu.
3. On the Select Object Dialog page of the Add External Classiﬁcation wizard, select the
appropriate taxonomy, and click Next.
4. On the Specify Classiﬁcation page, specify the classiﬁcation name and value.
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5. Click Finish to create the classiﬁcation assignment.
6. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Deassigning Classifications from Registry Objects
To deassign internal and/or external classifications from a registry object
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object from which you want
to deassign classiﬁcations in a CentraSite view to open the editor. The object's
classiﬁcations are displayed on the Classiﬁcations tab.
2. On the Classiﬁcations tab, select the classiﬁcations you want to deassign from the
object.
3. Click

in the toolbar, or select Remove Classiﬁcations from the context menu.

4. Conﬁrm the removal in the dialog displayed.
5. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Displaying Classified Registry Objects
To display the registry objects classified by a category
1. Navigate to the required category. Use the Administration View to display the
taxonomy to which the category belongs in the Contents View.
2. Select Show Objects Classiﬁed By from the category's context menu. The registry
objects classiﬁed by the selected category are displayed in the Search View.

Organizing Registry Objects in Lists
You can organize and group Assets and Registry Objects by assigning them to lists. You
can assign any number of registry objects of the same or diﬀerent types to any number
of lists, and add or remove list assignments later.
The lists you have created are displayed in the My Favorites folder in the My View.
Depending on the selection mode you have set for the view, you can single-click or
double-click a list entry in the view to display the registry objects assigned to it in the
Contents View.
To assign registry objects to lists
1. In a Views, select one or more objects which you want to assign to a list.
2. Select Add to List from the context menu.
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3. In the Add To List dialog, select the list to which the objects are to be assigned. You
can add the objects to an existing list or create a new one.
4. Click OK to create the assignments.
To deassign a registry object from a list
1. Depending on the selection mode you have set for the My CentraSite view, singleclick or double-click the list from which to deassign registry objects in the My
CentraSite view. The registry objects currently assigned to it are listed in the
Contents view.
2. Select one or more objects that you want to deassign from the list.
3. Select Remove from List from the context menu.
4. Conﬁrm the removal in the dialog displayed.

Impact Analysis for Registry Objects
You can carry out an impact analysis for any registry object in the CentraSite registry. An
impact analysis helps you determine which registry objects will be aﬀected by changes
to a selected object.
The CentraSite Eclipse GUI supports the following types of impact analysis:
Textual impact analysis: A textual impact analysis retrieves registry objects that
have associations or implicit references with a selected object and displays them in
the Contents View. The list shows which objects will be aﬀected by a change to the
selected one.
To carry out a textual impact analysis for a registry object, select the object in a
CentraSite navigation or list view and choose Impact Analysis > Textual from its
context menu.
Graphical impact analysis with the Impact Analyzer: The Impact Analyzer View
represents registry objects and their Associations Between Registry Objects with
other objects graphically. The Impact Analyzer's graphical representation is
displayed using a Flash-based Web browser. You can see the inter-dependencies of
the objects and navigate the object structure. The menu options in the view's menu
bar allow you to determine exactly what you want to display, and to resize and print
the graph as required.
You can open the Impact Analyzer view from a selected registry object in a Views by
choosing Impact Analysis > Graphical - Analyzer from its context menu.
Important: If you are running Designer on a 64-bit operating system, ensure that you
have installed the Adobe Flash Plugin 64-bit in the 64-bit Web browser.
For each type of impact analysis, you can specify exactly which types of objects,
associations and implicit references are to be taken into account and to be displayed in
the Impact Analyzer or Contents view.
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To do this for the graphical analysis with the Impact Analyzer, start an analysis and
specify the corresponding seings using the Customizing Options for the Impact
Analyzer. When the view is opened, the results of the analysis are displayed with the
most recent seings that you have used.
To deﬁne the seings for the graphical analysis with textual analysis, specify the
corresponding options in the Customize Dialog dialog, which you can invoke in one of
the following ways:
Select Impact Analysis > Customize from the context menu of a registry object in a
CentraSite navigation or list view.
Click

in the toolbar of the Contents view.

Be aware that the seings you make in the Customize dialog are valid for both graphical
and textual impact analysis.
Note:

CentraSite automatically performs an implicit impact analysis when you
aempt to perform an operation that might violate overall system integrity
by breaking usage relationships (for example, when you try to delete a Web
service that is still in use by a business process). In such cases, you will be
prompted for conﬁrmation or the operation will not be executable at all.

Working with Registry Object Versions
This section describes tasks and actions related to Versions of Registry Objects:
“Creating Registry Object Versions” on page 80
“Displaying Registry Object Versions” on page 81
“Deleting Registry Object Versions” on page 81

Creating Registry Object Versions
In this release of CentraSite, you can explicitly create new Versions of Registry Objects of
registry objects of the Service type.
The general procedure to create a new version of a registry object is described below.
The actions performed depend on the type of the registry object. For details on the
actions performed when versioning services, see Versioning Services.
To create a new version of a registry object
1. In a Views view, navigate to the registry object for which you want to create a new
version. If the registry object already has more than one version, select the most
recent version.
2. Select Versions > New from the object's context menu.
3. On the Create New Version page of the New Version wizard, you can specify a
Namespaces and a user version identiﬁer for the new version. You can also describe
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how the old version has changed compared to the new version to be created. The
default value of the user version identiﬁer is generated as follows: If the user version
identiﬁer is identical to the CentraSite version identiﬁer of the old version, the user
version identiﬁer of the new version is set to the new CentraSite version identiﬁer;
otherwise the value of the user version identiﬁer is left unchanged.
4. Click Finish to create the new version.
A log of the versioning operation is created and displayed in the Contents View.
The log provides the following information:
For each processing step, one line is displayed in the view.
The Status column shows if the processing was successful (OK), or whether errors or
warnings occurred. A corresponding message is displayed in the Message column.
On top of the table, the number of successful steps, warnings and errors is displayed.

Displaying Registry Object Versions
The Views display all existing Versions of Registry Objects of Assets and Registry
Objects. In order to obtain an overview of the versions of a speciﬁc object, you can
display the object's deﬁnition in the “Details Editor” on page 130 and list the
individual versions on the Versions.
On the Versions tab, you can choose the Details option from a version's context menu to
open the version's detailed deﬁnition in the editor area.

Deleting Registry Object Versions
CentraSite provides options for deleting the Versions of Registry Objects of Assets
and Registry Objects. As a prerequisite, the object versions must not be the target of
an Associations Between Registry Objects, and they must not be the source of implicit
references.
Deleting the Most Recent Object Version
You can delete the most recent version of a registry object in the same way as you can
Deleting Registry Objects that do not have multiple versions.
To delete the most recent object version
1. In a Views, navigate to the registry object version you want to delete.
2. Press the DELETE key on the keyboard, or select Delete from the version's context
menu.
3. Conﬁrm the deletion in the dialog displayed.
Purging Object Versions
You can delete all predecessor versions of a selected registry object version in a single
operation.
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To purge object versions
1. In a CentraSite navigation or list view, navigate to the registry object version whose
predecessor versions you want to delete.
2. Select Versions > Purge from the version's context menu.
3. Conﬁrm the deletion in the dialog displayed.

Using Notifications
CentraSite provides features and functions for Notiﬁcations you about changes to Assets
and Registry Objects. You can register notiﬁcation requests for any number of registry
objects. Whenever such an object changes, you are notiﬁed accordingly.
You can access the list of registry objects for which you have registered notiﬁcation
requests as well as the corresponding change notiﬁcations from the Notiﬁcations
folder in the My View. Using the Notiﬁcations entry, you can display the list of change
notiﬁcations you have already received for your notiﬁcation requests in the Contents
View. Using the Subscriptions entry, you can display the list of registry objects for which
you have registered a notiﬁcation request in the Contents view.
All users who have registered a notiﬁcation request for an object are listed on the
Notiﬁcations in the “Details Editor” on page 130 when the object's deﬁnition is
displayed.

Registering and Managing Notification Requests for Registry Objects
To register a notification request for a registry object
1. In a Views, navigate to the registry object you are interested in.
2. Select Notify me from the object's context menu.
To display the notiﬁcation requests you have registered:
In the My View, double-click or single-click the Subscriptions entry in the Notiﬁcations
folder, depending on the selection mode you have set for the view. This displays all
registry objects for which you have registered a notiﬁcation request in the Contents
View.
To deregister a notification request for a registry object
1. Display the registry objects for which you have registered a notiﬁcation request in
the Contents view.
2. Select the registry object for which you want to deregister the notiﬁcation request.
3. Click
in the view's toolbar, or select Remove from Subscriptions from the object's
context menu.
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Managing Change Notifications
To manage your change notifications
In the My View, double-click or single-click the Notiﬁcations entry in the Notiﬁcations
folder, depending on the selection mode you have set for the view. This displays the
list of change notiﬁcations you have already received for your requests in the Contents
view.

The Request Date column displays the date and time you registered the notiﬁcation
request. The
icon indicates that the registry object has been changed since you
registered the notiﬁcation request or since you last removed the change alert.
To acknowledge that you have received a notification
1. Select the registry object for which you want to acknowledge that you have received
the notiﬁcation in the Contents view.
2. Click

in the view's toolbar.

The
alert icon indicating a notiﬁcation for the selected object is removed. You thus
acknowledge that you have received the notiﬁcation.

Deleting Registry Objects
You can delete objects from the CentraSite registry. As prerequisites, the object to be
deleted must not be the target of an Associations Between Registry Objects unless you
have simultaneously selected the source of the Associations Between Registry Objects for
deletion, and it must not be the source of an implicit reference.
To delete one or more registry objects
1. In a Views, select one or more registry objects you want to delete.
2. Press the DELETE key on the keyboard, or select Delete from the context menu.
3. Conﬁrm the deletion in the dialog displayed.
The selected objects are deleted, and the CentraSite views are updated accordingly.
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Working with Supporting Documents and Resources
This section describes tasks and actions related to Supporting Documents and Resources
in the CentraSite repository.

Creating Folders and Files
You can create new Supporting Documents and Resources in the CentraSite repository
from the CentraSite Eclipse GUI. New folders are created directly in the repository.
Creating a new ﬁle means uploading an existing ﬁle from the ﬁle system to the
repository.
To create a new folder
1. In the Repository Explorer View or Documents View, navigate to the folder under
which you want to create the new folder.
2. Select New > Folder from the folder's context menu.
3. In the New Folder dialog, specify the name for the new folder.
4. Click OK to create the folder.
To create a new file
1. In the Repository Explorer or Documents view, navigate to the folder under which
you want to create the new ﬁle.
2. Select New > File from the folder's context menu.
3. In the New File dialog, specify the path and name of the ﬁle you want to upload to
the repository, or use the Browse buon to select the ﬁle in the ﬁle system of your
computer.
4. Click OK to upload the ﬁle to the CentraSite repository.
Depending on the editor seings you have deﬁned in the Changing Preference Seings
of the Workbench, you can double-click or single-click a new folder or a new ﬁle in the
Repository Explorer or Documents view to display its details in the “Details Editor” on
page 130.

Updating Properties of Folders and Files
You can update the Properties of Resources of a folder or ﬁle in the “Details Editor” on
page 130. A new version of a ﬁle is created each time its deﬁnition is modiﬁed.
You can:
Rename ﬁles or folders.
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Change the description of ﬁles.
To rename a file or folder
1. Depending on the editor seings you have deﬁned in the Changing Preference
Seings of the Workbench, double-click or single-click the folder or ﬁle to be
renamed in the Repository Explorer View or Documents View to display its details
in the CentraSite Details editor.
2. On the General tab, type the new name directly in the Name ﬁeld.
3. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.
Alternatively, you can use the Repository Explorer or the Documents view to rename
ﬁles or folders: Navigate to the folder or ﬁle to be renamed and select the Rename option
from the folder's or ﬁle's context menu.
To change the description of a file
1. Depending on the editor seings you have deﬁned in the Preferences of the
Workbench, double-click or single-click the ﬁle in the Repository Explorer or
Documents view to display its details in the CentraSite Details editor.
2. On the General tab, type the new description directly in the Description ﬁeld.
3. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Displaying the Contents of Files
You can display the current contents of a Supporting Documents and Resources stored
in the CentraSite repository. The editor that is opened depends on the ﬁle's type. You can
specify the editors to be used for speciﬁc ﬁle types in the Changing Preference Seings
of the Workbench.
You have the following options for displaying the contents of a ﬁle:
Using the Documents View.
Using the Versions in the “Details Editor” on page 130.
To display the contents of a file using the Documents view
1. Navigate to the folder that contains the ﬁle.
2. Single-click the folder to display the ﬁles it contains in the Documents view.
3. Select Show Document from a ﬁle's context menu to display the ﬁle's contents.
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To display the contents of a file using the Versions tab in the CentraSite Details editor
1. Depending on the editor seings you have deﬁned in the Preferences of the
Workbench, double-click or single-click the ﬁle in the Documents view to display its
contents in the CentraSite Details editor.
2. Activate the Versions tab to display the versions that exist for the ﬁle.
3. Select Show Document from a version's context menu to display the ﬁle's contents.

Displaying File Versions
The Supporting Documents and Resources stored in the CentraSite repository are
versionable. A new version of a ﬁle is created each time changes to it are uploaded to the
repository or each time its deﬁnition is modiﬁed.
To obtain an overview of the versions of a specific file
1. Depending on the editor seings you have deﬁned in the Changing Preference
Seings of the Workbench, double-click or single-click a ﬁle in the Documents View
to display its details in the “Details Editor” on page 130.
2. Activate the Versions to display the versions that exist for it.
On the Versions tab, you can select the Details option from a version's context menu to
open the version's deﬁnition in the CentraSite Details editor.
You can select the Show Document option from a version's context menu to display
its contents in an editor. The editor that is opened depends on the ﬁle's type. You can
specify the editors to be used for speciﬁc ﬁle types in the Preferences of the Workbench.

Impact Analysis for Folders and Files
You can carry out an impact analysis for any Supporting Documents and Resources in
the CentraSite repository. An impact analysis helps you determine which Assets and
Registry Objects will be aﬀected by changes to a folder or ﬁle.
An impact analysis for a ﬁle retrieves all registry objects that depend on it, for example,
because they have an External Links to it. An impact analysis for a folder retrieves all
registry objects that depend on the folder itself or on any folder or ﬁle it contains.
To carry out an impact analysis for a folder or file
1. In the Repository Explorer View or Documents View, navigate to the folder or ﬁle for
which you want to carry out an impact analysis.
2. Select Impact Analysis from the folder's or ﬁle's context menu.
The registry objects found by the impact analysis are listed in the Contents View.
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Saving Files to the Eclipse Workspace
You can copy any Supporting Documents and Resources stored in the CentraSite
repository to your Eclipse workspace.
To copy a file to your Eclipse workspace
1. Do one of the following:
In the Documents View, navigate to the ﬁle you want to copy to your Eclipse
workspace.
On the External Links displayed for a registry object in the “Details Editor” on
page 130, select an External Links which refers to the ﬁle you want to copy to
your Eclipse workspace.
2. Select Save to Workspace from the ﬁle's or external link's context menu.
3. In the Save Resource dialog, specify or select the location and name for the ﬁle in
your workspace.
4. Click Finish to copy the ﬁle from the repository to your workspace.

Renaming Folders and Files
You can rename Supporting Documents and Resources in the CentraSite repository. The
folder or ﬁle you want to rename must not be the target of an External Links. Folders
you want to rename must not contain folders or ﬁles that are the targets of external links.
You have the following options for renaming folders and ﬁles:
Using the Repository Explorer View or the Documents View.
Using the General in the “Details Editor” on page 130.
To rename a folder or file using the Repository Explorer or Documents view
1. In the Repository Explorer or Documents view, navigate to the folder or ﬁle you
want to rename.
2. Select Rename from the folder's or ﬁle's context menu.
3. Type the new name in the dialog displayed.
4. Click OK to apply the changes.
To rename a folder or file using the General tab in the CentraSite Details editor
1. Depending on the editor seings you have deﬁned in the Changing Preference
Seings of the Workbench, double-click or single-click the folder or ﬁle to be
renamed in the Repository Explorer or Documents view to display its details in the
CentraSite Details editor.
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2. On the General tab, type the new name directly in the Name ﬁeld.
3. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Deleting Folders and Files
You can delete Supporting Documents and Resources from the CentraSite repository.
When you delete a folder, all its contents are also deleted.
The folder or ﬁle you want to delete must not be the target of an External Links. Folders
you want to delete must not contain folders or ﬁles that are the targets of external links.
To delete one or more folders or files
1. In the Repository Explorer View or Documents View, select one or more folders or
ﬁles you want to delete.
2. Press the DELETE key on the keyboard, or select Delete from the context menu.
3. Conﬁrm the deletion in the dialog displayed.

Working with Associations and External Links
This section describes tasks and actions related to Associations Between Registry Objects
and External Links:

Displaying Associations and External Links
For displaying Associations Between Registry Objects and External Links of registry
objects, you can use the following components of the CentraSite Eclipse GUI:
Associations in the “Details Editor” on page 130 for listing associations.
External Links in the CentraSite Details editor for listing external links.
Additionally, the Contents View and the Classiﬁcations in the CentraSite Details editor
display the target objects of speciﬁc associations and implicit references.
Associations can also be displayed in the set of Aributes that is visible for a registry
object in the CentraSite Details editor. As a prerequisite, an Aributes which maps to the
displayed association must have been deﬁned in the registry object's type deﬁnition.

Creating Associations Between Objects
You can connect registry objects with each other by Associations Between Registry
Objects. You have the following options for creating associations.
“Creating Associations by Drag and Drop” on page 89
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“Creating Associations Using the Associations Tab” on page 89
Use these options only for associations that are not represented by Aributes in one of
the custom proﬁles in the CentraSite Details editor. For working on aributes, use the
mechanisms for Updating Registry Objects.

Creating Associations by Drag and Drop
To create an association between two registry objects using drag and drop
1. In a Views, navigate to the object which is to become the source object of the
association, and drag it to the object which is to become the target object of the
association.
2. In the dialog displayed, select the type of association you want to create between the
two objects.
3. Click OK to create the association.

Creating Associations Using the Associations Tab
Using the Assign Associations options on the Associations in the CentraSite Details
editor, you can create one or more outgoing associations from the selected object to one
or more target objects.
To create associations using the Associations tab
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object for which you want to
create associations in a CentraSite view to open the editor. The object's associations
are displayed on the Associations tab.
2. Click

, or select Assign Associations from an association's context menu.

3. In the wizard displayed, Select Object Dialog that is/are to become the target object(s)
of the association(s), then click Next.
4. Select one or more types of association you want to create between the current object
and the target object(s).
5. Click Finish to create the association(s).
6. Save the changed deﬁnition of the registry object, for example, by selecting File >
Save from the main menu or by typing Ctrl+S.

Removing Associations Between Objects
You can at any time remove Associations Between Registry Objects you have created
between registry objects.
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Use the following steps for removing an association only for associations that are not
represented by Aributes in one of the custom proﬁles in the CentraSite Details editor.
For working on aributes, use the mechanisms for Updating Registry Objects.
To remove associations between objects
1. Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click the registry object from which
you want to remove associations in a CentraSite view to open the editor. The existing
associations are displayed on the Associations.
2. On the Associations tab, select one or more associations you want to remove. You
can only remove outgoing associations from the selected object to one or more
target objects. For removing incoming associations, you have to navigate to the
corresponding source object.
3. Click

in the tab's toolbar, or select Remove Associations from the context menu.

4. Conﬁrm the removal in the dialog displayed.
5. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Creating External Links for Objects
Using External Links, you can establish connections between Assets and Registry
Objects and resources that are managed outside the registry, for example, Supporting
Documents and Resources in the Supporting Documents Library.
You have the following options for creating external links for registry objects.
“Creating External Links by Drag and Drop” on page 91
“Creating External Links Using the External Links Tab” on page 91
“Creating External Links by Copying Existing Ones” on page 92
Use these options only for external links that are not represented by Aributes in one of
the custom proﬁles in the CentraSite Details editor. For working on aributes, use the
mechanisms for Updating Registry Objects.
Note:

The CentraSite Eclipse GUI allows you to create a registry object of the
ExternalLink type that represents a folder or ﬁle in the registry, but is
not connected to a registry object. To do this, select the folder or ﬁle in
the Repository Explorer View or Documents View, choose New External
Link from the folder's or ﬁle's context menu, and specify a name for the
ExternalLink object in the dialog.
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Creating External Links by Drag and Drop
With drag and drop, you can create an external link between a registry object and a
folder or ﬁle that is displayed in the Repository Explorer View or in the Documents
View.
To create an external link between a registry object and a folder or file that is displayed in the
Repository Explorer view or Documents view
1. In a Views, navigate to the registry object for which you want to create the external
link.
2. Drag the object to the folder or ﬁle in the Repository Explorer or Documents view
that is to become the target of the external link.

Creating External Links Using the External Links Tab
Using the Add External Link option on the External Links in the CentraSite Details
editor, you can create an external link for a selected registry object:
You can aach a document from your organization's supporting document library.
The supporting document library is a collection of shareable documents that
members of your organization have uploaded to CentraSite's document repository.
For more information about the supporting document library, see “Working with
Supporting Documents and Resources” on page 84.
You can aach any document on the network that is accessible via a URL (permied
protocols are hp, hps, ﬁle and ftp).
To create an external link using a URL
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object for which you want to
create an external link in a CentraSite view to open the editor. The object's external
links are displayed on the External Links tab.
2. On the External Links tab, click
link's context menu.

in the toolbar, or select Add External Link from a

The Add External Link dialog is displayed.
3. Enable the Point to URL option and type the document's URL (for example, hp://
myserver:53305/CentraSite/ino:dav/documents/icons/dbms.gif) into the adjacent text
box. (Supported protocols are hp, hps, ﬁle and ftp.)
4. Click Finish to create the external link.
5. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.
6. Repeat steps 2 to 5 for each document that you want to aach.
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To create an external link from the Supporting Document Library (SDL)
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object for which you want to
create an external link in a CentraSite view to open the editor. The object's external
links are displayed on the External Links tab.
2. On the External Links tab, click
link's context menu.

in the toolbar, or select Add External Link from a

The Add External Link dialog is displayed.
3. Enable the Add a document from the Supporting Document Library option.
4. In the SupportingDocumentsLibrary list, select the document.
5. Click Finish to create the external link.
6. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.
7. Repeat steps 2 to 5 for each document that you want to aach.

Creating External Links by Copying Existing Ones
You can reuse an external link you have created for a registry object by copying it to
other objects. For all copies, the same ExternalLink object in the registry is used.
To copy an external link
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object whose external link you
want to copy in a CentraSite view to open the editor. The object's external links are
displayed on the External Links tab.
2. On the External Links tab, select the external link you want to copy.
3. Select Copy to Add to Registry Object from the link's context menu.
When you now use the Add External Link option to create external links for one or
more registry objects (see previous section), the URL of the external link you copied is
displayed by default in the Add External Link dialog. You can accept it and thus copy
the external link to the selected object(s), or specify a diﬀerent URL and thus create new
external links.

Modifying External Links
Modifying an External Links of a Assets and Registry Objects means changing the URL
the link points to.
Use the following steps only for modifying external links that are not represented by
Aributes in one of the custom proﬁles in the CentraSite Details editor. For working on
aributes, use the mechanisms for Updating Registry Objects.
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To modify an external link
1. Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click the registry object whose external
link you want to modify in a CentraSite view to open the editor. The object's external
links are displayed on the External Links.
2. On the External Links tab, select the external link whose URL you want to change.
3. Click

in the toolbar, or select Edit URL from the link's context menu.

4. Change the URL as required in the dialog displayed.
5. Click OK to apply the changes.
6. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Displaying the Targets of External Links
The targets of External Links are Supporting Documents and Resources (e.g. folders
and ﬁles) that can be accessed by the speciﬁed URL. From the External Links in the
“Details Editor” on page 130, you can open your default Web browser or an editor of
the Eclipse Workbench with the URL of an external link and display the corresponding
contents.
To display the target of an external link
1. Depending on the Changing Preference Seings you have deﬁned for the CentraSite
Details editor, single-click or double-click the registry object for which to display the
targets of external links in a CentraSite view to open the editor. The object's external
links are shown on the External Links.
2. On the External Links tab, select the external link whose target you want to display.
3. Select Open in Browser from a link's context menu to display the target in your
default Web browser. Select Show Document from a link's context menu to display
the target in an editor of the Eclipse Workbench.

Removing External Links
You can at any time remove External Links you have created for Assets and Registry
Objects, Supporting Documents and Resources.
Use the following steps for removing an external link only for external links that are not
represented by Aributes in one of the custom proﬁles in the CentraSite Details editor.
For working on aributes, use the mechanisms for Updating Registry Objects.
To remove an external link
1. Depending on the Changing Preference Seings you have deﬁned for the “Details
Editor” on page 130, single-click or double-click the registry object from which
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you want to remove external links in a CentraSite view to open the editor. The
existing external links are displayed on the External Links.
2. On the External Links tab, select one or more external links you want to remove.
3. Click

in the tab's toolbar, or select Remove External Links from the context menu.

4. Conﬁrm the removal in the dialog displayed.
5. Save the changed deﬁnition, for example, by selecting File > Save from the main
menu or by typing Ctrl+S.

Exporting Data from Centrasite
CentraSite enables you to export data from the Registry and Repository to the ﬁle system
of your computer. You can use the exported data, for example, to Importing Data into
CentraSite them to the same or a diﬀerent CentraSite registry and repository at a later
stage.
You can invoke an export for one or more Assets and Registry Objects. Depending on
the object's type, diﬀerent data are exported from the registry and/or repository (see the
table below). The data you export are collected in a ZIP archive which is stored in the ﬁle
system location you specify.
The following data are exported depending on the selected registry objects:
Object

Exported Data

Object of any
type

Exports the XML representation of the registry object and all
objects related to it, including the object's type deﬁnition, events,
external links, outgoing associations and classiﬁcations. Repository
folders and ﬁles related to the object and addressed by external
links are also included.

Organization

Exports the XML representation of the organization and all its
child organizations. The export does not include the parent
organization and the reference to it. If the exported data is to be
imported later, the parent organization and the reference to it must
be created after the import operation.

Service

Exports the XML representation of the service, the service bindings
and the speciﬁcation links. Any ﬁle related to the service, e.g. a
WSDL ﬁle, is automatically included in the export operation.

Object type
(category)

Exports the schema ﬁle (XSD) and icon ﬁle of the object type
from the repository as well as the XML representation of the
corresponding external links from the registry. You can optionally
include all registry objects of the type.
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Object

Exported Data

Taxonomy

Exports the XML representation of the taxonomy and all its
categories. You can optionally include all registry objects that are
classiﬁed by the taxonomy and/or its categories.

Category

Exports the XML representation of the category and all its
subcategories. You can optionally include all registry objects that
are classiﬁed by the category and its subcategories.

Note:

The organization to which a registry object belongs and the user who is the
owner of the object are not exported. The Owner property is set to unknown.
When you import an object, the importing user becomes the owner of the
imported object and the imported object is assigned to the organization to
which the importing user belongs.

To export objects from CentraSite
1. In a Views, select the registry objects you want to export.
2. Select Export from the context menu.
3. In the dialog displayed, specify the export options.
Option

Description

Include instances
for selected
categories or types

Includes instances of the selected type.

Delete after export

Deletes the selected object after export. However, you
cannot delete an object if additional references to it exist in
the registry.

Minimize audit trail

Minimizes the number of auditable events that can be
exported. If only one auditable event of the speciﬁc
type exists, then only this auditable event is exported. If
two or more auditable events of the type exist, then the
chronologically ﬁrst and last auditable events are exported.

4. Click OK to start the export.
5. In the dialog displayed, specify the location in the ﬁle system to which you want to
export the data and a name for the ZIP archive.
6. Click Save to create the ZIP archive at the speciﬁed location.
The data are collected in the ZIP archive and exported. A log of the export operation is
displayed in the Contents View:
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The log provides the following information:
For each ﬁle generated and added to the archive, one line is displayed in the view.
The Status column shows if the processing was successful (OK), or whether errors or
warnings occurred. A corresponding message is displayed in the Message column.
On top of the table, the number of successful steps, warnings and errors is displayed.

Importing Data into CentraSite
CentraSite enables you to import data to the Registry and Repository. Data to be
imported can be of diﬀerent types and from diﬀerent sources:
Importing Data from an Archive you created with the CentraSite Exporting Data
from Centrasite function.
Importing XML Schemas from a Web server or ﬁle system.
Importing Data from an Archive from a Web server or ﬁle system.
Importing Data from an Archive created in Eclipse from a ﬁle system.
Importing Data from an Archive from a ﬁle system.
Importing Data from an Archive from an XPDL ﬁle.
Details about each of these import options are provided in the corresponding help
topics. For all import options, the following rules apply:
If the object to be imported does not exist in the target registry, it is created by the
import operation.
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The user who performs the import operation becomes the owner of all imported
registry objects that are added to the registry. Ownership of existing objects that are
replaced by the import operation remains unchanged.
Any imported registry object that is added to the registry is aﬃliated to the
organization to which the user belongs who performs the import operation. For
existing objects that are replaced by the import operation, the aﬃliated organization
remains unchanged.
Any permission that is deﬁned for a registry object that is overwrien by an import
operation remains unchanged.
To import data into CentraSite
1. Select File > Import from the main menu.
2. On the Select page of the Import wizard, select the type of data you want to import
and click Next.
3. On the next page of the Import wizard, specify the parameters for importing the
selected type of data (see the corresponding help topics).
4. Click Finish to start the import.
A log is created for the import operation and displayed in the Contents View:

The log provides the following information:
For each processing step, one line is displayed in the view.
The Status column shows if the processing was successful (OK), or whether errors or
warnings occurred. A corresponding message is displayed in the Message column.
On top of the table, the number of successful steps, warnings and errors is displayed.
Details on importing data into CentraSite are provided in the following sections.

Importing Data from an Archive
You can import the data contained in a ZIP archive you created with the
CentraSite Exporting Data from Centrasite function into the same or a diﬀerent
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CentraSite Registry and Repository. The registry and repository from which you export
the data and the registry and repository to which you import the data can have diﬀerent
CentraSite versions.
Depending on the data in the archive, the import may be successful only if speciﬁc
objects already exist in the registry. The following rules apply:
When you import registry objects that have references to User objects, the users must
already be deﬁned in the target registry. For example, you can ﬁrst import the User
objects into the target registry from an archive. If required User objects do not exist,
the corresponding references of imported objects will be changed to the predeﬁned
'unknown' user during the import operation.
Registry objects to be imported must not have unresolved references to other objects.
All referenced objects (including taxonomies and categories) must already exist in
the target registry or be included in the archive you are importing.
Registry objects that exist in both the export set and in the target registry must be
identical. If this is not the case, the registry object in the archive and all the objects
related to it are ignored by the import.
Repository folders and ﬁles that exist in both the export set and in the target
repository must be identical. If this is not the case, the folders and ﬁles in the archive
and all registry objects related to them are ignored by the import.
Note that all objects in an archive are imported. If the import operation fails to
successfully import one of the objects contained in the archive, the entire import
operation is rolled back.
To import an archive
1. On the Select page of the Import wizard, select Archive in the CentraSite folder and
click Next to deﬁne the import parameters.
2. On the Import Archive page of the Import wizard, specify the following parameters:
File: The path and name of the archive you want to import. Use the Browse
buon to select the ﬁle in the ﬁle system of your computer.
Check Allow replace of registry objects, if existing registry objects are to be
overwrien automatically by the objects being imported. If you do not check
this option, the existing objects are only overwrien if they are older than the
imported objects.

Importing XML Schemas
You can import an XML schema from a Web server or a ﬁle system to a
CentraSite Registry and Repository.
The following Supporting Documents and Resources and Assets and Registry Objects
are created by the import of an XML schema:
The schema ﬁle is copied to a subfolder of projects/WSDL in the repository. The
name of the subfolder is determined by the namespace deﬁned in the schema.
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For example, if the namespace is hp://www.MyOrganization.com/MySchemas/
schema1, the schema is copied to projects/WSDL/www.MyOrganization.com/
MySchemas/schema1.
If the schema ﬁle contains references to other schema ﬁles, these are also imported,
including all the schema ﬁles that are referenced.
For each imported schema ﬁle, a registry object of the XML Schema type is created.
An external link is created for the object which points to the schema ﬁle in the
repository.
Note:

When you delete an External Links in the registry that points to a schema
ﬁle in the repository, the schema ﬁle in the repository is also deleted.
However, any schema entries in the registry and repository that are
referenced by the schema being deleted remain untouched.

If the importer detects an equivalent schema ﬁle within CentraSite during the import
of a schema, the import dialog will prompt you to specify either Overwrite latest
version or Create new version. If you decide to create a new version, the importing
schema will be applied to the new version.
You can also choose the option Interactive resolution of Import/Includes, which will
allow you to specify how an already existing imported/included ﬁle is handled. For
each of the imported/included ﬁles you have one of these options:
Overwrite the importing ﬁle with new content.
Create a new version of the ﬁle with the new content (if, for example, you want
to modify a schema but want to retain its previous version).
Reuse any version of the ﬁle (if, for example, an intermediate version of a schema
is currently referenced by a WSDL, you can redirect it to the newest version).
To import an XML schema
1. On the Select page of the Import wizard, select Schema in the CentraSite folder and
click Next to deﬁne the import parameters.
2. On the Import Schema page of the Import wizard, specify the following parameters:
Select the organization to which the XML schema is to be assigned.
Specify a version identiﬁer for the new service. The version identiﬁer you enter
here is the service's public, user-assigned version identiﬁer. You can enter any
string in the Initial version ﬁeld, i.e. the version identiﬁer does not need to be
numeric. You can also leave this ﬁeld blank.
If you want to import the schema from a Web server, choose the Import from
Web server option and specify the schema's URL in the URL ﬁeld.
If you want to import the schema from the ﬁle system of your computer, choose
the Import from ﬁle system option and specify the schema's path and name in
the File ﬁeld. Use the Browse buon to select the ﬁle in the ﬁle system of your
computer.
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If you have speciﬁed a URL, and the site you want to access via the URL requires
user authentication, enable the URL Authentication check box. This opens a subdialog in which you can enter a username and password for authentication at the
URL site.
Check Interactive resolution of Import/Includes to determine how referenced
schemas are handled when the schema that is referenced already exists in the
registry. When this option is enabled, you will be prompted during import to
specify whether you want to reuse any schema ﬁles referenced in the main ﬁle or
upload new ﬁles.
Click OK.
What Happens When You Import a New Schema File?
CentraSite retrieves the speciﬁed ﬁle and creates the XML schema. If you have
speciﬁed Interactive resolution of Import/Includes, you will also be prompted
to specify whether you wish to reuse any of the schema ﬁles that might be
referenced in the main schema ﬁle via IMPORT or INCLUDE statements or
upload new ﬁles.
What Happens When You Import an Existing Schema File?
If the importer detects that the schema you are trying to import already exists
within CentraSite, the import dialog will prompt you to specify whether you
want to Overwrite latest version or Create new version. If you have speciﬁed
Interactive resolution of Import/Includes, you will also be prompted to specify
whether you wish to reuse any of the schema ﬁles that might be referenced in the
main schema ﬁle via IMPORT or INCLUDE statements or upload new ﬁles.

Importing Web Services
You can import one or more Web services from a Web server or a ﬁle system to a
CentraSite Registry and Repository. For the import, you specify a WSDL ﬁle, which may
deﬁne one or more Web services.
The following Assets and Registry Objects and Supporting Documents and Resources
are created by the import of Web services:
In the registry, objects are created for diﬀerent elements deﬁned in the WSDL
ﬁle being imported: An object of the Service type is created for each service
element deﬁned in the WSDL ﬁle, the corresponding name aribute in the WSDL
ﬁle determines the registry object's name. The Service objects are assigned to
the organization which you specify in the import parameters. A corresponding
Organization object is created, if required.
Depending on the WSDL ﬁle, additional objects of the following types may be
created: ServiceBinding objects for service bindings, SpeciﬁcationLink objects
for speciﬁcation links, Concept objects for bindings, Operation objects for
operations, Interface objects for interfaces, BPELPartnerLinkType objects for
partnerLinkType elements in the WSDL ﬁle, BPELRole objects for role elements
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within partnerLinkType elements. The new objects are connected by associations
and implicit references as required.
For each imported Web service, an External Links is created which points to the
WSDL ﬁle in the repository.
The WSDL ﬁle is copied to a subfolder of projects/WSDL in the repository.
The name of the subfolder is determined by the namespace deﬁned in the
targetNamespace aribute of the WSDL's deﬁnition element. For example, if the
namespace is hp://www.MyOrganization.com/products, the WSDL ﬁle is copied to
projects/WSDL/www.MyOrganization.com/products.
The name of the WSDL ﬁle in the repository is built as follows:
organization_service_ﬁle.wsdl, where organization is the organization name you
specify in the import parameters, service is the name of the service as speciﬁed
in the WSDL, and ﬁle is the ﬁle name or ﬁnal part of the URL speciﬁed in the
import parameters. For example, when you import a Web service from C:\services
\MyService.wsdl, the service name in the WSDL ﬁle is queryService, and the
speciﬁed organization is MyOrg, the resulting ﬁle name in the repository is
MyOrg_queryService_MyService.wsdl.
If the WSDL ﬁle contains references to schema ﬁles, these are also imported,
including all the schema ﬁles that are referenced. The folders and ﬁles and registry
objects that are created correspond to Importing XML Schemas.
If the importer detects an equivalent service within CentraSite during the import of
a Web service, the import dialog will prompt you to specify either Overwrite latest
version or Create new version. If you decide to create a new version, the importing
WSDL will be applied to the new version.
You can also choose the option Interactive resolution of Import/Includes, which will
allow you to specify how an already existing imported/included ﬁle (further WSDL
or schema) is handled. For each of the imported/included ﬁles you have one of these
options:
Overwrite the importing ﬁle (WSDL or schema) with new content.
Create a new version of the ﬁle with the new content (if, for example, you want
to modify a schema but want to retain its previous version).
Reuse any version of the ﬁle (if, for example, an intermediate version of a schema
is currently referenced by a WSDL, you can redirect it to the newest version).
Note:

When you delete a service in CentraSite whose WSDL ﬁle references one or
more schemas, you can choose to delete the schema ﬁles.

You can update Web services in CentraSite by importing an updated WSDL ﬁle. The
WSDL ﬁle must have the same namespace, service names, and organization as the
original WSDL ﬁle. The WSDL ﬁle may include additional Web services. However, it is
not possible to remove a service from CentraSite via an updated WSDL ﬁle which no
longer includes the corresponding service element.
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To import Web services
1. On the Select page of the Import wizard, select Web Service in the CentraSite folder.
2. On the Import Web Service page of the Import wizard, specify the following
parameters:
Select the organization to which the Web services are to be assigned.
Specify a version identiﬁer for the new service. The version identiﬁer you enter
here is the service's public, user-assigned version identiﬁer. You can enter any
string in the Initial version ﬁeld, i.e. the version identiﬁer does not need to be
numeric. You can also leave this ﬁeld blank.
If you want to import Web services from a Web server, choose the Import from
Web server option and specify the URL of the WSDL ﬁle in the URL ﬁeld.
If you want to import Web services from the ﬁle system of your computer, choose
the Import from ﬁle system option and specify the path and name of the WSDL
ﬁle in the File ﬁeld. Use the Browse buon to select the ﬁle in the ﬁle system of
your computer.
If you have speciﬁed a URL, and the site you want to access via the URL requires
user authentication, enable the URL Authentication check box. This opens a subdialog in which you can enter a username and password for authentication at the
URL site.
Check Interactive resolution of Import/Includes to determine how referenced
schemas are handled when the schema that is referenced already exists in the
registry. When this option is enabled, you will be prompted during import to
specify whether you want to reuse any schema ﬁles referenced in the main ﬁle or
upload new ﬁles.
Click OK.
What Happens When You Import a New WSDL File?
CentraSite retrieves the speciﬁed ﬁle and creates the Web service. If you have
speciﬁed Interactive resolution of Import/Includes, you will be prompted to
specify whether you wish to reuse any of the WSDL/schema ﬁles referenced in
the main WSDL ﬁle or upload new ﬁles.
What Happens When You Import an Existing WSDL File?
If the importer detects that the service you are trying to import already exists
within CentraSite, the import dialog will prompt you to specify whether you
want to Overwrite latest version or Create new version. If you have speciﬁed
Interactive resolution of Import/Includes, you will be prompted to specify
whether you wish to reuse any of the WSDL/schema ﬁles referenced in the main
WSDL ﬁle via IMPORT or INCLUDE statements or upload new ﬁles.
Be aware that the import fails if you specify a WSDL ﬁle containing a namespace and
services that already exist in CentraSite but are aﬃliated to a diﬀerent organization.
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Importing Reports
You can import reports you have Working with Reports in Eclipse from the ﬁle system
to a CentraSite Registry and Repository. Importing a report is equivalent to “Deploying
Reports in CentraSite ” on page 112.
The following Supporting Documents and Resources and Assets and Registry Objects
are created when importing a report:
The report design ﬁle (.rptdesign) is copied to the projects/CentraSite/Reports folder
of the repository.
A registry object of the Report type is created in the CentraSite registry.
An External Links is created between the new registry object and the ﬁle in the
repository.
To import a report
1. On the Select page of the Import wizard, select Report in the CentraSite folder and
click Next to deﬁne the import parameters.
2. On the Import Report page of the Import wizard, specify a name for the design
ﬁle to be imported. You can also enter a description for it. Use the Browse buon
to select the ﬁle in the ﬁle system of your computer. Check the Overwrite existing
imported template ﬁle option, if an existing design ﬁle with the speciﬁed name is
to be overwrien automatically by the import operation. If you do not check this
option, the existing design ﬁle is only overwrien if it is older than the imported ﬁle.

Importing BPEL Process Definitions
You can import BPEL process deﬁnitions from a ﬁle system into a CentraSite Registry
and Repository. For the import, you specify a BPEL ﬁle which may deﬁne one or more
processes.
The following Assets and Registry Objects and Supporting Documents and Resources
are created by the import of BPEL process deﬁnitions:
In the registry, objects are created for diﬀerent elements deﬁned in the BPEL ﬁle
being imported:
An object of the BPELProcess type is created for each process element deﬁned in the
BPEL ﬁle, the corresponding name aribute in the BPEL ﬁle determines the registry
object's name. An object of the BPELPartner type is created for each BPEL partner
in a process, and a BPELPartnerLink object is created for each BPEL partner link of
a process. The new objects are connected by associations and implicit references as
required.
If partner links are imported, the import checks whether the registry contains
an object of the BPELPartnerLinkType type whose name is identical with the
value of the name aribute of the partnerlink element in the BPEL ﬁle. If this
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is the case, the import creates references between the BPELPartnerLink and
BPELPartnerLinkType objects in the registry. Otherwise, a warning is issued that
the required BPELPartnerLinkType does not exist in the registry. You can create
BPELPartnerLinkType as well as BPELRole objects in the registry by Importing Web
Services.
The BPEL ﬁle is copied to a subfolder of projects/BPEL in the repository. The name
of the subfolder is determined by the target namespace speciﬁed in the BPEL ﬁle. For
example, if the namespace is hp://www.MyOrganization.com/processes, the BPEL
ﬁle is copied to projects/BPEL/www.MyOrganization.com/processes.
For each imported process, an External Links is created which points to the BPEL ﬁle
in the repository.
You can update BPEL process deﬁnitions in CentraSite by importing an updated BPEL
ﬁle. The BPEL must have the same namespace and process names as the original BPEL
ﬁle. The BPEL ﬁle may include additional process deﬁnitions. However, it is not possible
to remove a process deﬁnition from CentraSite via an updated BPEL ﬁle which no longer
includes the corresponding process element.
To import BPEL process definitions
1. On the Select page of the Import wizard, select BPEL in the CentraSite folder and
click Next to deﬁne the import parameters.
2. On the Import BPEL page of the Import wizard, specify the following parameters:
Select the organization to which the BPEL process deﬁnitions are to be assigned.
Specify a version identiﬁer for the new service. The version identiﬁer you enter
here is the service's public, user-assigned version identiﬁer. You can enter any
string in the Initial Version ﬁeld, i.e. the version identiﬁer does not need to be
numeric. You can also leave this ﬁeld blank.
In the File ﬁeld, specify the path and name of the BPEL ﬁle. Use the Browse
buon to select the ﬁle in the ﬁle system of your computer.
In the Product ﬁeld, you can specify the name of a category of the Products
taxonomy by which the process deﬁnitions are to be classiﬁed in CentraSite. Use
the Browse buon to select the category in a Select Object Dialog.

Importing XPDL Process Definitions
The XML Process Deﬁnition Language (XPDL) is a standard language that is used to
represent workﬂows and business processes. It is generally used to exchange process
deﬁnitions between diﬀerent business processing systems. CentraSite provides an
importer for XPDL ﬁles. This importer reads an XPDL 2.x ﬁle and adds the process that
it deﬁnes to the registry as a Process object. It stores the XPDL ﬁle itself in CentraSite's
repository.
Note:

If you are using ARIS Business Architect to create process deﬁnitions to
share with webMethods BPMS, do not use this procedure to add them to the
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registry. Use the publishing tools provided with ARIS Business Architect
instead. Using the ARIS Business Architect ensures that the appropriate
metadata is included in the Process object.
The following Assets and Registry Objects and Supporting Documents and Resources
are created by the import of an XPDL ﬁle:
A Process object is created for each WorkﬂowProcess element deﬁned in the XPDL
ﬁle.
The Name aribute for this element determines the name of the Process object.
The Id aribute for this element is assigned to an aribute called UniqueID in the
Process object.
A Process Step object is created for each Activity element deﬁned in the XPDL ﬁle.
Associations are generated to represent the transitions between Process Step objects.
A Process Pool object is created for each Pool element deﬁned in the XPDL ﬁle and a
Process Swim Lane object is created for each Lane element deﬁned in the XPDL ﬁle.
The XPDL ﬁle is added to the CentraSite repository. The Process object will include
an aribute called ProcessDefinitionURL, which will contain a link to this ﬁle.
If the XPDL ﬁle references a WSDL document, the importer will prompt you to
provide the speciﬁed WSDL ﬁle. When you provide the ﬁle, the importer will check
whether the service described in the WSDL already exists in the registry. If it does,
the importer will associate the Process object with that service. If it does not, the
importer will import the WSDL ﬁle, add the service to the registry, and associate the
service with the Process object.
If the process in the XPDL ﬁle has a workﬂow Id that matches the UniqueID aribute of a
Process object that already exists in the registry, the importer will handle the import in
the following way:
If the Process object in the registry is not associated with a lifecycle model or if it is
in the initial state of its lifecycle, the importer will replace the Process object in the
registry with the process from the XPDL ﬁle. (If you do not have Modify permission
on the Process object in the registry, the import of the XPDL ﬁle will fail.)
If the Process object is in any state other than the initial state of its lifecycle, the XPDL
ﬁle will be imported as a new version of the Process object.
To import an XPDL file
1. On the Select page of the Import wizard, select XPDL in the CentraSite folder and
click Next.
2. On the Import File page of the Import wizard, do the following:
Select the organization to which the Process object (and its components) are to be
added.
In the File ﬁeld, specify the path and name of the XPDL ﬁle. Use the Browse
buon to select the ﬁle from the ﬁle system of your computer.
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Optional. In the Product ﬁeld, specify the product with which the process is
associated.
Optional. In the Initial Version ﬁeld, specify a version identiﬁer for the new
Process object. The identiﬁer you enter here is the Process object's public,
user-assigned version identiﬁer. You can enter any string in this ﬁeld ( i.e., the
identiﬁer does not have to be numeric). You can leave this ﬁeld blank.

Working with Reports
This section describes the reporting features provided by the CentraSite Eclipse GUI.

Overview of the Reporting Features
The CentraSite Eclipse GUI oﬀers sophisticated features and options for designing,
creating and previewing reports on the CentraSite registry and its contents.
The CentraSite Eclipse GUI does not provide a reporting interface of its own. Instead,
it provides drivers, features and functions that are integrated with the Business
Intelligence and Reporting Tools (BIRT) provided by the Eclipse Foundation.
“Predeﬁned Reports” on page 106
“Custom Reports” on page 106

Predefined Reports
A set of predeﬁned reports is installed with CentraSite. The predeﬁned reports are
linked to speciﬁc object types. They can be linked to additional object types, as required,
and can be previewed from the CentraSite Eclipse GUI.
Here are some examples of the predeﬁned reports in CentraSite:
Asset Change History: For a selected asset, list all changes.
Asset Changes Since Date: For this organization, lists the changes since the selected
date.
Asset Dependencies: For an asset, lists the incoming and outgoing relationships.
New Assets Since Date: For this organization, lists all assets created since the
selected date.

Custom Reports
You can create additional custom reports using the BIRT report designer, which is
integrated in Eclipse. Details on BIRT and on how to use the tools are described in the
BIRT documentation.
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The CentraSite Eclipse GUI integrates the following functionality into the BIRT report
designer:
Dialogs and functions for deﬁning data sources that connect your reports to a
CentraSite registry.
Dialogs and functions for building data sets that specify the data to retrieve from the
registry.
Customized BIRT reports can be deployed to CentraSite, linked to object types, and
previewed from the CentraSite Eclipse GUI. But if a BIRT report contains subreports,
then the report cannot be deployed to CentraSite. Any report that has been deployed
to CentraSite can be copied from the CentraSite repository to your Eclipse workspace
where you can update it with the BIRT report designer, if required.

Building Reports with BIRT
When creating reports with BIRT, you usually take the following basic steps:
1. Create a project of type Report.
2. Create a report.
3. Deﬁne a data source.
4. Build a data set.
5. Lay out the report.
6. Sort the data.
7. Format the report.
8. Create a report title.
For details, refer to the BIRT documentation.
The following help topics describe how you can deﬁne data sources and build data sets
for accessing a CentraSite registry.

Defining Data Sources
Data sources connect reports to a database or other physical source of data. When
you deﬁne a data source, you specify the data source name and other connection
information.
In BIRT, you can deﬁne two types of data source that connect to a CentraSite registry:
CentraSite: This type of data source is used to access a CentraSite registry using the
search and ﬁnd functionality of the CentraSite Eclipse GUI.
CentraSite XQuery: This type of data source is used to retrieve data from a
CentraSite registry using XQuery, the XML query language.
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JDBC: This type of data source is used to access relational databases.
The following sections describe how to deﬁne data sources of each of these types.
“Deﬁning a CentraSite Data Source” on page 108
“Deﬁning a XQuery Data Source” on page 108
“Deﬁning a JDBC Data Source” on page 108

Defining a CentraSite Data Source
To define a data source of type CentraSite
1. In the BIRT Data Explorer view, select the Data Sources entry.
2. Choose New Data Source from the context menu.
3. In the New Data Source wizard, specify the following information:
a. Select CentraSite Data Source from the list of data source types.
b. In Data Source Name, type a name for the CentraSite data source.
4. Click Finish to create the CentraSite data source with the speciﬁed name.

Defining a XQuery Data Source
To define a data source of type CentraSite XQuery
1. In the BIRT Data Explorer view, select the Data Sources entry.
2. Choose New Data Source from the context menu.
3. In the New Data Source wizard, specify the following information:
a. Select CentraSite XQuery Data Source from the list of data source types.
b. In Data Source Name, type a name for the CentraSite XQuery data source.
4. Click Finish to create the data source with the speciﬁed name.

Defining a JDBC Data Source
To define a data source of type JDBC
1. In the BIRT Data Explorer view, select the Data Sources entry.
2. Choose New Data Source from the context menu.
3. In the New Data Source wizard, specify the following information:
a. Select JDBC Data Source from the list of data source types.
b. In Data Source Name, type a name for the JDBC data source.
4. Click Manage Drivers..., and then the Add... buon.
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5. In the Open dialog box, navigate to the following folder:
<Software AG_directory>/Designer/eclipse/plugins
6. Select the ﬁle com.centrasite.ext.dd.cjdbc_*.jar, and click Open.
The wildcard symbol (*) is a placeholder to represent the version number of the
driver library. Make sure that you select the latest version of the driver library.
7. In Driver Class, type the corresponding driver of the relational database you want to
access:
DB2: com.softwareag.common.jdbc.driver.DB2ProxyDriver
Microsoft SQL Server:

com.softwareag.common.jdbc.driver.MSSQLProxyDriver

Oracle: com.softwareag.common.jdbc.driver.OracleProxyDriver
Sybase: com.softwareag.common.jdbc.driver.SybaseProxyDriver
8. In Database URL, type the URL for the database, using the format that the driver
requires.
DB2: jdbc:wm:db2://

<server_name>:<port>;databasename=<database_name>

Microsoft SQL Server: jdbc:wm:sqlserver://

<server_name>:<port>;databasename=<database_name>

Oracle: jdbc:wm:oracle://<server_name>:<port>;sid=<database_name>
Sybase: jdbc:wm:sybase://<server_name>:<port>
Wherein, the substitution tokens <server_name>, <port>, and <database_name>
are placeholders that should be replaced by real values.
9. In User Name, type a valid user name to connect to the JDBC data source.
10. In Password, type a valid password to connect to the JDBC data source.
11. Click Finish to create the data source with the speciﬁed name.

Building a Data Set with a Data Source
A data set, or query, speciﬁes the data to be retrieved from a speciﬁc data source. The
data of a data set can then be used in any number of reports.
In a data set that uses a data source of type CentraSite, the data are retrieved from the
CentraSite registry via the search and ﬁnd functionality of the CentraSite Eclipse GUI.
To build a data set that uses a data source of type CentraSite
1. In the BIRT Data Explorer view, select the Data Sets entry.
2. Select New Data Set from the context menu.
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3. In the New Data Set wizard, specify:
A name of your choice for the data set.
The data source of type CentraSite that is to be used to connect to the CentraSite
registry.
The data set type. You can only select Business Query for data sets using a
CentraSite data source.
4. Click Next.
5. On the Deﬁne Query Page, specify the data to be retrieved from the registry and to
be included in the data set.
You can use the % character as a wildcard in the Name ﬁeld, to retrieve objects that
match the given name paern.
6. Click Finish to create the data set with the speciﬁed name and data.

Building a Data Set with a XQuery Data Source
A data set, or query, speciﬁes the data to be retrieved from a speciﬁc data source. The
data of a data set can then be used in any number of reports.
In a data set that uses a data source of type CentraSite XQuery, the data are retrieved
from the CentraSite registry by a query in XQuery syntax and format. For details on
XQuery in CentraSite, contact your CentraSite support organization.
To build a data set that uses a data source of type CentraSite XQuery
1. In the BIRT Data Explorer view, select the Data Sets entry.
2. Select New Data Set from the context menu.
3. In the New Data Set wizard, specify:
A name of your choice for the data set.
The data source of type CentraSite XQuery that is to be used to connect to the
CentraSite registry.
The data set type. You can only select CentraSite XQuery for data sets using a
CentraSite XQuery data source.
4. Click Next.
5. On the Specify XQuery Page, enter the query that speciﬁes the data to be retrieved
from the registry and to be included in the data set.
Example: The following query retrieves all registry objects of type Organization from
the registry:
declare namespace
cs="http://namespaces.CentraSite.com/Schema/jaxr"; for $ro in
collection("CentraSite")/cs:organization return $ro
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6. Click Next. The Deﬁne Table Mapping Page is displayed, showing the schema
information for the elements that match the query in the XML Structure ﬁeld.
7. On the Deﬁne Table Mapping page, select the element of the XML structure that
is to be mapped to a table which is usable by BIRT, click the > buon and specify
the XPath expression for addressing the selected element in the registry. The XPath
expression is entered in the XPath expression ﬁeld of the Deﬁne Table Mapping
page.
Note:

To display the name or description of an element, select the corresponding
localString entry in the XML structure instead of the name or description
entry. The reason is that the values of these elements are available as
localized strings but not in a locale-independent way.

8. Click Next.
9. On the Deﬁne Column Mapping Page, specify the elements of the XML structure
that are to be mapped to table columns which are usable by BIRT. You can specify a
mapping in one of the following ways:
Click an element in the XML Structure ﬁeld, then click the > buon, and specify
the column name, XPath expression and data type in the dialog displayed.
Click the <new mapping here> entry in the Column Mapping table, and type the
column name, XPath expression and data type directly in the table.
10. Click Finish to create the data set with the speciﬁed name and data.

Working with Data Sources and Data Sets
For working with the data sources and data sets you have created for CentraSite or
relational databases, you use the standard functions of BIRT. For details, refer to the
BIRT documentation.
The following BIRT dialogs include pages speciﬁc to CentraSite or relational databases
(SQL):
Edit Data Source dialog for data sources of type CentraSite: On the Registry Page,
you can change the object/table mapping between CentraSite and BIRT.
Edit Data Set dialog for data sets using a data source of type CentraSite: On the
Deﬁne Query Page, you can modify the search criteria.
Edit Data Set dialog for data sets using a data source of type CentraSite XQuery: On
the Specify XQuery Page, you can modify the query. On the Deﬁne Table Mapping
Page and Deﬁne Column Mapping Page pages, you can change the table and column
mappings.
For more information on the XQuery functions and modules, see CentraSite
Developer’s Guide.
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Deploying Reports in CentraSite
Reports you have created in BIRT can be made available and executable in CentraSite.
Deploying a report in CentraSite means:
Uploading the report design ﬁle (.rptdesign) from Eclipse to the projects/CentraSite/
Reports folder of the CentraSite repository.
Creating an object of type Report in the CentraSite registry.
Creating an external link between the new registry object and the repository ﬁle.
Deploying a report is equivalent to Importing Reports. Reports in CentraSite can be
linked to object types and previewed from the CentraSite Eclipse GUI.
Note:

A BIRT report that contains subreports cannot be deployed to CentraSite.

To deploy a report in CentraSite
1. Select the report you want to make available and executable in CentraSite, for
example, in the Eclipse Navigator view.
2. Select Deploy Report to CentraSite in the context menu.
3. On the Import Report page of the Import wizard, specify a name for the design
ﬁle to be imported. You can also enter a description for it. Use the Browse buon
to select the ﬁle in the ﬁle system of your computer. Check the Overwrite existing
imported template ﬁle option if an existing design ﬁle with the speciﬁed name is to
be overwrien by the import operation.
Related Topics
on page 112“Linking Reports to Object Types”

Linking Reports to Object Types
Predeﬁned reports and custom reports that you have deployed or imported to
CentraSite can be linked to object types in the registry. A report linked to an object type
can be previewed from any object of this type in the CentraSite Eclipse GUI.
To view the predeﬁned and custom reports that are available in CentraSite:
In the Administration View, single-click or double-click the Report Templates entry,
depending on the selection mode you have set for the view. This displays the reports
that are currently available in the Contents View.
To link reports to an object type
1. In a Views, select the object type to which you want to link one or more reports.
2. Select Link Reports from the type's context menu.
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3. In the Select Object Dialog dialog, select the reports you want to link to the object
type.
4. Click OK to conﬁrm the selection.
Technically, a report assignment to an object type is an association of the Uses type
between the registry object representing the report and the registry object representing
the object type. You can unlink a report from an object type by Removing Associations
Between Objects the corresponding association.

Saving Reports to the Eclipse Workspace
You can copy any template ﬁle for a report stored in the CentraSite repository to your
Eclipse workspace, where you can modify it using the BIRT report designer:
1. In the Administration View, single-click or double-click the Report Templates
entry, depending on the selection mode you have set for the view. This displays the
predeﬁned and custom reports that are currently deﬁned in the Contents View.
2. In the Contents view, select the report to be saved to the Eclipse workspace.
3. Select Save to Workspace from the report's context menu.
4. In the Save Resource dialog, specify or select the location and name for the ﬁle in
your workspace.
5. Click Finish to copy the ﬁle from the repository to your workspace.
After modifying the report in Eclipse using the BIRT report designer, you can either
use the instructions in “Deploying Reports in CentraSite ” on page 112 or Importing
Reports to make it available and executable again.
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Perspectives
CentraSite provides two perspectives that you can use to create, browse and manage the
information in the registry and repository.
The CentraSite Asset Catalog perspective is directed to users who want to view and
manage their organization's assets. The available views support the users in providing
and consuming assets as well as browsing and searching the CentraSite registry. By
default, the perspective includes the following views of the CentraSite Eclipse GUI:
Navigation views:
Asset Types View
My View
List views:
Contents View
Search View
The CentraSite Search and Browse perspective is directed to users who want to browse
and search assets and documents in the CentraSite registry and repository. In addition,
the perspective oﬀers direct access to the supporting objects that are used for managing
and organizing the assets. It provides comprehensive administration functions and
allows the users to create and manage registry federations. By default, the perspective
includes the following views of the CentraSite Eclipse GUI:
Navigation views:
Administration View
Asset Types View
My View
Registry Explorer View
Repository Explorer View
List views:
Contents View
Documents View
Search View
On the right side of each CentraSite perspective, there is an editor area which can
display one or several CentraSite Details editors.
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Views
The CentraSite Eclipse GUI adds the following views to the Eclipse Workbench.

Navigation Views
Navigation views are used to browse the CentraSite registry and repository.

Administration View
The Administration view allows you to access the Assets and Registry Objects that are
used for managing your assets. Depending on the selection mode you have set for the
view, you can single-click or double-click an entry in the view to list the registry objects
of this type in the Contents View.

The view provides access to the following objects:
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Icon

Name

Action

Taxonomies

Lists all taxonomies that are deﬁned for your
CentraSite registry. A Taxonomy object represents a
taxonomy which contains Classiﬁcations of Registry
Objects or categorizing registry objects. The object type
of taxonomy objects is ClassiﬁcationScheme. For each
Taxonomy object, a tree structure is displayed in the
Contents view if it contains categories for classifying
and categorizing registry objects.

Report
Templates

Lists all predeﬁned and custom reports that are
deﬁned in your CentraSite registry.

Name

Action

Synchronize
Other
Views

Toggles the selection mode in the Administration
view. When this buon is not pressed, double-clicking
an entry in the view displays the corresponding
registry objects in the Contents view. When this buon
is pressed, a single click updates the Contents view.
The Workbench remembers the selection mode you
have set for the Administration view. The next time
you open the view, the selection mode is set as you
have left it.

Toolbar
Icon

Asset Types View
The Asset Types view allows you to access the Assets and Registry Objects stored
in the CentraSite registry. In the view, you decide which types of assets you want to
access. Using the checkboxes in combination with the toolbar buons, you can select the
required asset types and display all assets that exist for these types in the Contents View.
The Asset Types view lists all asset types that are deﬁned for your organization. When
initially installed, it displays the following asset types:
Application servers
BPEL processes
Services
XML schemas
Virtual services

CentraSite Eclipse UI Help Version 10.3

118

M

Odd Header
Reference

Virtual XML services
Virtual REST services
The list can hold additional asset types for artifacts that your organization needs. All
object types you deﬁne yourself are identiﬁed as asset types and added to the list.

Toolbar
Icon

Name

Action

Refresh

Updates the view's contents.

Update
Contents

This buon is only relevant when the
not pressed.

buon is

To display assets of certain types in the Contents
view, select the checkboxes for the required types in
the Asset types view. Then click
or double click a
type entry in the view to update the Contents view.
Synchronize
Other
Views

Toggles the selection mode in the Asset Types view.
When the buon is pressed, you just select a
checkbox for an asset type and the Contents view is
updated immediately.
When the buon is not pressed, you ﬁrst select
the checkboxes for the required asset types. Then
you click
or double click an entry in the view to
update the Contents view.
The Workbench remembers the selection mode you
have set for the Asset Types view. The next time you
start the CentraSite Eclipse GUI, the selection mode
is set as you have left it.
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Impact Analyzer View
The Impact Analyzer view represents Assets and Registry Objects and their Associations
Between Registry Objects with other objects in a graphical way. The graphical
representation is enabled via a Flash-based Web browser.
Important: If you are running the designer on a 64-bit operating system, ensure that you
have installed the Adobe Flash Plugin 64-bit in the 64-bit Web browser.
Use the Customizing Options for the Impact Analyzer in the view's menu bar to
determine exactly what you want to consider in the impact analysis and display in
the view. The options in the menu bar also allow you to size and print the graph as
required. In addition, options are provided for saving and restoring the seings deﬁned
for the view in so-called conﬁgurations. CentraSite delivers predeﬁned conﬁgurations,
and you can deﬁne and save your own custom conﬁgurations. These are user-speciﬁc
and can be restored by the same user on any client, if required.
The Impact Analyzer view is not included in the CentraSite perspectives by default. It
is automatically opened when you start a Impact Analysis for Registry Objects with the
Impact Analyzer.

The graph displays registry objects in rectangular boxes. The registry object for which
the impact analysis has been invoked is highlighted.
You can view details of each registry object represented in the view. To do so, singleclick the object. This displays its owner, its version number and its description.
Associations are shown as arrows pointing in the appropriate direction. The name of the
association type is placed on the arrow. Arrows for associations are grouped, if there is
more than one association of the same type. A number next to the association type name
indicates the total number of associations of this type the object has with other registry
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objects. Click a name to hide or show the related objects. This allows you to make the
impact analysis less complex and focus on individual sections only.
A green line between a registry object and an association type name indicates that all
associations of this type are also deﬁned for the registry object. The line is inserted to
avoid redundancies in the graphical representation. With the line, it is not necessary to
represent the associations twice.

My View
The My CentraSite view allows you to quickly access registry objects, folders and ﬁles
that you use frequently or that you want to keep close at hand.
Using the My Favorites folder, you can access and manage your favorite Assets and
Registry Objects and Supporting Documents and Resources. You can Using Favorites
any registry objects, folders or ﬁles to your favorites list and manage the entries in the
list.
The My Favorites folder also allows you to access the assets for which you are registered
as owner. Using the Assets I Provide entry, you can display the corresponding registry
objects in the Contents View. Besides your own assets, the My Favorites folder also
displays searches and lists you have saved in CentraSite. You can display the elements
contained in a list in the Contents view, and you can delete lists. You can run a saved
search, and you can delete queries that you do not need any more.
In addition to managing your favorites, the My CentraSite view allows you to access
your Notiﬁcations. Using the Notiﬁcations entry, you can display the list of change
notiﬁcations you have received for your notiﬁcation requests in the Contents View.
Using the Subscriptions entry, you can display the list of registry objects for which you
have registered a notiﬁcation request.

Toolbar
Icon

Name

Action

Synchronize
Other
Views

Toggles the selection mode in the My CentraSite
view. When the buon is not pressed, you have
to double-click an entry in the view to display the
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Icon

Name

Action
corresponding registry objects in the Contents view.
When the buon is pressed, a single click updates the
Contents view.
The Workbench remembers the selection mode you
have set for the My CentraSite view. The next time
you open the view, the selection mode is set as you
have left it.

Registry Explorer View
The Registry Explorer view displays registry objects contained in the CentraSite registry.
System administrators can conﬁgure the view's contents, deﬁning which registry objects
are displayed. Diﬀerent view conﬁgurations may be available. The menu in the view's
toolbar allows you to choose the appropriate one to work with.
The default view conﬁguration displays the organizations stored in the CentraSite
registry and the Assets and Registry Objects and users assigned to them. It sorts the
assets and users by organizations. For each organization, a tree structure is predeﬁned
which allows you to browse the assets deﬁned for the organization and to navigate to
all objects that are logically subordinate to it. Services and Users are predeﬁned entry
points to the tree structure. Additional entry points are available if assets are deﬁned for
the organization that are not directly or indirectly related to a service.
You can use the Registry Explorer view to browse the assets in the registry and create,
organize and delete assets. Behind the top entry in the view, the name of the current
CentraSite connection is displayed in square brackets.
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Toolbar
Icon

Name

Action

Home

Displays the object hierarchy from the top level.
For example, after you have chosen Go Into a
number of times, you can use this option to return
to the top level of the hierarchy.

Back

Displays the hierarchy as it was shown
immediately prior to the current display. For
example, after you have chosen Go Into, Back
returns you to the previous view.

Go Into

Changes the display to show only the objects
below the currently selected one.

Collapse All

Collapses the hierarchy to display the objects at the
top level only.

Back

Displays the objects that were shown immediately
prior to the current display.

Forward

Displays the hierarchy that was shown
immediately after the current display. For
example, if you just selected Back, selecting
Forward returns the view to the display from
which you activated Back.

Follow Other
Views

For working with the default conﬁguration only:
Deﬁnes whether the Registry Explorer view reacts
to selecting an object in another CentraSite view.
When the buon is not pressed, the view does not
focus an object selected in another view. When the
buon is pressed, the object is focused.
Note that an object selected in another view can
only be focused if the
buon is pressed in the
other view.
The Workbench remembers the selection mode
you have set for the Registry Explorer view. The
next time you open the view, the selection mode is
set as you have left it.
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Icon

Name

Action

Synchronize
Other Views

For working with the default conﬁguration
only: Toggles the selection mode in the Registry
Explorer view. When the buon is not pressed,
you have to double-click an entry in the view to
focus the corresponding object in the Association
Navigator view. When the buon is pressed, a
single click focuses the object in the Association
Navigator view.
Note that an object can only be focused in the
Association Navigator view if the
buon is
pressed in the Association Navigator view.
The Workbench remembers the selection mode
you have set for the Registry Explorer view. The
next time you open the view, the selection mode is
set as you have left it.

View Menu

Opens a menu with options for diﬀerent view
conﬁgurations. Use the Default option for
displaying the default conﬁguration, i.e. all
organizations stored in the CentraSite registry and
the assets and users assigned to them.
Contact your system administrator for information
on the contents displayed by additional view
conﬁgurations that are available.

Repository Explorer View
The Repository Explorer view by default displays the Supporting Documents and
Resources of the Supporting Documents Library which belongs to the organization to
which you are assigned.
You can navigate the folder structures in the library, create new folders and carry out the
following actions for existing folders: add to favorites, delete, rename, create External
Links, carry out an impact analysis or create documents.
Single-clicking a folder displays the folders and ﬁles it contains in the Documents View.
Provided you have the required access rights, you can choose to display more than the
Supporting Documents Library in the view. The view allows you to access all folders of
the CentraSite repository, thus enabling you to browse, for example, to:
Schema deﬁnitions for object types. Schema deﬁnitions are stored in the
projects/CentraSite/XMLSchemas folder.
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User-speciﬁc conﬁgurations for an impact analysis. The XML representation of
a conﬁguration is saved to the projects/CentraSite/Control/users/your_user_id/
ImpactAnalysisFilters/ conﬁguration_name.xml ﬁle.
User-speciﬁc search queries. The XML representation of a search query is saved to
the projects/CentraSite/Control/users/your_user_id/Queries/query_name.xml ﬁle.
Icon ﬁles for object types. When creating or modifying object types, an icon ﬁle is
automatically created in the projects/CentraSite/Icons folder of the repository and
connected by an external link to the object type in the registry.

Toolbar
Icon

Name

Action

View Menu

Use the Advanced menu option to switch the
contents displayed in the view. By default, the
contents of the Supporting Documents Library
is displayed. Choose this option to display all
folders of the CentraSite repository.

List Views
List views display lists of registry objects or folders and ﬁles.

Contents View
The Contents view can display diﬀerent information, depending on the element selected
in the Asset Types View, My View or Administration View. The view can also display
the registry object that are the result of an impact analysis you carried out for a Impact
Analysis for Registry Objects or a Impact Analysis for Folders and Files, or the execution
logs of Exporting Data from Centrasite, Importing Data into CentraSite and Creating
Registry Object Versions operations.
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Registry objects in the view can be displayed in a simple or in a structured list:
Click the plus sign (+) in front of an entry to expand the next level of the structure.
Click the minus sign (-) in front of an entry to collapse the structure below.
You can use the Contents view to create, organize and delete registry objects. Depending
on the Changing Preference Seings you have deﬁned for the “Details Editor” on
page 130, you can single-click or double-click a registry object in the view to display
its details in the editor.

Toolbar
Icon

Name

Action

Add Object/
Object Type

Starts a wizard for creating a new object. Specify the
new object's properties in the wizard, as requested.

Customize

Opens a dialog where you can customize the
Customize Dialog for an impact analysis.

Save Report

Saves the current contents of the view to a ﬁle in
HTML format. You can specify the path and name
of the ﬁle in a dialog.

Refresh

Updates the view's contents.

Select
Columns

Opens a dialog where you can select the columns to
be displayed in the table.
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Icon

Name

Action

Synchronize
Other
Views

Toggles the selection mode in the Contents view.
When the buon is not pressed, you have to
double-click an entry in the view to focus the
corresponding object in the Registry Explorer View.
When the buon is pressed, a single click focuses
the object.
Note that an object in the Registry Explorer is only
focused if the
buon is pressed in these views.
The Workbench remembers the selection mode you
have set for the Contents view. The next time you
open the view, the selection mode is set as you have
left it.

Additional options are available when the view displays notiﬁcation requests and
notiﬁcations. For details, see Using Notiﬁcations.

Documents View
The Documents view displays the folders and ﬁles contained in the folder that is
currently selected in the Repository Explorer View.
For a ﬁle, the view displays the latest version. You can carry out the following actions:
view contents, delete, rename, add to favorites, create External Links, carry out an
impact analysis or open the “Details Editor” on page 130 for the ﬁle.
For a folder, you can carry out the following actions: create folders and ﬁles in it, delete,
rename, add to favorites, create external links, carry out an impact analysis or open
the CentraSite Details editor for the folder. You can double-click a folder in the view to
display the folders and ﬁles it contains and focus it in the Repository Explorer view.
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Toolbar
Icon

Name

Action

Up

Moves up one level in the folder hierarchy, i.e.
displays the contents of the current folder's parent
folder in the Documents view. The parent folder is
focused in the Repository Explorer view.

Save Report

Saves the current contents of the view to a ﬁle in
HTML format. You can specify the path and name
of the ﬁle in a dialog.

Refresh

Updates the view's contents.

Select
Columns

Opens a dialog where you can select the columns
to be displayed in the table.

Search View
The CentraSite Eclipse GUI uses an instance of the standard Eclipse Search view to
display the Assets and Registry Objects found by a search request:
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Toolbar
Icon

Name

Action

Run Current
Search Again

Repeats the current search request.

Cancel
Current
Search

Stops the execution of the current search request.

Show
Previous
Searches

Clicking the arrow next to the buon displays
a list of the most recent searches. This includes
searches for registry objects as well as other
searches you have carried out in the Eclipse
workbench (e.g. ﬁle or Java searches). Selecting
an entry in the list re-executes the corresponding
search request. You can delete the entire list of
recent searches by choosing Clear History at the
boom of the list. Choosing History or clicking the
buon displays a dialog where you can remove
individual entries from the search history.

Pin the Search
View

When the buon is pressed, the view is pinned
and not overwrien by the next search. The next
search displays its results in a new view. If the
buon is not pressed, the view is not pinned and
overwrien with the results of the next search that
is carried out.

Reﬁne
Current
Search

Opens the Search dialog where you can modify
the criteria for the most recent search request and
then execute the request.

Save Report

Saves the current contents of the view to a ﬁle in
HTML format. You can specify the path and name
of the ﬁle in a dialog.

Refresh

Updates the view's contents.

Select
Columns

Opens a dialog where you can select the columns
to be displayed in the table.
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Icon

Name

Action

Synchronize
Other Views

Toggles the selection mode in the Search view.
When the buon is not pressed, you have to
double-click an entry in the view to focus the
corresponding object in the Registry Explorer
View. When the buon is pressed, a single click
focuses the object in these views.
Note that an object can only be focused in the
Registry Explorer if the
buon is pressed in
these views.
The Workbench remembers the selection mode
you have set for the Search view. The next time
you open the view, the selection mode is set as
you have left it.

Details Editor
The CentraSite Eclipse GUI adds the CentraSite Details editor to the Eclipse Workbench.

By default, the CentraSite Details editor is opened when a user double-clicks on an
element in one of the CentraSite navigation or list views. CentraSite can display multiple
editors for deﬁning and modifying data on registry objects, folders or ﬁles. By working
with multiple editors, you can deﬁne and modify information on multiple elements in
parallel. Any number of editors can be open, but only one can be active at a time.
The tabs at the upper border in the editor area indicate the names of the registry objects,
folders or ﬁles that are currently open for viewing or editing.
The information on the element open in the CentraSite Details editor is distributed
across diﬀerent tabs. You can select these tabs at the lower border of the editor area. The
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number of tabs available depends on the element that is currently selected. Only one tab
can be active at a time.

Details Editor for Registry Objects
Note:

Objects of type User or Organization can be displayed in the editor but they
cannot be modiﬁed. For objects of these types, the editor operates in read-only
mode.

For modifying a registry object, the “Details Editor” on page 130 provides diﬀerent
tabs. Each tab corresponds to a Aributes that is assigned to the object's type. The proﬁle
deﬁnition speciﬁes which aributes are displayed on each tab.
A tab is only displayed in the editor if you have view permission to the corresponding
proﬁle.
The following proﬁles are predeﬁned in CentraSite and available for every registry
object:
“General” on page 131
“Summary” on page 132
The following proﬁles are predeﬁned in CentraSite. However, they are only available if
they have been explicitly assigned to the object's type.
“Associations” on page 141
“Audit Log” on page 142
“Classiﬁcations” on page 142
“External Links” on page 143
“Object-Speciﬁc Properties” on page 144
“Permissions” on page 145
“Notiﬁcations” on page 146
“Versions” on page 147
If the CentraSite Details editor displays tabs diﬀerent from those listed above, these tabs
correspond to custom proﬁles. Custom proﬁles are proﬁles that have been deﬁned for
the object's type to meet the individual object type requirements. CentraSite provides,
for example, the custom proﬁles Technical Details, Speciﬁcation and Support for Service
objects.

General
The General tab in the “Details Editor” on page 130 displays general Properties of
Registry Objects or general Properties of Resources that is currently selected.
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The properties diﬀer, depending on the selected element. In general, the following
information is displayed:
Predeﬁned properties of registry objects, folders or ﬁles.
Type-speciﬁc custom properties of registry objects.
The Versions of Registry Objects for registry objects of speciﬁc types.
You can update properties by editing the corresponding ﬁelds, or by clicking the buons
next to the ﬁelds and ﬁlling in the dialogs displayed.

Summary
The Summary tab in the “Details Editor” on page 130 provides an overview of the
most important Properties of Registry Objects, Classiﬁcations of Registry Objects,
Associations Between Registry Objects of the selected Assets and Registry Objects. You
cannot make any changes on this tab.
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Details Editor for Resources
For Supporting Documents and Resources stored in the CentraSite repository, the
“Details Editor” on page 130 provides the following tabs:
“Aached To” on page 134
“General” on page 131
“Permissions” on page 145
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“Versions” on page 147 (for ﬁles only)

Attached To
The Aached To tab in the “Details Editor” on page 130 displays the Assets and
Registry Objects to which the selected Supporting Documents and Resources is
connected via an External Links.
By double-clicking an external link in the list or selecting the Details option from an
external link's context menu, you can open the external link's deﬁnition in the CentraSite
Details editor.

Toolbar
Icon

Name

Action

Save
Report

Saves the current contents of the view to a ﬁle in
HTML format. You can specify the path and name
of the ﬁle in a dialog.

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the columns
to be displayed in the table.

Dialogs and Wizards
The following help topics describe dialogs and wizards of the CentraSite Eclipse GUI.
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Customize Dialog
In the Customize dialog, you can select the types of associations, implicit references and
registry objects you want to include in an impact analysis for registry objects and display
in the Contents view.
The dialog has the following tabs which are described in the corresponding help topics:
General tab
Types tab
Associations tab
Implicit References tab
The following ﬁelds and options in the dialog's upper area are common to all tabs:
Field / Option

Description

Conﬁguration

Enables you to save and restore dialog seings:
To save the current seings: Type or select a name of your
choice in the Conﬁguration ﬁeld and click Save. The saved
seings are user-speciﬁc and can be restored by the same
user on any client.
To restore a set of seings you have saved: Select the
corresponding conﬁguration in the Conﬁguration ﬁeld.

Save

Saves the current dialog seings under the name speciﬁed
in the Conﬁguration ﬁeld.

Remove

Removes the set of seings speciﬁed in the Conﬁguration
ﬁeld from the list of saved conﬁgurations.

The Apply buon at the boom of the dialog applies your seings without closing the
dialog. For example, you can change seings and click Apply to see the eﬀects in the
Contents view. When you are satisﬁed, you can save the seings in a conﬁguration.

General Tab (Customize Dialog)
On the General tab of the Customize dialog, you can specify the number of association
levels and the classiﬁcations to be considered in an impact analysis and displayed in the
Contents view.
The tab has the following ﬁelds and options:
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Field / Option

Description

Depth of
references to
show

A number entered in the ﬁeld speciﬁes the maximum
number of association levels to consider/display. By
clicking Set to Maximum, the number of levels is set to the
maximum, indicated by the value Max in the input ﬁeld.

Show
classiﬁcations
of

Specify whether or not classiﬁcations are to be displayed for
taxonomies, categories and/or classiﬁcations by selecting or
deselecting the corresponding checkboxes.

Show
classiﬁcations
by object type
category

Specify whether the object type of a registry object is to be
shown as a classiﬁcation in addition to being displayed as
the object's type.

Types Tab (Customize Dialog)
On the Types tab of the Customize dialog, you can specify the types of registry objects to
be considered in an impact analysis and displayed in the Contents view.
The table shows the available object types.
In the Follow column of the table, select the types of registry objects which are to be
considered when retrieving an object's associations and implicit references. In the
Display column, select the types of registry objects that are to be displayed in the
Contents view. Object types you include for following associations do not need to be
displayed. On the other hand, object types you want to display must also be followed.
Use the Select all options below the table to select or deselect all types in the
corresponding table columns.

Associations Tab (Customize Dialog)
On the Associations tab of the Customize dialog, you can specify the types of
associations to be considered in an impact analysis.
The table shows the available association types. By checking the Show internal
association types option, you can include association types which are reserved for
CentraSite-internal use.
You can select association types in either the Top down or the Boom up column of the
table. The column decides where the corresponding associations and target objects are
displayed in the Association Navigator view with respect to the source object:
Top down: The associations and target objects are displayed below the source object.
Boom up: The associations and target objects are displayed above the source object.
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Use the Select all options below the table to select or deselect all association types in the
corresponding table columns.

Implicit References Tab (Customize Dialog)
On the Implicit References tab of the Customize dialog, you can specify the types
of implicit references to be considered in an impact analysis and displayed in the
Association Navigator view.
The table shows the available types of implicit references.
You can select implicit reference types in either the Top down or the Boom up column
of the table. The column decides where the corresponding references and target objects
are displayed in the Association Navigator view with respect to the source object:
Top down: The references and target objects are displayed below the source object.
Boom up: The references and target objects are displayed above the source object.
Use the Select all options below the table to select or deselect all implicit reference types
in the corresponding table columns.

Edit Dialog
In the Edit Name or Edit Description dialog, you can specify registry object names or
descriptions for diﬀerent locales.
The dialog has the following ﬁelds and options:
Field / Option

Description
Displays a dialog where you can select one or more locales that
are to be added to the list of Deﬁned locales in the Edit Name or
Edit Description dialog.
Removes the selected entries from the list of Deﬁned locales in
the Edit Name or Edit Description dialog.

Deﬁned
locales

Displays the locales in which the name or description of the
registry object can be speciﬁed. An asterisk indicates the locale
for the default language selected in the Preferences.

Value of
selected
locale

Displays the value, i.e. the object name or description, for the
locale selected in the list of Deﬁned locales. You can change the
value here as required.
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New/Modify Type Wizard
The following help topics describe the pages of the wizard used to create or modify an
object type.
“General Page” on page 138
“Aributes Page” on page 139
“Custom Proﬁles Page” on page 140
“Predeﬁned Proﬁles Page” on page 140
“Proﬁle Order Page” on page 148

General Page
On the General page of the New Type or Modify Type wizard, you specify general
parameters for the object type you want to create or modify. When you modify a
predeﬁned asset type or the system-deﬁned types Organization or User, options on this
page are write-protected.
The page has the following ﬁelds and options:
Field / Option

Description

Name

Alphanumeric name of the type which is to be displayed at the
CentraSite user interfaces.

Description

Optional. An alphanumeric description of the type.

Schema
name

The schema name of the type. This name is used internally
by CentraSite operations. This name can contain only leers,
numbers, and the underscore character (_).

Namespace

The URL specifying the namespace for the type, for example,
hp://www.MyCompany.com/MyDepartment. The URL does
not need to be the address of a real Web location, but it should be
chosen to be unique to your business organization and represent
your company or department as precisely as possible.

Large icon

Optional. An icon to be displayed for the type and all of its
objects on the Detail Pages in the CentraSite Control (Web
interface).
Use the Browse buon to select the icon in the CentraSite
repository or in your local ﬁle system. If you specify an
icon, a corresponding ﬁle is automatically created in the
projects/CentraSite/Icons folder of the repository, if it does not
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Field / Option

Description
yet exist there, and connected by an external link to the object
type in the registry. If you do not specify an icon, the CentraSite
icon for categories is used for the type and its objects.

Small icon

Optional. An icon to be displayed for the type and all of its
objects in the CentraSite Eclipse GUI and on the List Pages in the
CentraSite Control (Web interface).
Use the Browse buon to select the icon in the CentraSite
repository or in your local ﬁle system. If you specify an
icon, a corresponding ﬁle is automatically created in the
projects/CentraSite/Icons folder of the repository, if it does not
yet exist there, and connected by an external link to the object
type in the registry. If you do not specify an icon, the CentraSite
icon for categories is used for the object type and its objects.

Attributes Page
On the Aributes page of the New Type or Modify Type wizard, you specify aributes
for the object type you want to create or modify. Aributes deﬁned for predeﬁned object
types cannot be modiﬁed or deleted.
The page has the following ﬁelds and options:
Field / Option

Description
Displays the New Aribute dialog for deﬁning a new aribute.
An entry for the new aribute will be added to the table on the
Aributes page as soon as it is deﬁned.
Removes the selected entry from the table on the Aributes
page and thus the aribute from the type's deﬁnition. When
you modify a predeﬁned asset type or the system-deﬁned
types Organization or User, the predeﬁned aributes cannot be
deleted.

Aributes

Displays the aributes already deﬁned for the object type. To
modify an existing aribute, double-click it in the table. This
displays the Modify Aribute dialog to change the aribute's
deﬁnition.
The table shows the following details:
Name: Alphanumeric name of the aribute.
Type: The data type for the values of the aribute.
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Field / Option

Description
Description: The alphanumeric description of the aribute.

Custom Profiles Page
On the Custom Proﬁles page of the New Type or Modify Type wizard, you deﬁne new
proﬁles or modify existing proﬁles for the object type.
The page has the following ﬁelds and options:
Field / Option

Description
Displays the New Proﬁle dialog for deﬁning a new proﬁle from
the aributes that are currently deﬁned for the type.
Removes the selected proﬁle from the table on the Custom
Proﬁles page and thus the proﬁle from the type.

Custom
proﬁles

Displays the custom proﬁles already deﬁned for the object type
in a tree structure. Each proﬁle is listed with subordinate entries
for the aributes that are assigned to it. To modify an existing
proﬁle, double-click it in the table. This displays the Modify
Proﬁle dialog to change the current assignment of aributes.

Predefined Profiles Page
On the Predeﬁned Proﬁles page of the New Type or Modify Type wizard, you can select
which predeﬁned proﬁles you want to display for objects of this type in the “Details
Editor” on page 130. Proﬁle assignments for predeﬁned object types and the systemdeﬁned object types Organization and User cannot be removed.
The page lists all proﬁles that are predeﬁned in CentraSite:
“Associations” on page 141
“Audit Log” on page 142
“Classiﬁcations” on page 142
“External Links” on page 143
“Object-Speciﬁc Properties” on page 144
“Permissions” on page 145
“Notiﬁcations” on page 146
“Versions” on page 147
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Select the proﬁles to be displayed for the type. Remove a selection to deassign a proﬁle.
Associations
The Associations tab in the “Details Editor” on page 130 displays the associations of
the currently selected registry object.
The Associations tab displays:
the selected object's outgoing associations. The tab displays each association that
starts at the object with the corresponding target object.
the selected object's incoming associations. The tab displays each association that
ends at the object with the corresponding source object.
You can add and remove outgoing associations and browse to a source or target object.
For adding or removing incoming associations, you have to browse to the corresponding
source object.
By double-clicking an association in the list or selecting the Details of Target Object
option from an association's context menu, you can open the deﬁnition of the target
object in the CentraSite Details editor. Using the Details of Association option, you can
open the deﬁnition of the association.

Toolbar
Icon

Name

Action

Assign
Associations

Starts a wizard for adding one or more
outgoing associations to the registry object.

Remove
Associations

Deletes the outgoing associations selected in
the table.

Save Report

Saves the current list of associations to a ﬁle in
HTML format. You can specify the path and
name of the ﬁle in a dialog.
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Icon

Name

Action

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the
columns to be displayed in the table.

Audit Log
The Audit Log tab of the “Details Editor” on page 130 displays the events recorded in
the audit log for the selected registry object.

Toolbar
Icon

Name

Action

Save Report

Saves the current contents of the log to a ﬁle in
HTML format. You can specify the path and
name of the ﬁle in a dialog.

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the
columns to be displayed in the table.

Classifications
The Classiﬁcations tab in the “Details Editor” on page 130 displays the internal and
external classiﬁcations assigned to the currently selected registry object.
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You can add and remove classiﬁcations. By double-clicking a classiﬁcation in the list
or selecting the Details option from a classiﬁcation's context menu, you can open the
classiﬁcation's deﬁnition in the CentraSite Details editor.

Toolbar
Icon

Name

Action

Add External
Classiﬁcation

Starts a wizard for adding an external
classiﬁcation to the registry object.

Add Internal
Classiﬁcations

Starts a wizard for adding internal
classiﬁcations to the registry object.

Remove
Classiﬁcations

Deassigns the selected classiﬁcations from the
registry object.

Save Report

Saves the current contents of the tab to a ﬁle in
HTML format. You can specify the path and
name of the ﬁle in a dialog.

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the
columns to be displayed in the table.

External Links
The External Links tab in the “Details Editor” on page 130 displays the external links
of the currently selected registry object.
You can add, modify and remove external links, and display the target of an external
link in a Web browser or in an editor of the Eclipse Workbench. By double-clicking an
external link in the list or selecting the Details option from an external link's context
menu, you can open the external link's deﬁnition in the CentraSite Details editor.
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Toolbar
Icon

Name

Action

Add External
Link

Opens a dialog for adding an external link to
the currently selected registry object.

Remove
External
Links

Removes the selected external links.

Edit URL

Opens a dialog for modifying the URL of the
selected external link.

Save Report

Saves the current contents of the tab to a ﬁle in
HTML format. You can specify the path and
name of the ﬁle in a dialog.

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the
columns to be displayed in the table.

Object-Specific Properties
The Object-Speciﬁc Properties tab in the “Details Editor” on page 130 displays the
object-speciﬁc properties of the registry object that is currently selected.
You can deﬁne new object-speciﬁc properties or remove existing properties from
the deﬁnition. You can also modify existing properties. To do so, double-click the
corresponding entry in the table to display a dialog for changing the property's
deﬁnition.
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Toolbar
Icon

Name

Action

Add Property

Displays a dialog for deﬁning a new property.
An entry for the new property will be added
to the table on the tab as soon as it is deﬁned.

Remove
Property

Removes the selected entry from the table
on the tab and thus the property from the
deﬁnition.

Permissions
The Permissions tab in the “Details Editor” on page 130 displays the security seings
for the registry object, object type or folder or ﬁle currently selected.
An option that is checked indicates that the user or group is granted the corresponding
permission. An option that is not checked indicates that the user or group is denied the
corresponding right.
You cannot make changes on this tab. For deﬁning security seings, use the CentraSite
Control (Web interface).
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Toolbar
Icon

Name

Action

Save Report

Saves the current contents of the tab to a ﬁle
in HTML format. You can specify the path
and name of the ﬁle in a dialog.

Notifications
The Notiﬁcations tab in the “Details Editor” on page 130 displays the users who have
registered a notiﬁcation request for the selected registry object in order to be notiﬁed
about changes.
By double-clicking a user entry in the list or selecting the Details of Target Object option
from a user's context menu, you can open the user's deﬁnition in the editor. Using the
Details of Association option in a user's context menu, you can open the deﬁnition of the
underlying association.
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Toolbar
Icon

Name

Action

Save Report

Saves the current contents of the table to a ﬁle
in HTML format. You can specify the path
and name of the ﬁle in a dialog.

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the
columns to be displayed in the table.

Versions
The Versions tab of the “Details Editor” on page 130 displays the versions of a
registry object or ﬁle.
For registry objects only: By double-clicking a version in the list or selecting the Details
option from a version's context menu, you can open the version's deﬁnition in the
CentraSite Details editor.
For ﬁles only: By double-clicking a version in the list or selecting the Show Document
option from a version's context menu, you can display the version's contents in an
editor. The editor that is opened depends on the ﬁle's type. You can specify the editors to
be used for speciﬁc ﬁle types in the Preferences of the Workbench.
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Toolbar
Icon

Name

Action

Save Report

Saves the current contents of the view to a ﬁle
in HTML format. You can specify the path
and name of the ﬁle in a dialog.

Refresh

Updates the tab's contents.

Select
Columns

Opens a dialog where you can select the
columns to be displayed in the table.

Profile Order Page
On the Proﬁle Order page of the New Type or Modify Type wizard, you deﬁne in which
order the custom proﬁles and predeﬁned proﬁles are to be displayed in the “Details
Editor” on page 130.
The page lists all proﬁles that are currently assigned to the type.
indicates that a
proﬁle is a custom proﬁle,
indicates that a proﬁle is a predeﬁned proﬁle.
Use the arrow buons on the left of the proﬁle list to sort the proﬁles: Select a proﬁle in
the list and move it to the required position by using the up or down arrow.

New/Modify Attribute Dialog
In the New Aribute or Modify Aribute dialog, you deﬁne or modify an aribute for
an object type.
The dialog has the following ﬁelds and options:
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Field /
Option

Description

Name

The display name for the aribute. This is the name that users
will see when they view instances of this type in the user
interface. Therefore, the name should be meaningful. The display
name can contain any combination of characters, including
spaces. You can change an aribute's display name at any time.

Schema
Name

The schema name for the aribute. The schema name is the
internal name that CentraSite assigns to the aribute. This name
can contain only leers, numbers and the underscore character
(_).
CentraSite automatically generates a schema name for the
aribute based on the name you enter in the Name ﬁeld.
However, if your display name contains special characters, you
may need to explicitly edit the schema name to ensure that it
contains only leers, numbers, and the underscore character (_).
After you create and save an aribute, you can no longer change
its schema name.
For additional information about aribute display names and
schema names, see “Aributes” on page 38.

Description

Optional. An alphanumeric description of the aribute.

Required

Check this option if the aribute is mandatory. Otherwise, it is
optional.

Read-only

Check this option if the aribute is read-only. Otherwise, the
aribute value can be changed for an object of this type.

Multiplicity

Select Single value if the aribute has just one value. Select
Multiple value if the aribute has more than one value.

Data type

The data type for the values of the aribute: Select one of the
available types from the list and specify the data type speciﬁc
information that is required (see below).
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Data Types in New/Modify Attribute Dialog
Date Type

Description

Boolean

Data type for visualizing a property of a registry object. Select Yes
or No as default value.

Classiﬁcation Data type for visualizing a classiﬁcation of a registry object.
Specify a taxonomy and optionally a category that belongs to the
taxonomy.
Computed
Aribute

Data type for visualizing a property, classiﬁcation or external link
of a registry object.

Date/
Time

Data type for visualizing a property of a registry object. You can
select whether to specify date and time or date only or time only.
You can also enter a default value for the date and/or time.

Duration

Data type for visualizing a property of a registry object. You can
specify a default value for the duration.

E-Mail

Data type for visualizing an e-mail address as a property of a
registry object.

File

Data type for visualizing an external link for a registry object.

IP
Address

Data type for visualizing an IP address as a property of a registry
object. You can choose between IPV4 and IPV6 and enter a default
value.

Number

Data type for visualizing a number as a property of a registry
object. You can deﬁne a label for the number, either as preﬁx or
suﬃx. You can also enter a default value.

Relationship

Data type for visualizing an association of a registry object. Select
the association type and the object type for the target objects of the
association.

String

Data type for visualizing a property of a registry object.
Check the Internationalized option if the aribute is to support
values for diﬀerent locales. Check the Enumeration option and
specify multiple string values if the user is to choose the aribute

CentraSite Eclipse UI Help Version 10.3

150

M

Odd Header
Reference

Date Type

Description
value from a select list. For both options, you can specify a default
value.

URL/URI

Data type for visualizing a URL/URI as a property of a registry
object. You can enter a default value for the aribute.

New/Modify Profile Dialog
In the New Proﬁle or Modify Proﬁle dialog, you deﬁne or modify a proﬁle for an object
type.
The dialog has the following ﬁelds and options:
Field /
Option

Description

Name

Alphanumeric name of the proﬁle. The name must not contain
blanks or special characters that are forbidden in XML element
names. It must be unique within the proﬁles you deﬁne for the
object type. It is recommended that you do not use the names of
predeﬁned proﬁles for your custom proﬁles.

Available
aributes

All aributes that are deﬁned for the object type. Select the
aributes to be assigned to the proﬁle. Remove a selection to
deassign an aribute.

Select Date and Time Dialog
In the Select Date and Time dialog, you can specify the date and time to be used for the
property, condition or action from which you invoked the dialog.
The dialog has the following ﬁelds and options:
Field /
Option

Description

Calendar

Displays the days of a month. Using the arrows on top, you can
move to the previous month, the same month of the previous
year, the same month of the next year, or the next month. Click
a day in the calendar to select it. To select the current day, click
Today. The selected day is displayed in the Selected date ﬁeld
below the table.

CentraSite Eclipse UI Help Version 10.3

151

M

Even Header
Reference

Field /
Option

Description

Time

Specify a time of day in the following format: HH:mm:ss.
You must at least enter an hour; the minutes and seconds are
substituted by 0 if not speciﬁed.

Timezone

Select the timezone to be used: The local timezone of your
computer or UTC. If both are not suitable to your needs, you can
add a time diﬀerence compared to UTC to the entry in the Time
ﬁeld using a + sign, for example: 13:00+07 adds 7 hours to 13:00
UTC time.

Select Object Dialog
For various actions you carry out in the CentraSite Eclipse GUI, you can select the
registry objects of relevance in a Select Object dialog or on a corresponding wizard
page. Object speciﬁes the type of the registry object you are going to select, for example,
Organization or Service.
The table in the lower area of the dialog contains the registry objects which are
candidates for selection. You can reduce this list by specifying search conditions in the
upper area of the dialog and clicking Search. When you have found the registry object
you are looking for, select it in the table and click OK. For speciﬁc actions, you can select
more than one registry object.
The dialog has the following ﬁelds and options:
Field /
Option

Description
Opens the Add Condition dialog for adding a search condition.
Removes the selected search condition. Conditions specifying
object types cannot be removed. Depending on the action for
which you opened the dialog, other conditions may not be
removable, too.
Opens a Search dialog and displays the XQuery representation of
the search conditions on the XQuery page.

Saved
search

Enables you to save and restore a set of search conditions:
To save the current search conditions: Type or select a name of
your choice in the Saved search ﬁeld and click Save. The saved
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Field /
Option

Description
queries are user-speciﬁc and can be restored by the same user on
any client.
To restore a set of search conditions you have saved: Select the
corresponding query in the Saved search ﬁeld.

Save

Saves the current search conditions under the name speciﬁed in
the Saved search ﬁeld.

Condition
table

Displays the current search conditions. The conditions are
combined by logical ANDs. They cannot be ORed. Doubleclicking a condition opens the Modify Condition dialog where
you can modify the condition's details. Depending on the action
for which you opened the dialog, speciﬁc conditions may not be
editable.

Search

Retrieves all registry objects that fulﬁll the search conditions and
enters them in the table below.
Saves the current list of registry objects to a ﬁle in HTML format.
You can specify the path and name of the ﬁle in a dialog.
Updates the list of registry objects.
Opens a dialog where you can select the columns to be displayed
in the table.

Objects
table

Displays the registry objects that fulﬁll the search conditions.
Click an object to select it.

Pages in BIRT
The CentraSite Eclipse GUI integrates the following pages in wizards and dialogs of the
Eclipse Business Intelligence and Reporting Tools (BIRT):

Registry Page
The CentraSite Eclipse GUI integrates the CentraSite Registry page in the BIRT Edit Data
Source dialog for data sources of type CentraSite. The page has the following ﬁelds and
options:
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Field /
Option

Description

Object/
table
mapping

Speciﬁes how the elements deﬁned in the CentraSite registry are
mapped to tables and columns that are usable by BIRT. Usually, you
can work with the default mapping that comes with the CentraSite
Eclipse GUI. In this case, select Use default mapping. Alternatively,
you can select Use ﬁle from URL and specify the URL of an XML ﬁle
that deﬁnes a diﬀerent mapping; for details about such XML ﬁles,
contact your CentraSite support organization.

Define Query Page
The CentraSite Eclipse GUI integrates the Deﬁne Query page in the BIRT New Data Set
wizard and Edit Data Set dialog for data sets that use a data source of type CentraSite.
The page has the following ﬁelds and options:
Field /
Option

Description

Name
paerns

Partial or full paern for the name of the registry objects you want
to include in your reports. The wildcard character for the name
paern is %. The name paern must comply with the SQL-92 LIKE
speciﬁcation. For example, Sample% searches for registry objects
whose names start with the string Sample. Speciﬁcation of a name
paern is mandatory.

Type

The type of the registry objects you want to include in your reports.
You must select exactly one type.

Find
qualiﬁers

Options that determine the registry object search behavior.
The options you can choose are compliant with the UDDI API
speciﬁcation:
exactNameMatch When selected, only the objects are returned
whose names exactly match the paern speciﬁed in the Name
Paern ﬁeld. Otherwise, a lexical-order name match behavior is
applied.
caseSensitiveMatch When selected, only the objects are returned
whose names exactly match the case of the paern speciﬁed in the
Name Paern ﬁeld. Otherwise, the search is case-insensitive.
None, sortByNameAsc, sortByNameDesc Speciﬁes how the names of
the registry objects returned are to be sorted:
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Field /
Option

Description
None: The default sort order deﬁned in the registry is applied.
sortByNameAsc: The names are sorted in ascending alphabetic
order.
sortByNameDesc: The names are sorted in descending alphabetic
order.
None, sortByDateAsc, sortByDateDesc Speciﬁes how the registry
objects returned are to be sorted depending on their last-update date.
The registry objects are ﬁrst sorted by their name, then by their lastupdate date:
None: The default sort order deﬁned in the registry is applied.
sortByDateAsc: The names are sorted in ascending chronological
order.
sortByDateDesc: The names are sorted in descending chronological
order.
None, orLikeKeys, orAllKeys, andAllKeys Speciﬁes the boolean
operator for combining the categories you select in the list below:
None: The default operator deﬁned in the registry is applied.
orLikeKeys: Categories selected in the same taxonomy are ORed,
categories of diﬀerent taxonomies are combined by logical ANDs.
orAllKeys: All the selected categories are ORed.
andAllKeys: All the selected categories are combined by logical
ANDs.

Categories

Select one or more categories that classify the registry objects you are
looking for. The categories you select are combined by the boolean
operator you choose under Find qualiﬁers.

Specify XQuery Page
The CentraSite Eclipse GUI integrates the Specify XQuery page in the BIRT New
Data Set wizard and Edit Data Set dialog for data sets that use a data source of type
CentraSite XQuery. The page has the following ﬁelds and options:
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Field /
Option

Description

Query

The query that speciﬁes the data to be retrieved from the registry
and to be included in the data set. The query must be wrien in
XQuery syntax and format. For details on XQuery in CentraSite,
contact your CentraSite support organization.
Example:
The following query retrieves all registry objects of type
organization from the registry.
declare namespace cs="hp://namespaces.CentraSite.com/Schema/
jaxr"; for $ro in collection("CentraSite")/cs:organization return $ro

Delete
Query

Removes any text from the Query ﬁeld.

Load

Opens a dialog where you can select a text ﬁle that contains a query.
The text ﬁle contents is loaded into the Query ﬁeld.

Paste

Pastes the contents of the clipboard to the Query ﬁeld. Alternatively,
you can press CTRL + V on your keyboard.

Preview
ﬁrst x
lines of
source
data

Allows you to specify the maximum number of table rows that
the BIRT preview function should display. If you do not check this
option, the number of rows is unlimited.

Define Table Mapping Page
The CentraSite Eclipse GUI integrates the Deﬁne Table Mapping page in the BIRT New
Data Set wizard and Edit Data Set dialog for data sets that use a data source of type
CentraSite XQuery. The page has the following ﬁelds and options:
Field /
Option

Description

XML
Structure

Shows the schema information for the registry elements that match
the given query. One of these elements must be mapped to a table
which is usable by BIRT. To do this, select the desired element, click
the > buon and specify the XPath expression for addressing the
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Field /
Option

Description
element in the registry. The XPath expression is entered in the XPath
expression ﬁeld.

XPath
expression

Speciﬁes the XPath expression for addressing the element, that is to
be mapped to a table, in the CentraSite registry.

Define Column Mapping Page
The CentraSite Eclipse GUI integrates the Deﬁne Column Mapping page in the BIRT
New Data Set wizard and Edit Data Set dialog for data sets that use a data source of type
CentraSite XQuery. The page has the following ﬁelds and options:
Field /
Option

Description

XML
Structure

Shows the schema information for the registry elements that match
the given query. One of these elements must have been mapped to
a table which is usable by BIRT on the Deﬁne Table Mapping Page;
this element is highlighted.
You can choose any of the other elements and map them to columns
of the given table. To do this, select the desired element and click
the > buon. In the dialog displayed, specify the column name,
the XPath expression for addressing the selected element in the
CentraSite registry, and the data type for the element's value. The
speciﬁed parameters are entered in the Column Mapping table.

Column
Mapping

Speciﬁes the mappings of registry elements to columns usable by
BIRT. After clicking the <new mapping here> entry, you can type the
column name, XPath expression and data type for a new mapping
directly in the table.
Use the arrow buons to change the order of the columns: Select an
entry and click the relevant buon to move it up or down in the list.
Click the

Table
Preview

buon to delete the selected mapping from the list.

Shows a preview of the table and columns you have deﬁned. Click
the buon to create or update the preview.
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Pages in the Search Dialog
For searching registry objects, the CentraSite Eclipse GUI adds the following pages to
the standard Search dialog of the Eclipse Workbench:
Use the Customize option to select or deselect the pages to be displayed in the Search
dialog.

Advanced Search Page
The CentraSite Eclipse GUI adds the CentraSite Advanced Search page to the standard
Search dialog of the Eclipse Workbench. The page has the following ﬁelds and options:
Field /
Option

Description
Opens the Add Condition dialog for adding a Search and Filter
Conditions to the table.
Removes the selected search condition from the table. Conditions
specifying an object type cannot be removed.
Opens a new Search dialog and displays the XQuery representation
of the search conditions on the XQuery Page.

Saved
search

Enables you to save and restore a set of search conditions:
To save the current search conditions: Type a name of your choice
in the Saved search ﬁeld and click Save. The saved queries are userspeciﬁc and can be restored by the same user on any client.
To restore a set of search conditions you have saved: Select
the corresponding query in the Saved search ﬁeld. The search
conditions are displayed on the CentraSite Advanced Search page.
You can modify the restored search conditions and save them under
the same or a diﬀerent name.

Condition
table

Displays the current search conditions. The conditions are combined
by logical ANDs in the search. They cannot be ORed. Double-clicking
a condition opens the Modify Condition dialog where you can
modify the condition's details.
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Keyword Search Page
The CentraSite Eclipse GUI adds the CentraSite Keyword Search page to the standard
Search dialog of the Eclipse Workbench. The page has the following ﬁelds and options:
Field /
Option

Description

Saved
search

Enables you to save and restore a keyword search:
To save the current keywords: Type a name of your choice in the
Saved search ﬁeld and click Save. The saved queries are userspeciﬁc and can be restored by the same user on any client.
To restore a keyword search you have saved: Select the
corresponding query in the Saved search ﬁeld. The keywords to
search for are displayed on the CentraSite Keyword Search page.
You can modify the restored keywords and save them under the
same or a diﬀerent name.

Search

Enter the keywords to search for. Note the following when entering
keywords:
Separate the keywords by spaces, if you enter more than one
keyword. The search returns all registry objects that match at least
one of the keywords, i.e. the keywords are combined by logical
ORs.
A keyword is treated as a partial string. Searching for al, for
example, returns CalcService, Calendar or AustralianPostCode.
Use quotes if you do not want a keyword to be treated as a partial
string. The search is then performed on the exact string within the
quotes.
The search is not case-sensitive. This also applies if you search for
strings in quotes. Searching for abc, for example, returns the same
result as searching for ABC.
Use * or % as wildcard. Searching for A%n, for example, returns
Amazon and American. You can use one or more wildcards in your
query, as required. Wildcards can also be used within quotes.
Leave the Search ﬁeld blank or enter a wildcard to return all
registry objects stored in the CentraSite registry.
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XQuery Page
The CentraSite Eclipse GUI adds the CentraSite XQuery page to the standard Search
dialog of the Eclipse Workbench. The page has the following ﬁelds and options:
Field /
Option

Description

Saved
search

Enables you to save and restore a query:
To save the current query: Type a name of your choice in the Saved
search ﬁeld and click Save. The saved queries are user-speciﬁc and
can be restored by the same user on any client.
To restore a query you have saved: Select the corresponding query
in the Saved search ﬁeld. The query is displayed on the CentraSite
XQuery page. You can modify the restored query and save it under
the same or a diﬀerent name.

Execute
XQuery

Specify the query in XQuery format. You can specify any query that
fulﬁlls the syntactical and semantical requirements of CentraSite and
returns a list of registry objects as its result. For details on XQuery in
CentraSite, contact your CentraSite support organization.
The Execute XQuery ﬁeld oﬀers basic text editing functions such as
undo, cut, copy, and paste, that help you entering queries.

Customizing Options for the Impact Analyzer
In the Impact Analyzer View, you use the options in the menu bar to select the types
of Associations Between Registry Objects and Assets and Registry Objects you want
to include in the impact analysis and display in the view. The options allow you to
determine exactly what you want to display and to size and print the graph as required.
The menu bar has the following pull-down menus:
“Types” on page 161
“Associations” on page 162
“Controls” on page 162
“Conﬁguration” on page 163
Next to the pull-down menus, the following options are provided:
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Option

Description

Current

Displays the conﬁguration that is currently used for the Impact
Analyzer view. CentraSite provides options for saving and restoring
the seings deﬁned for the view in so-called conﬁgurations.
CentraSite delivers predeﬁned conﬁgurations, and you can deﬁne
and save your own custom conﬁgurations. These are user-speciﬁc
and can be restored by the same user on any client, if required.
Use the options provided in the Conﬁguration menu to select a
predeﬁned or a custom conﬁguration, and to save and restore your
seings.

Zoom

Zoom factor for scaling the graph up or down. Enter a factor to scale
the current graphical representation.

Types
You can use the options in the Types menu to select the types of registry objects to be
considered in the impact analysis and displayed in the Impact Analyzer view:
Option

Description

Assets

Allows you to consider and display all existing asset types.

Custom

Allows you to individually choose the object types you want to
consider and display in the analysis from the complete list of object
types deﬁned in the CentraSite registry.
Selecting Custom opens a sub-menu with all existing object types.
In the Follow column in front of the object type names, select the types
of registry objects which are to be considered when retrieving an
object's associations and implicit references. In the Display column
behind the object type names, select the types of registry objects that
are to be displayed in the Impact Analyzer view. Object types you
include for following associations do not need to be displayed. On the
other hand, object types you want to display must also be followed.
Use the Select all options at the top to select or deselect all types in the
corresponding columns.
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Associations
You can use the options in the Associations menu to specify the types of associations to
be considered in the impact analysis and displayed in the Impact Analyzer view:
Option

Description

Relationship Allows you to consider all associations represented by aributes of
Aributes data type Relationship in the impact analysis.
Custom

Allows you to individually choose the association types you want to
consider in the analysis.
Selecting Custom opens a sub-menu with a list of all existing
association types. Select the types to be considered.
Use the Select all option at the top to select or deselect all association
types.
By checking the Show internal association types option, you can also
include association types which are reserved for CentraSite-internal
use.

Controls
You can use the options in the Controls menu to specify the number of association levels
to be displayed, print the results of an analysis and change your screen display:
Option

Description

Auto
Expansion
Level

Allows you to deﬁne the maximum number of association levels to
consider/display. Click 1, 2 or 3, or enter the level number of your
choice in the Custom ﬁeld.

Print

Allows you to print the association graph. Click the
buon to
print the graph with the zoom factor that is currently set. Click the
buon to print the graph on one page. The graph might be scaled
down for this purpose.

Full
Screen

Allows you to open the Impact Analyzer view in full screen mode.
Click the
buon to switch to full screen mode and use Esc to return
to the initial screen size.
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Configuration
The Conﬁguration menu enables you to save and load seings for the Impact Analyzer.
CentraSite provides predeﬁned conﬁgurations, and you can save seings in so-called
custom conﬁgurations. You can restore your custom conﬁgurations on any client, as
required.
The following conﬁgurations are predeﬁned in CentraSite:
Asset Dependencies
Schema Usage
Organization Details
Service Details
Option

Description

Select a
Conﬁguration

To load a conﬁguration for the current impact analysis: Select
the conﬁguration in the list. To delete a conﬁguration you no
longer need: Click the
buon next to a conﬁguration. A
custom conﬁguration you delete cannot be restored any longer.
If you delete a predeﬁned conﬁguration, it will be available
again in the menu with your next login.

Add new
conﬁguration

To save the current seings in a conﬁguration: Type a name of
your choice in the ﬁeld and click Save. The seings are saved
under the name you specify. The saved conﬁguration is userspeciﬁc and can be restored by the same user on any client. The
list of conﬁgurations in the Conﬁguration menu is extended.

Search and Filter Conditions
When executing a registry search by conditions or selecting registry objects, you can add
or edit search or ﬁlter conditions in a corresponding dialog. The available conditions are
listed in the Type of Condition area of the dialog. They depend on the action you are
executing and on the object type or types you have selected as a condition. In the Details
area of the dialog, you can specify the details and parameters for the condition selected
in the Type of Condition area.
The type of the registry objects to be included in the search or ﬁlter is predeﬁned on the
CentraSite Advanced Search page. To change the object type, double-click the condition.
This displays the Modify Condition dialog where you can modify the condition's details.
When the Show all types option is not checked, the type list includes the most important
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object types that are predeﬁned in CentraSite as well as object types you have deﬁned
yourself. When the option is checked, the list includes all available object types.
The following table describes all the conditions that may be shown in the Type of
Condition dialog and the details you can specify for each of them.
Condition

Description

Name

Specify the name of the registry objects you want to include
in the search or ﬁlter. When the UDDI-like paern matching
option is not checked, the name is treated as speciﬁed and
case-sensitive. When the option is checked, the name is
handled in a case-insensitive way, and % characters in it
are interpreted as wildcards for one or more characters. For
example, Sample% includes all registry objects whose names
start with the string Sample.

Description

Specify the description of the registry objects you want to
include in the search or ﬁlter. When the UDDI-like paern
matching option is not checked, the description is treated
as speciﬁed and case-sensitive. When the option is checked,
the description is handled in a case-insensitive way, and %
characters in it are interpreted as wildcards for one or more
characters.

Internal
Classiﬁcation

Specify the category that Classifying Registry Objects the
registry objects you want to include in the search or ﬁlter.
Use the Browse buon to select the category in the Select
Object Dialog. Specify whether registry objects classiﬁed by
sub-categories of the given category are to be included in
the search or ﬁlter by checking or unchecking Include subcategories.

External
Classiﬁcation

Specify the taxonomy and value that Classifying Registry
Objects the registry objects you want to include in the search
or ﬁlter. Use the Browse buon to select the taxonomy in the
Select Object Dialog.

Service by
Provider

Specify the organization which provides the services you want
to include in the search or ﬁlter. Use the Browse buon to
select the organization in the Select Object Dialog.

Service by
Interface

Specify the interface assigned to the services you want to
include in the search or ﬁlter. Use the Browse buon to select
the interface in the Select Object Dialog.
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Condition

Description

Service by
Operation

Specify the operation assigned to the services you want to
include in the search or ﬁlter. Use the Browse buon to select
the operation in the Select Object Dialog.

Versioning

Select this condition if you want the search to include only the
most recent version of Versions of Registry Objects. Otherwise,
all versions of an object are taken into account.

Type-Speciﬁc
Property

Select the property and specify the value of the property
which is set for the registry objects you want to include in the
search or ﬁlter.

Object-Speciﬁc
Property

Specify the name, Namespaces and value of the property
which is set for the registry objects you want to include in the
search or ﬁlter.

Owner

Specify the user who is the owner of the registry objects you
want to include in the search or ﬁlter. Use the Browse buon
to select the user in the Select Object Dialog.

Created

Specify the date and time after and/or before which the
registry objects you want to include in the search or ﬁlter
have been created. Specify the date and time in the following
format: yyyy-MM-dd HH:mm:ss. Alternatively, you can
use the
buon to select the date and specify the time and
timezone in the Select Date and Time Dialog.

Modiﬁed

Specify the date and time after and/or before which the
registry objects you want to include in the search or ﬁlter have
been modiﬁed. Specify the date and time in the following
format: yyyy-MM-dd HH:mm:ss.SSS. Alternatively, you can
use the
buon to select the date and specify the time and
timezone in the Select Date and Time Dialog.

Key

Specify the unique key of the registry object you want to
include in the search or ﬁlter.

Custom
Condition

Specify a search or ﬁlter condition as a query in XQuery
format, that fulﬁlls the syntactical and semantical
requirements of CentraSite. For details on XQuery in
CentraSite, contact your CentraSite support organization. The
XQuery fragment ﬁeld oﬀers basic text editing functions such
as undo, cut, copy, and paste, that help you entering queries.
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